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Summary of Changes

Query Results window

v Column wrapping
v Vertical alignment (bottom, middle, top)
v ″Go-To″ a specific place, such as a line number or break summary rows
v Search within highlighted data
v Display data in hex or binary format in Zoom Edit dialog
v User-defined currency symbol
v Simplified menus

EasyAsk

QMF for Windows supports EasyAsk, formerly English Wizard, which is a
product interface for submitting queries as ordinarily written questions
instead as SQL

Prompted queries

Prompted queries have been enhanced. Now, join conditions include inner-,
outer-, left-, right-, and full joins. You can now sort by columns that were not
selected and by expressions.

Report Center

Version 7.2 contains many updates to QMF for Windows Report Center, such
as:
v Server filter

Use the server filter to choose which servers are defined and which SDFs
are displayed.

v Link reports
You can link reports to locally-saved query (*.qry) files

v View reports
You can view, but not edit, SQL and procedure text of reports

v Tree structure
QMF objects and DB2 tables can display in a tree structure.

v Report comments
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Comments, up to 800 characters, can be defined for reports service or the
Internet Explorer Task Scheduler

v Hide variables
Using QMF for Windows, Version 7.2, you can hide pre-set variable values
individually

v Date Wizard
You can create a calculated date for a variable value with Date Wizard. Set
to current date, first- or last day of month or previous months, first- or last
weekday in month or first or last day based on financial quarters

v Report in temporary directory
Reports can be created in the temporary directory of the machine running
the report

v Charts can be preset and created in Microsof®t Excel® or Lotus 1-2-3®.
v Pivot tables can be created in Microsoft Excel
v Group data can be created in Lotus 1-2-3
v You can group by one- or two columns in Microsoft Excel or Lotus 1-2-3.
v Report Center will stop on error folder property and also stop running

reports under a folder when an error is encountered.

QMF Query for Java™

With QMF Query for Java, you can create, save, and run SQL queries and
prompted queries. Reports can be formatted from a default or saved form.
You can format reports using the result grid formatting in the query. QMF
Query for Java can govern and track queries and output graphs and charts.

Spatial data

IBM DB2® Spatial Extender stores, accesses, manages, and analyzes spatial
data that you can query. This feature of QMF for Windows provides visual
map renderings of spatial data. You can import or export spatial data. Several
menus contain options for the spatial data feature, including the Results
menu, List menu, and File menu. The dialog, Display Map, contains two
panes: one is a tree view that presents the layers (query or table) used in the
shape file; whereas, the other pane provides a visual map rendering of the
spatial data.

Catalogs

Catalogs have been enhanced so that you can access a database server
without creating the entire QMF catalog at that server. Multiple, and distinct
QMF catalogs can be created at a single server. Extended catalog support has
been introduced, to maintain the QMF catalog on a single DB2 server.
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Administrators do not need to maintain a catalog for each DB2 server
accessed. Catalog centralization includes queries designed for ODBC data
sources, which query the ODBC data source unless redirected to another data
source by the end-user at execution.

Query improvements

Improvements have been made to the query function, including to the
PREPARE function, in which DB2 checks the query syntax and availability of
required objects, while performing internal calculations without sending data
to the client. Also, COMMENT/UNCOMMENT has been improved, in which
you can comment out or include a line in a query that will not or will be used
when the query runs.

API improvements

More than 25 APIs have been added, such as ResetGlobalVariable() and
SetParameter().

Other improvements

v IBM ObjectREXX @IF function, which tests for specified values within the
REXX expression, then interprets the expression and returns the result

v Fast Save Data function within a QMF procedure
v BiDi (bi-directional) orientation option for displaying data in query results

and reports
v Tooltip descriptions for global variables and object tracking reports

Summary of Changes xi
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The QMF library

You can order manuals either through an IBM representative or by calling
1-800-879-2755 in the United States or any of its territories.
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Chapter 1. Introduction

This chapter provides an overview of QMF for Windows and explains some
of the basic tasks for getting started with QMF for Windows.

Prerequisites

Operating system
v Microsoft® Windows® 95
v Microsoft Windows 98
v Microsoft Windows ME
v Microsoft Windows NT 4.0
v Microsoft Windows 2000
v Microsoft Windows XP

Note: QMF for Windows does not run on Windows 3.1 (or earlier), Windows
for Workgroups, or Windows NT 3.51 (or earlier).

Add-in applications

v Microsoft® Excel®: 7.0 or later
v Lotus® 1-2-3®: 97 or later

Connectivity

TCP/IP
The Microsoft TCP protocol installed with the Windows operating system
should work with any product that provides a WinSock interface.

SNA
IBM Personal Communications 4.1 or later should work with any product that
provides a WinCPIC interface.

ODBC
Most ODBC 2.x or 3.x drivers are acceptable.

CLI
IBM DB2 Universal Database™ runtime client, Version 6.1 or later.

© Copyright IBM Corp. 1983, 2002 1



QMF Query for Java

Recommended servers
IBM WebSphere® Version 3.02 or 3.5 should work with any application server
product that implements JSDK 2.x or Java Servlet 2.2 or later. Applicable
platforms and versions are listed below.
v UNIX and Linux
v Windows NT or Windows 2000
v iSeries™ (4.4 or later)
v OS/390® (2.5 or later), z/OS™ with UNIX System Services installed or

MVS™

Note: IBM WebSphere Application Server is recommended (version 2.0, 3.02,
and 3.5 are supported). However, QMF Query for Java is compatible
with any application server that supports JDSK 2.0 and JDBC 1.0.

Database
IBM DB2 Version 5.x and above with a JDBC type 1.0 driver, with the
applicable updates to enable JDBC.

Other functionality

IBM ObjectREXX
IBM ObjectREXX for Windows 1.0.2.3 or later.

Natural language query
v Linguistic Technology English Wizard 3.1
v EasyAsk 6.0

Audience

The audience for this manual is the end-user of the application. Typically, this
is the person who knows:
v the data in DB2
v which tables are in DB2
v SQL prompted queries or SQL

This person may write applications, create queries, forms, and procedures in
order to produce reports, export data, and use the Report Center.
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Accessibility features

QMF for Windows allows for customization that will accommodate your
vision or mobility needs. There are different categories of accessibility options
available from within QMF for Windows and from the Windows operating
system:
v Keyboard accelerators: these are shortcuts that enable you to perform

activities directly through the keyboard rather than from a menu. These are
also known as mnemonics.
For example, pressing Ctl+S would be the same as selecting the Save option
from a menu.
Another example, files listed as 1, 2, 3 off a menu can be selected by simply
typing the option number. For example, you would select Tables if you
select option 2:
1 Reports
2 Tables
3 Queries

v Toolbar icons: you can add icons to the toolbar to execute the most
frequently-used options (such as save, run query, and others)

v Tooltips: tool tips (information about the option) display when you
″mouse-over″ (sweep the cursor) over an area of a tool tip-enabled window

v Screen reader: QMF objects can be read by screen readers

Note: The query results (also known as the ″results grid″) cannot be read
by a screen reader. Instead, export the file or save the file in HTML
format.

v High-contrast display: you can change the display from the Control Panel
so that icons and type are magnified to meet the needs of the visually
impaired.

v Microsoft Control Panel Accessibility Options: these options are available
from the control panel, and include options for:
– Keyboard ″StickyKeys,″ ″FilterKeys,″ and ″ToggleKeys,″ plus the option

to show extra keyboard help in programs
– Display: contains an option for Windows to use colors and fonts

designed for easy reading, plus an option for high-contrast (color scheme
= white on black, black on white, or a custom scheme)

– Mouse: the option to use MouseKeys, which controls the pointer with
the numeric keypad on your PC (including the shortcut and pointer
speed)

v General: turn on/off accessibility options; notifications; SerialKey devices,
and administrative options
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What is QMF for Windows?

IBM Query Management Facility for Windows (QMF for Windows) is a tightly
integrated, powerful, and reliable query and reporting tool set for IBM’s DB2
relational database management system. It provides an easy-to-use interface
for enterprise reporting, including reports and procedures with REXX
calculations.

QMF for Windows accesses data that are stored in any database in the IBM
DB2 family of databases. It also handles data from heterogeneous and
non-heterogeneous data sources. QMF for Windows integrates with
spreadsheet solutions such as Microsoft Excel and Lotus 1-2-3 for an alternate
method of packaging and presenting report data.

Java SQL from a browser and point-and-click, drag-and-drop functionality,
(including aggregations, summaries, and formatting from within the query
results) make QMF for Windows a robust query and reporting tool. The QMF
for Windows Administrator component provides extensive, detailed
management and control over your QMF environment to protect resources
and monitor user actions.

Database servers

Queries, forms, procedures, and tables are run and saved at a database server.

DB2 family of databases
QMF for Windows can connect to a wide range of DB2 databases:
v DB2 UDB for OS⁄390, DB2 for OS⁄390 and z/OS, and DB2 for MVS
v DB2 Server for VSE™ & VM® and SQL⁄DS™

v DB2 Universal Database and DB2 Common Server
v DB2 Parallel Edition
v DataJoiner®

Your QMF for Windows license determines which DB2 family products you
can install on and connect to with your copy of QMF for Windows.

User name and technical name
Different versions and types of DB2 refer to a database by an RDB name,
location name, or other technical name.

With QMF for Windows your administrator can assign an easily remembered
name to a database name, for example, Purchasing Database instead of
DB2P_01_PURCH.

QMF for Windows refers to a database server or a DB2 database as a "server."
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Setting the server name
Before you can query a database, QMF for Windows needs to know where the
database is stored.
1. From the File menu, select New SQL Query. A new SQL query document

opens.
2. From the Query menu, select Set Server. The Set Server dialog box opens.
3. From the list of available servers, select the one that you want to query

and click OK. When you begin your next QMF for Windows session, QMF
for Windows automatically reconnects to the same server.

Database security

You must provide a user ID and password before you can connect to a server.

Logging on
You must specify a valid user ID and password for the database server that
you are trying to access. The database server user ID and password is not
necessarily the same as your local or network user ID and password.

If you are running Windows, you have the option of remembering server
passwords across QMF for Windows sessions. If you are currently logged on
to Windows, the Set User Information dialog box displays an additional check
box labeled Remember this password?. If you select this check box, then the
password you enter for that server is stored in the Windows password list.
Whenever you are logged on to Windows, QMF for Windows can
automatically retrieve that password so that you are not prompted. If you are
not logged on when you run QMF for Windows, or if you are logged on as a
different user, QMF for Windows prompts you for a user ID and password.

Note: If you choose to save a password, anyone who can log on to your
Windows account can access your database servers with your (server)
user ID and password.

1. From the Query menu, select Set User Information.
The Set User Information dialog box opens.

2. Enter your user ID and password.

Note: The user ID and password are case sensitive. For example, if your
user ID or password is uppercase, you must enter it in uppercase.
Some types of database servers treat user IDs and passwords as
case sensitive; others do not.

3. Check Remember this password? if you want to save your user ID and
password.

4. Click OK. QMF for Windows stores this information in preparation for
accessing the server.
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Correcting passwords
If you entered an incorrect password, you can correct the error by reopening
the Set User Information dialog box.
1. From the Query menu, click Set User Information.

The Set User Information dialog box opens.
2. Type the password again and click OK.

The password is corrected.

Changing passwords
You can change your password at the database server from QMF for
Windows. This feature is currently supported only by DB2 for OS⁄390 Version
5 and later.
1. From the Query menu, select Set User Information.

The Set User Information dialog box opens.
2. Click Change.

The New password and Confirm new password fields display.
3. Type your new password in the New password and Confirm new

password fields and click OK.
Your database server password is changed.

Specifying accounting strings
The database server uses accounting strings to track system usage. Ask your
database administrator to find out if your system uses accounting strings.
1. From the Query menu, select Set User Information.

The Set User Information dialog box opens.
2. In the Accounting string field, type the accounting string you want to use

and click OK.
QMF for Windows stores the information in preparation for accessing the
server.

QMF for Windows menus

Three drop-down menus are available at the QMF for Windows main dialog
box:
v File
v View
v Help
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File menu

New
Select this menu option to create a SQL query, prompted query, natural query,
form, procedure, list, or job. Submenus display for several of the following
menu options:
v SQL query

A query that you create and modify using SQL (Structured Query
Language) statements, which you enter in a query window. The database
server defines the rules (grammar, syntax, and other rules) for valid SQL
queries.

v Prompted query

A graphical representation of the components that make up a query. If you
are not familiar with SQL syntax, use the Prompted Query window to
create and edit your queries.

v Natural query

A query that is written using conversational English. The query is
converted to SQL and run normally at the database.

Note: You need EasyAsk installed on your machine to work with Natural
queries. Otherwise, this option is disabled.

v Form

A form contains the formatting instructions that QMF for Windows uses to
generate a report from query results.

v Procedure

A set of commands that enable you to run queries, print reports, import
and export data, and perform other functions with a single command. Use
the Procedure window to create and edit your procedures.

v List

Creates a new list of objects, which is a query, form, procedure or table.
v Job

Creates a new job, which is file used to schedule and run unattended
procedures. A job file can store a user ID, encrypted password, and
substitution variables.

Open
This option opens a document from an existing query, form, procedure or list
file.

Open from server
This option opens a document from an existing query, form, or procedure, or
list file from the database server, without opening a list document.
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Draw query
Use the Draw Query dialog box create a new query document based on the
query type and tables you specify. This menu command is the same as using
the DRAW command in host QMF.
v Server

The database server where the tables for the query are stored.
v Query type

The type of query you want to create:
– Select: creates an SQL SELECT statement for the specified tables. You can

specify more than one table when you use the SELECT statement.
– Update: Creates an SQL UPDATE statement for the specified table. You

can specify only one table when you use the UPDATE statement.
– Insert: Creates an SQL INSERT statement for the specified table. You can

specify only one table when you use the INSERT statement.
v Owner

The owner of a table (in the correct format for identifiers) for which you
want to create a query.

v Name

The name of a table (in the correct format for identifiers) for which you
want to create a query.

v Identifier

The correlation ID for a table in the query that you create. If you leave this
field blank, a correlation ID is automatically generated for you.

v Tables

Lists the tables to include in the query. If you are creating a SELECT
statement, you can specify more than one table. If you are creating an
UPDATE or INSERT statement, you can specify only one table.

Table Editor
This dialog box displays when you click Table Editor on the File menu or
when you click Edit on the List menu. You use this dialog box to search for
and edit rows in a table.
v Server

The name of the database server that stores the table you want to search.
v Table owner

The name of the user responsible for maintaining the table.
v Table name

The name of the table you want to search.
v Save mode

Indicates whether you want to save changes with each row or when you
have completed all changes:
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– Immediate

The table will be updated at the database server immediately after each
change.

– End

The table will be updated at the database server after you finish entering
all changes. Other users will not be able to make changes to the table
while you make your changes.

Import data
Use this option to import data from an existing IXF file into a new query
document.

Recent files
Use this option to open the files from your computer that have been recently
accessed.

Follow these steps to access the most recently used files to use in a new query
window:
1. Click Recent Files on the File menu.

The Recent Files menu displays.
2. Select the file you want to use.

The file data displays in a new window.

Note: There is no toolbar button for the Recent Files menu.

Recent objects
Use this option to retrieve objects from a server that have been recently
accessed during a QMF for Windows session. The format of the most recently
accessed object is:
SERVER:OBJECT_TYPE:OWNER.NAME

Follow these steps to access the most recently used object to use in a new
query window:
1. Click Recent Objects on the File menu.

The Recent Objects menu displays.
2. Select the object you want to use.

The object data displays in a new window.

Note: There is no toolbar button for the Recent Objects menu.

Terminate connections
Ends the connection to the server.
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Exit
Use this option to close QMF for Windows.

View menu

Connections
The Connection Information dialog box displays when you click Connections
on the View menu. It shows a summary of the connections that QMF for
Windows has to your database servers. You can leave this dialog box open
while working in QMF for Windows.
v Servers and connections

Displays the servers to which you are currently connected with QMF for
Windows as well as the number of connections that QMF for Windows has
to each.

v Show details

Displays the Connection Details dialog box that contains detailed
information on each of the connections to a server in the Servers and
Connections list.

Global variables
This dialog box displays when you click Global Variables on the View menu.
It shows all the global variables defined at this computer.
v Name

Displays the name of the global variable.
v Value

Displays the value currently held by the global variable.

Toolbars
This dialog box displays when you click Toolbars on the View menu. You use
this dialog box to display and hide various toolbars.
v Main toolbar

Select this check box to display the Main toolbar.
v Query toolbar

Select this check box to display the Query toolbar. This toolbar is enabled
when a query document is active.

v Natural query toolbar

Select this check box to display the Natural Query toolbar (when a natural
query document is active).

v Procedure toolbar

Select this check box to display the Procedure toolbar (when a procedure
document is active).

v Form toolbar
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Select this check box to display the Form toolbar (when a form document is
active).

v List toolbar

Select this check box to display the List toolbar (when a list document is
active).

v Customize

Opens the Customize Toolbar dialog box.

Command bar
Check this option to display the Run command and at server command lines
at the top of the QMF for Windows user interface. You use the command bar
to run a procedure command directly from the QMF for Windows interface.

Status Bar
Check this option to display the status bar at the bottom of the QMF for
Windows user interface. The status bar displays information and messages
that help you use QMF for Windows and provides status information when
you are running queries.

Options [General]
This dialog box displays when you click Options on the View menu and
select the General tab.
v Server definition file

The name of the server definition file that QMF for Windows uses. Your
system administrator provides you with the name of this file. You must
enter the name of a server definition file in order to use QMF for Windows
....- Browses for a name to use for the server definition file

Special values

v Display null values as
The string QMF for Windows uses to display null values that are retrieved
from the database server.

v Enter null values as
The string to use when entering null values in query results and in the Edit
Table dialog box.

v Enter default values as
The string to use when entering default values in query results and in the
Edit Table dialog box.

Options [CPI-C]
This dialog box displays when you click Options on the View menu and
select the CPI-C tab.
v CPI-C provider DLL
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The name of the DLL QMF for Windows uses to access CPI-C services. See
Product Requirements for QMF for Windows for information about
supported SNA software products
.... - Browses for a CPI-C Provider DLL

v CPI-C warning timeout

If a communication request does not complete within this period of time,
QMF for Windows asks whether to cancel the request and return an error.

v CPI-C cancel timeout

If a communication request does not complete within this period of time,
QMF for Windows automatically cancels the request and returns an error.

Options [TCP]
This dialog box displays when you click Options on the View menu and
select the TCP tab.
v TCP warning timeout

If a communication request does not complete within this period of time,
QMF for Windows asks whether to cancel the request and return an error.

v TCP cancel timeout

If a communication request does not complete within this period of time,
QMF for Windows automatically cancels the request and returns an error.

Options [CLI]
This dialog box displays when you click Options on the View menu and
select the CLI tab.
v CLI warning timeout

If a communication request does not complete within this period of time,
QMF for Windows asks whether to cancel the request and return an error.

v CLI cancel timeout

If a communication request does not complete within this period of time,
QMF for Windows automatically cancels the request and returns an error.

Options [ODBC]
This dialog box displays when you click Options on the View menu and
select the ODBC tab.
v ODBC warning timeout

If a communication request does not complete within this period of time,
QMF for Windows asks whether to cancel the request and return an error.

v ODBC cancel timeout

If a communication request does not complete within this period of time,
QMF for Windows automatically cancels the request and returns an error.
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Options [LOB]
This dialog box displays when you click Options on the View menu and
select the LOB (Large Objects) tab.
v Override LOB options

When checked, overrides your default LOB options with the options that
you specify. Depending on your resource limits, you may not be able to
override you LOB options.

v Disable LOB columns

No data is returned to queries that query columns containing LOB data.
v Disable LOB data retrieval

Users cannot retrieve LOB data

v Retrieve LOB data on demand

Specific LOBs are returned when you request them individually
v Retrieve LOB data automatically

All LOBs in the query results are returned automatically
v Maximum LOB column size (KB)

Specifies the maximum size of a LOB column in kilobytes. A limit of zero
indicates no maximum.

Options [Traces]
This dialog box displays when you click Options on the View menu and
select the Traces tab.

Note: Apply tracing only if you are attempting to diagnose a problem, since
tracing has an adverse effect on performance.

v Trace file 1

The name of the first trace file you want to use. QMF for Windows writes
data to this file, until the size of the file exceeds 512K bytes. Then QMF for
Windows begins writing data to Trace file 2. When the size of this file
exceeds 512K bytes, QMF for Windows switches back to Trace file 1. This
method prevents QMF for Windows from completely consuming disk space
with trace information while still allowing a reasonable running history of
trace information
.... - Browses for the name of the first trace file you want to use.

v Trace file 2

The name of the second trace file that you want to use.... - Browses for the
name of the second trace file you want to use.

v DDM

When checked, applies tracing to DDM operations.
v TCP

When checked, applies tracing to TCP operations.
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v CPI-C

When checked, applies tracing to CPI-C operations.
v CLI

When checked, applies tracing to CLI operations.
v Embedded SQL

When checked, applies tracing to embedded SQL operations.
v SQLAM

When checked, applies tracing to SQLAM operations.
v REXX

When checked, applies tracing to IBM ObjectREXX operations.
v Internet Mail

When checked, applies tracing to Internet Mail operations.

Options [BiDi]
This dialog box displays when you click Options on the View menu and
select the BiDi tab. The settings at the BiDi (bi-directional) dialog box control
the direction of the data in query results and report in a BiDi enabled
operating system.
v Left-to-Right

Under any operating system, data will display using a left-to-right
orientation.

v Right-to-Left

Any operating system data will display using a right-to-left orientation.
v Based on operating system

QMF for Windows will orient the grid and reports according to the
operating system. If the operating system is bidi-enabled, data will display
using a right-to-left orientation; otherwise, data will display using a
left-to-right orientation.

Note: The orientation flag is stored in registry entry QFW_KEY\Advanced
Options\BIDIOptions. The following values are correct: 0 = OS
dependent; 1 = always left-to-right; 2 = always right-to-left.

Governing

The QMF for Windows governor is always running in the background,
monitoring the usage of database and system resources. The governor also
limits the type and size of queries you can run.
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Viewing resource limits
From the View menu, select Resource Limits. The Resource Limits dialog box
opens. All information in the Resource Limits dialog box is read only. Your
system administrator sets these limits.

The types of limits and controls that can be in effect are:
v Timeouts
v Limits
v SQL Verbs
v Options
v Save Data
v Binding
v Object Tracking
v LOB Options
v Report Center

Setting your own row limit
You can specify the maximum number of rows to retrieve for this query.
When this limit is reached, QMF for Windows cancels the query. The
maximum authorized row limit specified in your resource limits group takes
precedence over this parameter.

Enter 0 to specify no limit in this field.

Rows that QMF for Windows has already retrieved in excess of this limit are
retained and available for viewing.
1. From the Query menu, click Set Row Limit.

The Set Row Limit dialog box opens.
2. Enter the maximum number of rows that you want the query to return

and click OK.
The row limit is applied the next time you run the query.

Customizing the toolbar

You can customize the toolbar to display only the buttons that you want to
see.

Adding buttons to the toolbar
You have the option of adding buttons to the existing QMF for Windows
toolbar. These buttons represent functions that not all users may need, but
that are available for inclusion in the toolbar.
1. Double-click the gray area surrounding the toolbar. The Customize Toolbar

dialog box opens.
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2. From the Available buttons column, select the button that you want to
add and click Add.
The button is added to the toolbar.

3. When you finish adding buttons, click Close.
The dialog box closes and the new buttons are added to the toolbar.

Moving buttons on the toolbar
You have the option of rearranging the buttons on the QMF for Windows
toolbar.
1. Double-click on the gray area surrounding the toolbar.

The Customize Toolbar dialog box opens.
2. From the Available buttons column, select the button that you want to

move.
3. Use the Move Up and Move Down buttons to move the button within the

toolbar.
4. When you finish moving buttons, click Close.

The dialog box closes and the buttons appear in their new locations.

Removing buttons from the toolbar
You have the option of removing buttons from the QMF for Windows toolbar.
1. Double-click on the gray area surrounding the toolbar.

The Customize Toolbar dialog box opens.
2. From the Available buttons column, select the button that you want to

remove and click Remove.
The button is removed from the toolbar.

3. When you finish removing buttons, click Close.
The dialog box closes and the buttons are removed from the toolbar.
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Chapter 2. Working with SQL Queries

Structured Query Language (SQL) is the most basic interface between a user
and a database. Queries are written in SQL and processed by the database.
Users can write QMF for Windows queries in SQL, or create queries using the
"point and click" method.

SQL queries

Structured Query Language queries require knowledge of the commands and
syntax of SQL. Users unfamiliar with SQL should try creating prompted
queries, as discussed in the ″Building Prompted Queries″ chapter.

Query menu

Run
Run the active query.

Prepare
This option invokes PREPARE SQL command. DB2 will check query syntax,
existence of every object that is associated with the query, but internal
calculations will be performed and no data will be sent to client.

This option is very convenient to validate queries.If you have prompted query
with big calculations or returns huge amount of data and you are unsure that
the syntax is correct the best way to check syntax is to use the PREPARE
command.

Cancel
Cancel the active query currently running at the database server.

Uppercase
Force the letters you type in a query or procedure window to be all
uppercase.

Reformat SQL text
Reformat the SQL text of a query. It neatens the appearance of the text,
capitalizes SQL keywords, and shortens queries to less than 79 characters per
line, a requirement for saving a query at a database server.

Comment
Use this option to comment out a line in a query, typically a line that
describes what a section of the SQL will do. The text that is commented will
not be included when the query is run.
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This option places two dashes (--) at the beginning of a line in the query, such
as:
SELECT * FROM Q.STAFF
--USE THIS ONLY FOR MONTH-END REPORTS

Uncomment
Removes the commented line or lines. Once a line is uncommented, it will be
read when the SQL query is run.

This option removes the comment flag, two dashes (--), from the beginning of
a line in the query, such as:
SELECT * FROM Q.STAFF
USE THIS ONLY FOR MONTH-END REPORTS

Set server
Select the database server where you want the active query to run.

Set user information
Set your database server user ID, password, and accounting string for the
active query.

Set row limit
Determine the maximum number of rows to retrieve from the database server
for the active query.

Set font
Change the display font attributes of your selection.

EasyAsk Open Dictionary
Open an EasyAsk dictionary (*.dct) for this server.

Note: This option is available only if EasyAsk is installed on the computer.

EasyAsk Query Builder
Open the EasyAsk query builder.

Note: This option is available only if EasyAsk is installed on the computer.

EasyAsk View Interpretation
Open the EasyAsk View Interpretation window.

Note: This option is available only if EasyAsk is installed on the computer.

EasyAsk Dictionary Editor
Open the EasyAsk Dictionary Editor.

Note: This option is available only if EasyAsk is installed on the computer.
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EasyAsk Dictionary Map
Open the EasyAsk Dictionary Map.

Note: This option is available only if EasyAsk is installed on the computer.

EasyAsk Set Date
Open the EasyAsk Set Date dialog box.

Note: This option is available only if EasyAsk is installed on the computer.

EasyAsk Dictionary Construction Kit
Display the EasyAsk dictionary construction kit.

Note: This option is available only if EasyAsk is installed on the computer.

EasyAsk Dictionary Properties
Display the properties of the current EasyAsk dictionary.

Note: This option is available only if EasyAsk is installed on the computer.

Bind Package
Create a package at the database server that contains the active SQL statement
as a static query.

Revert to dynamic SQL
Edit and run a query as dynamic SQL after binding the package for it.

Convert to SQL
Convert the active prompted query into a new SQL query.

Note: This command is available only if the active query is a prompted query.

Confirm stored procedure parameters
Confirm the data types, modes, and values of parameters for stored
procedures run with a CALL statement.

Creating SQL queries
Click the New SQL Query button on the toolbar.

A new query document opens.

Running SQL queries at a database server
1. Open a new query document and type in a query, open an existing query

file, or open a query from the database.
2. Click the Run Query button on the toolbar.

The query runs and the results are displayed.
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Switching between the results view and the SQL view
You can look at the results of a query or the SQL statement itself.

From the SQL view of a query that has been run, click View Results on the
toolbar.

The query results are displayed.

-or-

From the Results view of a query, click View SQL.

The SQL statement displays.

Working with fonts

You can change the font used to display queries. The choice of fonts varies
according to what has been installed on your computer. For more information
on adding fonts, refer to your operating system’s help facility.

Note: If you save the query after selecting a new query display font, the
query displays with the new font.

Selecting the query display font
1. From the SQL view, click Set Font from the Query menu. The Font dialog

box opens.
2. Select the font for the text of the query and click OK.

The query reappears in the new font.

Note: Click Set As Default to use the selected font as the default font for
all new queries.

Multiple queries

You can open or run more than one query at the same time. You can use these
features to generate multiple reports, or to cut and paste SQL text from one
query to another.

Displaying multiple queries
1. Open at least two query documents.
2. From the Window menu, select one of the following commands:

Table 1. Query display commands

Command Result

Cascade Displays queries in a staggered series.
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Table 1. Query display commands (continued)

Command Result

Tile Horizontal Displays query windows stacked vertically.

Tile Vertical Displays query windows stacked side by side.

The query windows are arranged according to the option you select.

Drawing queries

Use the Draw Query command to create new SQL query documents. You
specify one or more table names and the type of SQL statement that you
want, and QMF for Windows creates an SQL statement that references the
names and data types of the columns in the table.

Creating SQL queries
1. From the File menu, click Draw Query.

The Draw Query dialog box opens.
2. Select the type of query that you want to create:

Table 2. Select query type

Query Type Result

Select Retrieve rows from one or more tables.

Update Change the information in a table.

Insert Add new rows to a table.

3. Enter the owner and name of the table to be queried.

Note: You can use patterns to select table names from a list of matching
tables.

v Use the percent character (%) to match a string of any length containing
any characters. For example, to list all tables with a name beginning
with the letter A, enter A%.

v Use the underscore character (_) to match a single character. For
example, to list all tables with an owner that has the letter A in the
second position, enter _A%.

4. After you enter a pattern, click Add from List and select a table from the
resulting list.

5. Enter a unique identifier for the table.
6. Click Add.

The table is added to the query.
7. Click OK after adding the table or tables to query.
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An SQL query for the selected tables is created and displayed.

Substitution variables in SQL queries

Variables are a small part of the computer program code that can be modified
while the program is running. In this way, the same program can be used for
several actions.

QMF for Windows has two kinds of variables: substitution variables and
global variables (which are discussed in the chapter, ″Working with Global
Variables.″)

Substitution variables
Substitution variables are used in QMF objects for substituting variables to
strings at runtime. This enables you to substitute a part of an SQL statement
and make it more generic. Substitution variables are active only while the
object (query, procedure or form) is running. As a result, only one object can
access the substitution variable. After the execution the variable will no longer
exist.

With substitution variables, you can use the same query to retrieve different
information by supplying different values each time you run the query. To
retrieve a different set of data, you do not need to rewrite the query. Rather,
you just supply different values for the substitution variables in the query
when you run it.

A substitution variable is text that you include in a query. It must begin with
an ampersand character (&), and can contain up to 18 characters, which can
be alphabetic, numeric, or one of the following special characters: ^ ! $ ~ { } ?
@ # % \ or _. For example, the following values are valid substitution
variables:
&VARIABLE1
&DEPARTMENT_NUMBER

A substitution variable can appear anywhere in a query, and its value can be
anything that you might write in a query (except a comment). For example,
you can use a substitution variable in place of a column name, search
condition, subquery, or any specific value.

Global variables
Global variables are active while QMF for Windows is active, which means
that variables will have the same value until the instance of QMF for
Windows is finished, and the global variable can be accessed by all QMF
objects. Different instances of QMF will not be able to see each other’s global
variables.
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Running SQL queries with substitution variables
1. Open a new query document and enter this SQL statement:

SELECT * FROM Q.STAFF WHERE DEPT >= &MIN_DEPT

2. Run the query.
The Enter Substitution Variable Values dialog box opens.

3. In the Value field enter a value of 50 and click OK.
The query runs and displays the query results.

Try experimenting with substitution variables by replacing values in the
SELECT and FROM clauses. See what results your queries return with different
inputs.

Saving and opening SQL queries

You can save queries on your PC, on a file server, or at a database server.

Saving SQL queries to files
1. From an open query, click Save on the toolbar.

If the query has been saved before, it is saved again. If the query has not
been previously saved, the Save As dialog box opens.

2. Enter the name of the file where you want the query stored.
3. Click OK.

The query is saved.

Opening saved SQL query files
1. Click Open on the toolbar.

The Open dialog box opens.
2. Select the file that you want to open.
3. Click OK.

The selected query opens in a new query document.

Saving SQL queries at the database server
Queries saved at the server can be made accessible to other users. If you want
to share your queries with other users, save them at the database server.
1. From an open query, click Save at Server on the toolbar.

The Save Query dialog box opens.
2. Enter an owner, a name, select whether to share the saved query with

other users.
3. Click OK.

The query is saved at the server.
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Note: If a query with this name exists, you are prompted to overwrite the
previously existing query.

Opening saved SQL queries at the database server
You can open queries that have been saved at the database server.
1. Click Open From Server on the toolbar.

The Open From Server dialog box opens.
2. Enter a server, owner, and name.
3. Click OK.

The SQL query opens.

Printing SQL queries

You can preview and print your SQL queries.

Previewing a query
1. Open a query and activate the SQL view.

The SQL statement appears.
2. From the File menu, click Page Setup.

The Page Setup dialog box opens.
3. Make any changes you want to the layout of the page and click OK.
4. Click Print Preview on the toolbar.

A preview of the printed query appears.

Printing SQL queries
1. Open a query and activate the SQL view.

The SQL statement appears.
2. From the File menu, click Page Setup.

The Page Setup Dialog box opens.
3. Make any changes you that want to the layout of the page.
4. Click OK.
5. Click Print on the toolbar.

The query is printed.
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Chapter 3. Building Prompted Queries

Prompted queries are an easy way for you to create a query by selecting
options from menus and lists. Once you have created a prompted query you
can save it or convert it to an SQL query.

Building simple queries

You can easily build simple queries using the prompted query interface.

Query menu

Run
Run the prompted query.

Prepare
This option invokes PREPARE SQL command. DB2 will check query syntax and
the existence of every object associated with the prompted query. Internal
calculations will be performed but no data will be sent to client.

This option is very convenient to validate prompted queries. If you have
prompted query with big calculations or returns huge amount of data and
you are unsure that the syntax is correct the best way to check syntax is use
Prepare command.

Cancel
Cancel the prompted query currently running at the database server.

Uppercase
Force the letters you type in a prompted query or procedure window to be all
uppercase.

Set server
Select the database server where you want the active query to run.

Set user information
Set your database server user ID, password, and accounting string for the
active query.

Set row limit
Determine the maximum number of rows to retrieve from the database server
for the active query.
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Set font
Change the display font attributes of your selection.

Add table
Add a table to the active prompted query. This command is available only if
the active query is a prompted query, and is the same as adding a table to the
SQL query FROM clause.

Add join condition
Add a join condition to the active prompted query. This command is available
only if the active query is a prompted query, and is the same as adding a join
predicate to the SQL query WHERE clause.

Add column
Add a column or column expression to the active prompted query. This
command is available only if the active query is a prompted query, and is the
same as adding a column or expression to the SQL query SELECT clause.

Add sort condition
The Sort Conditions dialog box displays when you add or change a sort
condition in a prompted query.

Add a sort condition to the active prompted query. This command is available
only if the active query is a prompted query, and is the same as adding a
column or expression to the SQL query ORDER BY clause.

For example, you can write statements such as the following in the Enter a
sort condition here field:
SELECT ID, SALARY FROM Q.STAFF ORDER BY DEPT ASC

In this case, the sort condition is a column that does not exist in the result set.

In another example,
SELECT ID, SALARY FROM Q.STAFF ORDER BY ID+SALARY ASC

In this case, the sort condition is an expression.

Table 3. Sort conditions dialog

Field Description

Columns in result set Displays the columns in the prompted query.

v You can select one or more columns if you are
adding a sort condition

v You can select only one column if you are changing
a sort condition
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Table 3. Sort conditions dialog (continued)

Field Description

Other available columns Displays other columns from within other available
tables in the prompted query

Enter a condition here Manually enter a sort condition here. Only sort
conditions are supported.

Sort direction Applies ascending or descending sort order to the
selected columns in the column list

Add row condition
Add a row condition to the active prompted query. This command is available
only if the active query is a prompted query, and is the same as adding a
predicate to the SQL query WHERE clause.

Convert to SQL
Convert the active prompted query into a new SQL query. This command is
available only if the active query is a prompted query.

Opening new prompted queries
From the+ File menu, click New Prompted Query. A new prompted query
document opens.

Note: You cannot create a prompted query when you access an ODBC server.
The following message displays:
This feature is not supported when accessing an ODBC server.

Prompted query action buttons
Edit prompted queries using the query action button. A set of buttons appears
above the section that it controls.

Table 4. Prompted query controls

Prompted Query Action
Button

Result

Add Click to add an item to the prompted query.

Edit Click to edit the highlighted item in the query.

Delete Click to delete the selected item.

Move Up/Move Down Click to move the selected item up and down in the
prompted query.

Adding tables to prompted queries
1. In the Tables section of the prompted query document, click Add.

The Tables dialog box opens.
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2. Type the owner and name of the table that you want to add and click
Add.
The table is added to the query.

Note: You can use patterns to select objects from a list of matching objects.
v Use the percent character (%) to match a string of any length

containing any characters. For example, to list all tables with a
name beginning with the letter A, enter A%.

v Use the underscore character (_) to match a single character. For
example, to list all tables with an owner that has the letter A in
the second position, enter _A%.

3. After you enter a pattern, click Add From List.
4. Select a table from the resulting list.
5. Add additional table conditions to the query.
6. Click Close.

The prompted query document appears with the new tables listed.

Running prompted queries
You may run a prompted query the same way that you run an SQL query.
Click Run Query on the tool bar.

The prompted query runs.

Building complex queries

You can also build more complex queries using the prompted query interface.

Adding columns to prompted queries
The Columns dialog box +displays when you add or change a column in a
prompted query.

Table 5. Columns dialog

Field Description

Table Lists the tables or columns you have added to the
prompted query window

Column Select a column to add to the Columns list in the
prompted query window. Select the column then click
Add. Repeat this procedure to add multiple columns
to the Columns list.
Note: Right-click on a column to add it to the
Columns list.

Type Lists the character or numeric data type found in
each column
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Table 5. Columns dialog (continued)

Field Description

Label Lists any labels associated with the table

Comments Lists any comments associated with the table

Or, Enter an expression here A column expression valid for the database server.
Use the appropriate format for any identifiers (table
owner, table name or column name) in the
expression. Enclose character values in appropriate
quote characters. If you do not enter an expression,
select a column from the Column list.

Summary function Apply the summary function to the column. QMF for
Windows provides a list of summary functions,
including AVERAGE, COUNT, MAXIMUM, MINIMUM, and SUM.
The summary function must be compatible with the
data type of the column.

New column name A new column name for use in reports

Add Enabled when you select a column to add to the
prompted query window

Cancel Cancels the current action and closes the dialog box
without applying any changes to the prompted query

Procedure
1. In the Column section of the Prompted Query document, click Add.

The Columns dialog box opens.
2. Select the column you want to add.
3. Click Add.

The column is added to the prompted query.
4. Add additional columns to the query.
5. Click Close.

The Prompted Query document appears with the new columns listed.

Note: You can apply a summary function to the column by selecting one
in the Function field. Available summary functions are: AVERAGE,
COUNT, MAXIMUM, MINIMUM, and SUM.

Also, you can rename a column in the query by typing a new
column name in the New+ column name field.

Using sort conditions
Sort conditions are used to specify the way you want to sort the rows in the
query. Rows can be sorted in ascending (A-Z) or descending (Z-A) order.
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If you sort your rows by more than one column, the first column is ordered
first, then the second column is ordered within the order of the first column,
and so on. The Sort Conditions dialog box displays when you add a sort
condition in a prompted query. Fields on this dialog box include:

Columns in result set
Displays the columns in the prompted query. If you are adding a sort
condition, you can select one or more columns. If you are changing a sort
condition, you can select only one column.

Other available columns
Displays other columns from within other available tables in the prompted
query.

Enter a condition here
Enter a sort condition here.

Note: Only sort conditions are supported.

Sort direction
Applies an ascending (lowest-to-highest) or descending (highest-to-lowest)
sort order to all the selected columns in the column list.

Procedure
1. In the Sort conditions section of the Prompted Query document, click Add.

The Sort Conditions dialog box opens.
2. Select any of the following:

v the column by which you want to sort
v additional columns from the selected tables
v any additional sort conditions
v the direction in which to sort the results (ascending or descending)

3. Click Add.
The sort column is added to the prompted query. The Prompted Query
document appears with the new sort conditions listed.

4. Add any additional sort conditions to the query and click Close.

Using row conditions
Add row conditions if you want to view only certain rows in a table. If you
do not use row conditions, all the rows in the table are displayed.

The following row conditions are available:
v EQUAL TO

v LESS THAN

v LESS THAN OR EQUAL TO
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v BETWEEN

v STARTING WITH

v ENDING WITH

v CONTAINING

v NULL

Row conditions are controlled by the following operators:
v IS

v IS NOT

Procedure
1. In the Row conditions section of the Prompted Query document, click

Add.
The Row Conditions dialog box opens.

2. Select the parts of the conditional statement and click Add.
Then the row condition is added to the prompted query.

Table 6. Specify row condition

Part of the row condition Function

Left side Select the column you want to examine

Operator Determine the relationship between the left- and
right sides of the row

Right side Enter the condition for which you want to check

3. Add any additional row conditions to the query.
4. Click Close.

The Prompted Query document displays with the new row conditions.

Using multiple tables in prompted queries
You can include information from more than one table in a prompted query.

You must relate the two tables, specifying one or more join conditions in each.
Only rows from the tables where the join columns are equal are included in
the results. The data type of each column in a join condition must match.
Once you specify a relationship between two columns, QMF for Windows
remembers the relationship and suggests it in future queries, which makes the
creation of subsequent queries simpler and more efficient.

The Join Columns dialog box displays when you:
v Edit a join condition, or
v Add a join condition and there are only two tables specified in a prompted

query
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Note: You must specify a join condition when there are only two tables
specified in a prompted query.

Table 7. Join conditions dialog

Field Description

Left column list Displays the columns in one of the selected tables

Right column list Displays the columns in the other selected tables

Add Enabled when you are adding a join condition. Click Add
to add the join condition to the prompted query. This
control is disabled until you select one column from each
list.

Cancel Cancels the current action and closes this dialog box
without applying any changes to the prompted query

Close Closes this dialog box

Creating prompted query join conditions
1. In the Tables section of the Prompted Queries window, click Add to add at

least two tables.

Note: If you have never joined tables, the Join Tables dialog box opens.
Otherwise, QMF for Windows suggests the join condition you used
previously.

2. Select a column with the same data type from each table.
3. Click Add.

The new join condition appears in the prompted query.

Prompted queries and SQL

You can use the prompted query interface to learn SQL.

Viewing SQL for prompted queries
From the prompted query view, click View SQL on the toolbar.

The equivalent SQL statement for the prompted query appears. You cannot
modify the SQL statement from this view.

Converting prompted queries to SQL
You can convert a prompted query to a new SQL query document. The new
SQL query can be modified, saved, printed, and run.

From the Query menu, click Convert to SQL. The query is converted to a new
SQL query document.
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Using substitution variables in prompted queries

Substitution variables can be used in a prompted query in the same way as in
an SQL query. See ″Substitution Variables in SQL Queries.″

For example, substitution variables can be used in:
v a row condition

DEPT Is Greater Than Or Equal To &MINDept
v a column specification

&InputNum

Saving prompted queries

Prompted queries can be saved in files on your PC, on a file server, or at a
database server.

Saving prompted queries to files
1. From an open prompted query, click Save on the toolbar.

Note: If the query has been saved, it is saved again. If the query has not
been saved, the Save As dialog box opens.

2. Enter the name of the file where you want the prompted query stored.
3. Click OK.

The query is saved.

Open saved prompted query files
1. Click Open on the toolbar.

The Open dialog box opens.
2. Select the file you want to open.
3. Click OK.

The prompted query opens in a new query document.

Saving prompted queries at the database server
1. From an open prompted query, click Save at Server on the toolbar.

The Save Query dialog box opens.
2. Enter an owner, a name, select whether to share the saved query with

other users.
3. Click OK.

If a query with this name exists, you are prompted to overwrite the
existing query.
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Opening saved prompted queries at the database server
You can open prompted queries that have been saved at the database server.
1. Click Open From Server on the toolbar.

The Open From Server dialog box opens.
2. Enter a server, owner, and name.
3. Click OK.

The prompted query opens.

Printing prompted queries

You can print your prompted query. You can also print the SQL text of a
prompted query. See ″Printing SQL Queries.″

Previewing prompted queries
You can preview the results or text of a prompted query before you print it.
1. Open a query and activate the prompted view.

The query appears.
2. From the File menu, click Page Setup.

The Page Setup dialog box opens.
3. Make changes to the page layout and click OK.
4. Click Print Preview on the toolbar.

A preview of the printed query appears.
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Chapter 4. Working with Query Results

You can apply formatting, grouping, and aggregation directly to query results.
This formatting can be saved with the query, or exported as a form. Click
anywhere on the query results to activate the Results menu.

There are two ways to format query results:
1. Select the cell, column or row you want to format. From the Results menu,

select the type of formatting you want to apply.
2. Select the cell, column or row you want to format and right-click. The

Results menu displays.

Formatting

Query results are displayed in the Query window when you run a query.
There are several formatting options available to apply to a query result:
v set the color and font of the cells, rows, and columns
v group cells with summaries and no summaries
v display numeric data in currency, decimal, scientific, percent or user

currency format
v set date and time format with a separator symbol of your choice
v save formatting as a default setting
v copy and paste formats to rows and columns
v go to specific or relative rows in a query result
v auto-fit columns and rows to content

Working with query results

Users can select, resize, reorder, and sort the data results from a query.

Results menu

Font
This option displays the Font dialog box (Detail tab) where you can change
the display font attributes of your select within the results grid. This dialog
displays the font attributes of your selection within the results grid. Other
selected columns will appear in tabbed format under this dialog.

Note: Choosing Query: Set Font allows you to select the font for column and
row headers.
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The Font dialog box (Detail tab) displays when you click Results: Font or
right-click on a column.

Table 8. Font options

Field Description

Font The name of the font type

Font Style The style of the font

Size The size of the font

Foreground color Sets the color of the text

Background color Sets the color of the text is against

Sample Displays a text sample of the current formatting

Apply to all tabs Applies this formatting to all other font column
information tabs.
Note: When checked, formatting is
automatically applied to all other columns.
Other column tabs are disabled.

Set as Default Sets the font, font style, and size as the default
font. This font is used to display and print query
results until you choose a new font or change
the default.

Reset to Default Returns the font formatting information to its
default setting

Format
The Format dialog box (Detail tab) displays when you select a column and
click Results: Format or when you right-click on a selected column. Use this
dialog to set the formatting options for the selected column, such as
horizontal alignment, vertical alignment, options (thousands separator,
negative numbers, decimal places, apply to all tabs, which applies this
formatting to all other font information tabs).

Note: The appearance of the Format dialog box differs, depending on
whether you selected a column with character, numeric, date and time
data.
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Table 9. Format options

Field Description

Format The format of values in the column.

v For numeric data

Choose As Is, Currency, Decimal, Scientific, Percent
or User Currency

v For character data

Choose As is, Hexadecimal or Binary

v For date and time data

As is, Windows, or

The month, day and year (date), the hour, minute,
and second (time), and a Separator symbol

Sample Displays a sample of the current formatting

Horizontal alignment Aligns the content of the column to the left, right or
center of the cells

Vertical alignment Aligns the content of the column to the top, bottom or
center of the cells

Options For numeric data

v Thousands separator

When checked, places a thousands separator in
numeric values (the symbol is taken from Windows
settings)

v Negative numbers

Choose the way negative numbers are displayed

v Decimal numbers

Choose the way decimal numbers are displayed

For character data

v Wrap text

When checked, the contents of the cell will wrap to
the next line within the cell

For date and time data

v Separator symbol

Choose the symbol to display with the data and
time format you choose

v 12 hour mode

When checked, the time is displayed in a 12-hour
interval indicated by AM or PM

When unchecked, time is displayed in 24-hour
format
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Table 9. Format options (continued)

Field Description

Apply to all tabs Applies the formatting to all other column tabs

Set as Default Sets this format as the default format. This format is
used to display and print query results until you
choose a new format or change the default.

Reset to Default Returns the format information to its default setting.

No aggregation
Use this option to remove any aggregation or summary formatting from the
selected column.

Group with summaries
Use this option to group the selected column with summary information. This
moves the selected column to the left in the query results grid.
v Click on the top-right button to expand or collapse the cell, or
v Double-click on a cell to expand or collapse
v Hold down Shift and click the button for all rows to expand or collapse

Group with no summaries
Use this option to group the selected column without summary information.
v Click on the top-right button to expand or collapse the cell, or
v Double click on a cell to expand or collapse
v Hold down Shift and click on the button for all rows to expand or collapse

Count
This option summarizes the total number of values in the column.

First
Use this option to create a summary row showing the first value in the
column.

Last
Use this option to create a summary row showing the last value in the
column.

Maximum
Use this option to create a summary row showing the maximum value in the
column.

Minimum
Use this option to create a summary row showing the minimum value in the
column.
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Sum
Use this option to create a summary row showing the sum of the values in
the column.

Cumulative sum
Use this option to display the values in the column as a cumulative sum, with
a summary.

Average
Use this option to create a summary row showing the average of the values in
the column.

Standard deviation
Use this option to create a summary row showing the standard deviation of
the values in the column.

Percentage of group
Use this option to display the values in the column as a percentage of the
group’s total, with a summary row showing the sum of the percentages.

Percentage of total
Use this option to display the values in the column as a percentage of the
column total, with a summary row showing the sum of the percentages.

Cumulative percentage of group
Use this option to display the values in the column as a cumulative
percentage value of the group total, with a summary row showing the sum of
the percentages.

Cumulative percentage of total
Use this option to display the values in the column as a cumulative
percentage value of the column total, with a summary row showing the sum
of the percentages.

Copy formatting
Copy the formatting of the selected column.

Paste formatting
Paste the copied formatting to the selected column.

Reset all formatting
Reset all formatting of the query results.

Autofit
Autofit the contents of selected columns, all columns, all rows, or all (the
contents of the results grid) to accommodate the cell with the largest string of
data.
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Sort

Ascending: Sort the contents of the results grid in lowest-to-highest order
(such as A-Z).

Descending: Sort the contents of the results grid in highest-to-lowest order
(such as Z-A).

Sort by: Sort the data in the results grid by a specific column, in ascending
or descending order, by a specific sort type. You can specify sub-sorts to sort
by additional columns.

Go-to
This dialog box displays when you select Results: Go to. Use this dialog box
to navigate the rows of the query results grid.

Table 10. Go to options

Field Description

Go to Enter a numeric value

Absolute row The query results grid will scroll down to the
row number you have entered. For example, 17
will bring you to row 17.

Relative to current row The query results grid will scroll down to the
next number of rows from the row you have
selected in the results grid. For example, if you
select row 17 and enter 3, you go to row 20.

Percent of result set The query results grid scrolls down to the
percentage of the results grid you have entered.
For example, if yo u enter 75, you will scroll
down 75% of the results grid.

Display report
Select the form to use for displaying the report. Options are:
v default form
v from query
v from database
v from file
v from open document

Start cell contents
Open the contents of the selected cell in the appropriate Windows application
(such as Notepad).

Note: This applies only if a file name is associated with the cell.

40 Query Management Facility™ for Windows: Getting Started with QMF for Windows



Retrieve all LOB values
Retrieve all large object (LOB) values in the query results.

Column LOB associations
Open the Column LOB Type Associations dialog box where you specify the
applications associated with the large object (LOB) values in the column.

The Column LOB Type Associations dialog box opens when you select
Column LOB Associations from the Results menu or by double-clicking on a
LOB locator cell in the query results grid.

Table 11. LOB type options

Field Description

File Extension Displays the file extension of the LOBs in the column. The
list options are drawn from those in the Windows
Registry.

Mapping column Displays the column containing mapping values and their
corresponding extensions.

Click Mapping from the Column LOB Type Associations dialog box to display
the File Extension Mapping dialog box.

Table 12. File extension mapping options

Field Description

Mapping value Display the value of the column to map to the LOB data.
Edit a value by selecting the row and clicking Edit or by
double-clicking the row under the mapping value
column.

File extension Display the file extension of the LOB to map. Edit an
extension by double-clicking the row under the file
extension column.
Note: File extensions are first displayed as .LOB. You
need to edit the file extension so that it corresponds to the
mapping value.

For example, if the mapping value is bitmap, then the file
extension needs to be .bmp.

Save to database
Open the Save Data dialog box to save the query results to a database server
table. You can run a query at one database server and save the query results
to a table at a different database server.

Note: This command is available only when you are viewing query results.
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Save to file
Export query results to a file with the file name, locations, and format you
specify. This command opens the Export Data dialog box and is available only
when you are viewing query results.

Send to
Send the current document to the specified application or target in your Send
To: folder.

Selecting columns and rows
Once you have run a query, you can use the controls in the Results view to
edit and select information.

Table 13. Select columns and rows

Column and row selectors Function

Row selector Click to select all the data in a row.

Column selector Click to select all the data in a column.

Cell Click directly on the cell to select it.

Scroll-to-bottom and Scroll-to-top
buttons

Click to scroll to the top or bottom of a set of
query results.

Resizing columns and rows
You can change the appearance of a set of query results by resizing its
columns and rows.

You can apply formatting, grouping, and aggregation directly to query results.
This formatting can be saved with the query, or exported as a form.

Table 14. Resize options

Option Description

Sorting and sizing query
results

You can select, resize, reorder, and sort the data
results from a query

Selecting columns and rows Once you have run the query, you can use the
controls in the Results view to edit and select
information.

Table 15. Query results options

Column and row selectors Function

Row selector Select all the data in a row.

Column selector Select all the data in a column.

Cell Click to select the cell.
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Table 15. Query results options (continued)

Column and row selectors Function

Scroll-to-bottom and Scroll-to-top
buttons

Scroll to the top or bottom of the query results.

Resizing columns and rows

You can change the appearance of your query results by resizing its columns
and rows.
1. Using the mouse select the black dividing line between two columns or

two rows.
2. Drag the divider line from side to side or up and down to resize the

column or row.

Note: If you save the query after resizing its rows or columns, that query
always displays using the new formatting.

Auto fitting columns and rows

You can size columns and rows to fit the data they contain.

Using the mouse, select an entire column or row and double-click on the
black dividing line between it and the adjacent object. The column or row is
resized to fit its data.

Note: If you save the query after resizing its rows or columns, that query
displays using the new formatting.

Sorting query results

Once you have run a query, you can sort the results alphabetically by column.
Select one of the following methods:
v From the Results view of a query, select a column, then select Results: Sort

Ascending.
The query results are sorted in ascending order.

v From the Results view of a query, select a column and select Results: Sort
Descending.
The query results are sorted in descending order.

Note: To apply more complex sorting to the selected column, select Results:
Sort.

Reordering columns
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From the Results view of a query, select a column and drag it to its new
location. This changes the order of the columns in the query results.

The column appears in the new order.

Formatting query results

You can change the font used to display queries and query results. The choice
of fonts varies according to what has been installed on your computer. For
more information on adding fonts, refer to your operating system’s help
facility.

Note: If you save the query after selecting a new query results display font,
those results are always displayed using the new font.

Selecting the query results display font

1. From the Results view, select Results: Set Font.
The Font dialog box opens.

2. Select the font and type size for displaying the results of the query.
3. Click OK.

The query results display in the selected font.

Note: Click Set As Default to use the selected font as the default font for
all query results.

Formatting numeric query results

1. From the Results view, select a column containing numeric values and
select Results: Format.
The Format dialog box opens.

2. Specify the formatting that you want to apply.
3. Click OK.

The values are formatted according to your selection.

Note: Click Set As Default to use the selected font as the default font for
all query results.

Converting query results formatting to a form

1. From the Results menu, select Display Report.
The Select Form dialog box opens.

2. Select From Query.
3. Click OK.
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The query results formatting is converted to a form and opened in a new
form window.

Grouping and aggregating query results

You can apply grouping, aggregation, and summary formatting to query
results.
1. Select the column that you want to group.
2. From the Results menu, select the type of grouping that you would like to

apply.
The column is grouped according to your selection.

Summarizing query results

You can summarize query results by column:
1. Select the column that you want to group.
2. From the Results menu, select the type of summary that you would like to

apply.
The column is summarized according to your selection.

Saving query results and formatting

You can save query results and save the formatting as a form.

Saving query results as a table

You can save query results as a table at a database server.
1. From the Results menu, select Save to Database.

The Save Data dialog box opens.
2. Enter an owner and table name.
3. Click OK.

The query results are saved as a table at the database.

Saving query results to files

You can save query results to a file on your PC or a file server.
1. From the Results menu, select Save to File.

The Export Data dialog box opens.
2. Specify the location to which you want to save the file, any export options.
3. Click OK.

The query results are saved to a file.
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Previewing query results

1. Open and run a query.
The query results appear.

2. From the File menu, select Page Setup.
The Page Setup Dialog box opens.

3. Make changes to the layout of the page.
4. Click OK.
5. Click Print Preview on the toolbar.

A preview of the printed query results appears.

Printing query results

1. Open a query and activate the Results view.
The query results appear.

2. From the File menu, select Page Setup.
The Page Setup Dialog box opens.

3. Make changes to the layout of the page.
4. Click OK.
5. Click Print on the toolbar.

The query results are printed.

Chart options

This dialog box displays when you select Display Chart from the Results
menu. Use this dialog to define graphical attributes for charts created from
forms. These forms were created from query results. You can also display the
Chart Options dialog box when you click Display chart from the Form menu.

The following fields are found on this dialog box:

Title

Report page heading
The title of the report. The report page heading is used as the report title, by
default.

Text
Enter your own title for the chart.

Labels

Category (x) axis
The label to include on the category, or horizontal, axis of the report.

46 Query Management Facility™ for Windows: Getting Started with QMF for Windows



Value (y) axis
The label to include on the value, or vertical, axis of the chart.

Dimensions

Width
The width of the chart, in pixels.

Height
The height of the chart, in pixels.

Working with LOBs

QMF for Windows can retrieve LOBs from a database, export LOB data to
your PC, and save LOBs to a database. With this feature, you can insert data
types such as text, graphics, audio, video, mixed media, and photo images.

Because these data types take up memory, DB2 provides three data types to
store these data objects as strings of up to two gigabytes. These include:
v Binary large objects (BLOBS)
v Single-byte character large objects (CLOBs)
v Double-byte character large objects (DBCLOBs)

LOBs can be retrieved from a database and edited in an application that
supports the file type you retrieved. For example, a bitmap can be edited in
Microsoft Paint (R), as long as Paint is installed on your computer. LOBs are
stored in QMF for Windows tables and you manipulate the LOBs as you
would any other type of data stored in a QMF for Windows table. LOBs are
supported by DRDA™, CLI, and ODBC connections. For each server, LOB
support is determined by which connection is used. For example, a DRDA
connection does not support LOBs for all UPB servers. For a UPB server,
however, LOBs are supported by a CLI connection.

Features
The features include:
v LOBs can be retrieved from a database and exported to your PC
v you can insert files such as bitmaps and .gifs to your query results
v you can edit LOBs in the appropriate application

For example, a bitmap can be edited in Microsoft® Paint®, as long as it is
installed on your computer.

v LOBs are stored in QMF for Windows tables on a database and you call the
LOB as you would any other type of data stored in a QMF for Windows
table

v LOBs can be retrieved only through a CLI connection
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LOB data can be:
v viewed
v edited
v exported as an IXF, TXT, or HTM file

Note: Exporting as an IXF file is recommended.
v included in HTML reports
v saved to the database

Retrieving LOBs from a database
Follow these steps to call LOBs from the database:
1. Run the query or procedure to call the table where the LOB is stored on

the database.
The table with the LOB data is retrieved from the server.

Note: The picture column is labeled with ″LOB Locator.″

The QMF for Windows status bar at the bottom of the screen may
display the message, All rows retrieved, more LOB data to
retrieve. This is because transferring LOB data can be
resource-intensive. By default, QMF for Windows returns LOB
locators that refer back to the actual data on the database. The LOB
data will be retrieved on demand or when a function requires it.

2. Optionally, select View Menu: Options to adjust the default behavior when
retrieving LOBs.
The Options dialog box displays.

3. Click the LOB tab to change the default options.
4. Check Override LOB options, if possible to make changes in the LOB tab.

Note: You can do this only if your database administrator has granted
override authority to you.

View and Edit LOB data
Viewing and editing LOB data is similar. Editing allows you to update the
LOB on the server. Follow these steps to view or edit LOB data:
1. Double-click on a LOB locator cell.

The Column LOB Type Associations dialog box displays. Use this dialog
box to specify the Windows file format of the data.

2. Click Mapping.
The File Extension Mapping dialog box displays.

3. Make changes under the File Extension column.
4. Enter the file extension that corresponds with the mapping value.
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For example, if the mapping value is bitmap, change the file extension to
.bmp.

5. Click OK to return to the Column LOB Type Associations dialog box.
6. Click OK on the Column LOB Type Associations dialog box.

The dialog box closes. Also, the LOB opens in the designated application.

Note: Certain applications display specific file extensions. Refer to the
manual for your application to determine which files are
supported.

7. Click OK when you finish editing the value, or click Cancel to end
editing without saving any changes.
A message box indicates how many rows in the database will be affected
by the operation.

8. Click OK to accept changes, or Cancel to end the operation without
affecting any rows in the database.
A message box confirms the action was completed and displays how
many rows in the database were affected.

9. Click OK.
The LOB locators column now contains icons corresponding to the
application.

Note: Steps 7-9 are used only when editing.
10. Save to the server by choosing Results: Save to Database or by clicking

Save Data on the toolbar.

Exporting LOB data
Map the file extensions before you export LOB data retrieved from the
database (see Viewing and Editing). Once you do this, the export is similar to
exporting ordinary data, but with LOB option specifications.

For example, you export a LOB bitmap and name it photo.htm, and save it as
an HTML file (*.htm) in the Export Data dialog box.

For most LOB data, an HTML form may make the most sense because the file
can be displayed as an HTML address for HTML reports and web pages. For
more sophisticated web pages, use the HTML Form capabilities in QMF for
Windows.

Procedure
Follow these steps to export LOB data into an IXF, TXT or HTML file:
1. Choose Results: Save to File or click Export Data on the toolbar.

The Export Data dialog box displays.
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2. Name the file and choose a file type (*.ixf, *.txt or *.htm) in the Save as
Type list box.

3. Click Options.
The Export Text/DEL Options (General tab) dialog box displays.

4. Click the LOBs tab.
The Export Text/Del Options (LOB tab) dialog box displays.

5. Choose a directory and a naming convention for your LOB data (database
name).

6. Click OK.
The Export Data dialog box displays.

7. Click Save to save the file to the specified directory.
When opened, the text file displays the LOB query results information that
was exported from the query results grid. The HTML file displays an
active link.

8. Click this link to display the LOB data in the appropriate application.

Zoom Edit

The Zoom Edit dialog box displays when you select a cell and press Shift +
F2. Use this dialog to edit individual cells of data on the results grid.

There are two options for accessing the Zoom dialog box:
v Select a cell, right-click, and select Zoom Edit, or
v Select a cell and press Shift + F2

Fields

As is
Displays the data as it appears in the cell.

Advanced
This control toggles the Zoom Edit dialog box between simple and advanced
mode.
v Numeric editing

The Advanced button is disabled when you edit a numeric cell
v Character editing

The Advanced button is enabled when you edit a character cell

When Advanced is enabled, another dialog appears and displays the As is
data in hexadecimal or binary format.
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Hexadecimal
The Advanced button displays the As is data in hexadecimal format. You can
edit the hexadecimal numbers to change the As is data. Also, you can change
the hexadecimal numbers by highlighting the As is data and making updates.

Binary
The Advanced button displays the As is data in binary format. You can edit
the binary numbers to change the As is data. Also, you can change the binary
numbers by highlighting the As is data and making updates.
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Chapter 5. Building Reports

Reports are created by combining query results with formatting from a form.

Forms

Forms are sets of formatting instructions used to create, display, and print a
report.

Form menu

Edit
Edit the contents and formatting of the form from the Form dialog box.

Check
Check the form for errors and warnings.

Perform check on OK
Validate the form automatically when you click OK in the Form dialog box. If
the form is valid, the change is applied.

Convert to HTML form
Convert the active form to an HTML form.

View in a Web browser
View the active HTML report in your default Web browser.

Select query for data
Select the query document from which to get data for the report.

Refresh from query
This option becomes available if you created report using query. The option
will refresh the report’s format using the latest format of associated query.

For example, you run a query, receive a result set, and create a report from
the result set. Then, you display the report and run the query. If you return to
the query and make modifications, such as adding breaks or aggregations,
when you return to the report, the result set will take on the format of the
updated form.

Set server
Select the database server where you want the form to run.
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Set user information
Set your database server user ID, password, and accounting string for the
form.

Set font
Change the display font attributes of your selection.

Understanding forms
Forms are composed of a number of components. These components can be
edited in a form document.

Table 16. Form components

Component Description

Main The primary components of a form, including
headings, footings, and breaks.

Breaks Characteristics, content, and placement of up to six
subtotal lines in a report.

Calculations Report calculation expressions.
Note: You must have IBM’s ObjectREXX installed on
your machine to use form calculations.

Columns Appearance and formatting of columns in the report.
Definable characteristics include column order, format,
usage, indentation, and width.

Conditions Conditional formatting constraints. For example, you
can set the form to not display rows that do not meet
certain characteristics.

Details Report detail headings and body text. This is where
you can combine or replace tabular data with free-form
text to create form letters or address labels.

Final Content and placement of your report’s final text. For
example, you can choose to include final text and
summary data at the end of the report.

HTML Content and placement of HTML tags and formatting
in HTML reports.

Options Miscellaneous appearance options for your report.

Page Content and placement of the page heading and
footing on your report.

Producing a report using a form
Reports are created by combining query results with the formatting options
contained in a form. You can produce multiple reports from a single set of
query results by repeating this process:
1. From the Query Results view, click Display Report.
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The Select Form dialog box opens. Depending on the type of form you
select in the Select From dialog box, you are asked to provide additional
information.

2. Specify the file location or owner and name, or document title.
3. Click OK.

The report is generated using the selected form and current query results.

Editing a form
The Form window provides many options for editing and formatting forms.

From an open form, display the Form menu. The Form menu lists options for
editing and formatting your form. You can also edit any of these components
by clicking the corresponding button on the toolbar.

Creating a form

These steps include sample data from the table Q.STAFF. Try experimenting
with different settings to create your custom forms.

Step 1. Create a form
1. Run the following SQL query to retrieve the data to display in the report:

SELECT * FROM Q.STAFF ORDER BY DEPT,NAME

The query results appear.
2. Click Display Report on the toolbar.

The Select Form dialog box opens.
3. Select the default form.
4. Click OK.

QMF for Windows displays the default report.

Note: To make changes to the default format, click one of the form
component buttons on the toolbar. A button for each form
component is displayed on the Form toolbar.

Step 2. Change column order
Select NAME as the first column in the report and ID as the second. The order of
the columns is specified in the Columns component of the form.
1. Click Columns on the Form menu to display the Columns tab of the Form

dialog box.
2. Change the sequence of a column by typing over the existing sequence

value.
v To make NAME the first column in the report, change its sequence

number (the column in the list labeled Seq) to 1.
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v To make ID the second column in the report, change its sequence
number to 2.

3. Click OK.
QMF for Windows displays the report with the new column order in the
Form window.

Step 3. Change column headings
Set the first column heading to be EMPLOYEE and the second to be COMMISSION.
Column heading text is specified in the Columns component of the form.
1. Click Columns on the Form menu to display the Columns tab of the

Forms dialog box.
2. Change the column heading by typing over the existing column heading

text.
a. Change the first column heading to EMPLOYEE.
b. Change the last column heading to COMMISSION.

3. Click OK.
QMF for Windows displays the report with the new column headings in
the Form window.

Step 4. Change the column format
Change the SALARY column to displayed with the appropriate currency
symbol. The format of a column is determined by its edit code, which is
specified in the Columns component of the form.
1. Click COLUMNS on the Form menu to display the Columns tab of the Forms

dialog box.
2. Change the SALARY column edit code to D2 by typing over the existing edit

code.
3. Click OK.

QMF for Windows displays the report with the SALARY column using the
appropriate currency symbol in the Form window.

Step 5. Add summary information
Divide the report into separate sections for each department. In addition,
present the total SALARY and COMMISSION for each department at the end
of each section. To do this, specify how we want each column in the report to
be used. The usage of a column is determined by its usage code and is
specified in the Columns component of the form.
1. Click Columns on the Form menu to display the Columns tab of the

Forms dialog box.
2. To divide the report into sections based on DEPT, change the usage code

of DEPT to BREAK1.
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Usage codes beginning with the word BREAK produce a section break for
the specified column. The number that follows the word BREAK
determines the break level; up to six break levels are supported in a
report.

3. Include a total SALARY and COMMISSION for each DEPT.
4. Change the usage code of SALARY and COMMISSION to SUM.
5. Include descriptive information at the end of each section break by

clicking Breaks on the Form menu.
6. Specify break footing text on the Breaks tab of the Form dialog box. Set

the first break footing line to Department Total.
7. Click OK.

QMF for Windows displays the Form window.

Step 6. Add page headers and footers
Add a page heading and footing to the report. Page headings and footings are
specified in the Page component of the form.
1. Click Page on the Form menu to display the Page tab of the Form dialog

box.
The top portion of this dialog is used to specify the page heading.

2. Set the first line of the page heading to Department Report and the second
line to Total Salary and Commissions.

3. Choose how you want to align the heading.
4. The bottom portion of this dialog is used to specify the page footing. Set

the first line of the page footing to End Of Page.
5. Choose how you want to align the footing.
6. Click OK.

QMF for Windows displays the Form window.

Saving forms

You can save forms on your PC, on a file server, or at a database server.

Saving a form to a file
1. From an open form, click Save.

a. If the form has been saved before, select Save.
b. If the form has not been previously saved, the Save As dialog box

opens.
2. Enter the name of the file where you want to store the form.
3. Click OK.

The form is saved.
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Opening saved form files
1. Click Open on the toolbar.

The Open dialog box opens.
2. Select the file to open.
3. Click OK.

The selected form opens in a new form document.

Saving forms at the database server
Forms saved at the server can be made accessible to other users. If you want
to share your forms with other users, save them at the database server.
1. From an open form, click Save at Server on the toolbar.

The Save Form dialog box opens.
2. Enter an owner, a name, and select whether to share the saved form with

other users.
3. Click OK.

The form is saved at the server.

Note: If a form with this name exists, you are prompted to overwrite the
existing form.

Opening saved forms at the database server
You can open forms that have been saved at the database server.
1. Click Open From Server on the toolbar.

The Open From Server dialog box opens.
2. Enter a server, owner, and name.
3. Click OK.

The form opens.

Printing reports

You can produce printed reports.
1. Open a form and click Page Setup.
2. Make changes to the layout of the page.
3. Click OK.
4. Click Print Report on the File menu.

The report is printed.
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Exporting reports

You can export a report to a file.
1. Open a form and click Page Setup.
2. May changes to the layout of the page.
3. Click OK.
4. Click Export Report on the File menu.

The Export Report dialog box opens.
5. Enter the name of the file where you want the report stored.
6. Click OK.

The report is exported.
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Chapter 6. Working with Procedures

Linear procedures enable you to run queries, generate reports, edit data, and
perform other functions by executing a single RUN command. For a complete
listing of all the procedure commands supported by QMF for Windows, refer
to the online help facility.

QMF linear procedures

A QMF Linear procedure is a QMF for Windows object that contains
procedure commands instead of containing SQL commands. Where SQL
manipulates data, procedure commands manipulate QMF objects (tables,
queries, forms, and even other procedures). One way to define procedures is
that the user is automating actions that would normally be done by clicking
buttons and menu selections.

Procedures are sets of commands that enable the DBA or other users to run:
v queries
v print reports
v import data
v export data
v perform other functions

Like any other QMF object, procedures can be stored at the database server, or
saved in a file locally or on a file server. All commands issued through
procedures are governed by the resource limits you configured.

Running procedures

Procedures are used to execute multiple functions with one command.

Procedure menu

Run
Run the active procedure. A procedure is a set of commands that enable you
to run queries, print reports, import and export data, and perform other
functions with a single command.

Close all result windows
This option closes all result windows generated by the procedure so, when
the procedure ends, no result windows will remain open.
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Close intermediate result windows
This option closes all intermediate result windows generated by the procedure
so, as the procedure runs, no windows display until the procedure ends.

Uppercase
Format the procedure in uppercase text (if checked) or use the format
provided.

Comment
Use this option to comment out a line in a procedure, typically a line that
describes what a section of the procedure will do. The text that is commented
will not be included when the procedure is run.

This option places two dashes (--) at the beginning of a line in the procedure,
such as:
SET GLOBAL (DSQQW_RPT_USE_PS=0 dsqqw_rpt_font=terminal,
+dsqqw_rpt_font_sz=5, dsqqw_rpt_orient=1
run query potoole.testq
print report
--USE EOM FORM ONLY

Uncomment
Removes the commented line or lines. Once a line is uncommented, it will be
read when the procedure is run.

This option removes the comment flag, two dashes (--), from the beginning of
a line in the procedure, such as:
SET GLOBAL (DSQQW_RPT_USE_PS=0 dsqqw_rpt_font=terminal,
+dsqqw_rpt_font_sz=5, dsqqw_rpt_orient=1
run query potoole.testq
print report
THROUGH 01/01/06

Set server
Select the database server where you want the procedure to run.

Set user information
Set your database server user ID, password, and accounting string for the
procedure.

Set font
Change the display font attributes for the selection.

Creating a linear procedure
Select New: Procedure from the File menu.

A new procedure document opens.
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Creating a procedure with logic
1. Select New: Procedure from the File menu.

A new procedure document opens.
2. Type an IBM Object REXX comment line as the first line of the procedure.

IBM Object REXX comment lines begin with /* and end with */
3. Type the QMF procedure command for the procedure.

Enter the QMF commands in uppercase and enclose the commands in
quote marks.

4. Type the IBM Object REXX commands in the procedure.

Note: IBM Object REXX commands are run locally, not at the database server.
IBM Object REXX must be installed locally.

Running a procedure at a database server
1. Open a new procedure document and type a set of commands, or open an

existing procedure from a file or the database server.
2. Click the Run Procedure icon on the toolbar.

The procedure runs.

Saving procedures

You can save procedures on your PC, on a file server, or at a database server.

Saving procedures to files
1. From an open procedure, click the Save icon on the toolbar or select File:

Save.
If the procedure has been saved before, the procedure is saved. If the
procedure has not been previously saved, the Save As dialog box opens.

2. Enter the name of the file where you want the procedure stored and click
OK.
The procedure is saved.

Opening a saved procedure file
1. Click the Open icon on the toolbar or select File: Open.

The Open dialog box appears.
2. Select the file you want to open and click OK.

The selected procedure opens in a new procedure document.

Saving a procedure to the database server
1. From an open procedure, click the Save at Server icon on the toolbar.

The Save Procedure dialog box opens.
2. Enter an owner and a name.
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3. Specify whether to share the saved procedure with other users.
4. Specify whether to register the object in the Information Catalog.

When checked, the object is registered with the Information Catalog in
DB2 Warehouse Manager. See ″Using the DB2 Warehouse Manager″ below.

5. Click OK.
The procedure is saved at the server and optionally registered with the
Information Catalog in DB2 Warehouse Manager.
If a procedure with this name already exists, you are prompted to
overwrite the previously existing procedure.

Opening saved procedures at the database server
You can open procedures that have been saved at the database server.
1. Click the Open From Server icon on the toolbar.

The Open From Server dialog box opens.
2. Enter a server, owner, and name.
3. Click OK.

The procedure opens.

Using the DB2 Warehouse Manager

With QMF for Windows you can register a QMF for Windows object in the
DB2 Warehouse Manager Information Catalog. This allows the object to be
listed in and launched from the DB2 Warehouse Information Catalog.

How to register objects
QMF for Windows objects may be registered by one of the following methods.

Saving an object at the database server
1. Select File: Save at Server when saving the object for the first time.
2. Click Register the object in the Information Catalog (after you provide owner,

name and other information about the procedure).
The Save Procedure dialog box expands and displays additional
Registration fields.
a. Register immediately

A registration request is sent immediately to the DB2 Warehouse
Manager when the object is saved. The object is registered in
Information Catalog at the same time it is saved at the database server.
v Catalog

The name of the DB2 Warehouse Manager Information Catalog to
which the object will be registered. Your DB2 Warehouse Manager
Information Catalog administrator can give you this information.

v User ID
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The user ID that you are using to register the object. This can be the
same as your database user ID.

v Password
The password that you are using to register the object. The password
can be the same as your database password.

b. Register later

Bundle the object registration information into a tag file to wait for
registration by your DB2 Warehouse Manager Information Catalog
administrator.
v Tag file

The location and file name of the tag file containing the registration
information of the object to be saved. Your DB2 Warehouse Manager
Information Catalog administrator can provide location and file
name information.
Windows generates a tag file that the user places in a folder
designated by the Information Catalog administrator. The
administrator uses the Information Catalog to import this tag file
which registers the object.

Selecting an object from an object list
You can select multiple QMF for Windows objects to be registered
simultaneously.
1. Select an object.
2. Click List: Register in Information Catalog.

The Register Objects in Information Catalogs dialog displays.
3. Select a registration option:

v Register immediately

A registration request is sent immediately to the DB2 Warehouse
Manager when the object is saved. The object is registered in
Information Catalog at the same time it is saved at the database server.
– Catalog

The name of the DB2 Warehouse Manager Information Catalog to
which the object will be registered. Your DB2 Warehouse Manager
Information Catalog administrator can give you this information.

– User ID
The user ID that you are using to register the object. This can be the
same as your database user ID.

– Password
The password that you are using to register the object. The password
can be the same as your database password.

v Register later
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Bundles the object registration information into a tag file to wait for
registration by your DB2 Warehouse Manager Information Catalog
administrator.
– Tag file

The location and file name of the tag file containing the registration
information of the object to be saved. Your DB2 Warehouse Manager
Information Catalog administrator can provide location and file name
information.
Windows generates a tag file that the user places in a folder
designated by the Information Catalog administrator. The
administrator uses the Information Catalog to import this tag file
which registers the object.

Printing procedures

You can print the text of a procedure.

Previewing a procedure
1. Open a procedure.

The procedure commands appear.
2. Select File: Page Setup.

The Page Setup Dialog box opens.
3. Change the page layout.
4. Click OK.
5. Click the Print Preview icon on the toolbar.

A preview of the printed procedure appears.

Printing a procedure
1. Open a procedure.

The procedure commands appear.
2. Click File: Page Setup.

The Page Setup Dialog box opens.
3. Change the page layout.
4. Click OK.
5. Click the Print icon on the toolbar.

The procedure is printed.
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Procedure commands

You can create, edit, and run linear procedures and procedures with logic
(IBM REXX procedures) from QMF for Windows. Procedures are sets of
commands that enable you to run queries, print reports, import and export
data, as well as perform other functions. Procedures can be stored at the
database server, or saved in a file locally or on a file server. All commands
issued through procedures are governed by your resource limits.

Procedure reference
Typically, each line of a procedure contains a single command. However, you
can continue a command over multiple lines by placing a plus sign (+) as a
continuation character in the first column of each additional line.

You can include comments in a procedure by entering two hyphens (--) on a
line. All text following the hyphens through the end of the line is a comment
and is not interpreted by QMF for Windows when running the procedure.

You can use substitution variables to parameterize a procedure. Each time you
run a procedure, it is scanned for substitution variables before it is run. You
must provide values for all substitution variables before you run the
procedure. Values for substitution variables can come from a RUN PROC
command, from global variables, or by displaying the Enter Substitution
Variables dialog box.

The Enter Substitution Variables Values dialog box displays when you run a
dynamic query that contains substitution variables. You use this dialog box to
provide values for these variables. QMF for Windows substitutes the values
you enter for the variables in the query and then sends the query request to
the database server.

Enter the following information at the Enter Substitution Variables Values
dialog box:
v Name

The name of the substitution variable. You cannot modify the variable
name.

v Value

The value to use for this substitution variable. QMF for Windows textually
substitutes the value for each variable in the SQL statement before it sends
the statement to the database server.

Note: Enclose character values in quotation marks.

Current objects
Many procedure commands operate on named objects in the database or
current objects in open documents (referred to as ″temporary storage″).
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The current query object is the most recently activated SQL or prompted query
document. The current form object is the most recently activated form
document. The current procedure object is the most recently activated procedure
document The current report object is a synonym for the current form object.
The current data object is the most recently activated SQL or prompted query
document with query results.

Reading syntax diagrams
The procedure command syntax diagrams read from left to right, top to
bottom. Each command starts with ″>>″ and ends with ″<<″. If a command is
continued from one line to the next, the first line ends with ″>″ and the next
line begins with ″>″.

A command can have two types of parameters:
1. Positional parameters must be placed in a certain position within a

command.
2. Keyword parameters are assigned a value and can be placed in any order

within a command.
The first keyword parameter used in a command must be preceded by a
left parenthesis.

No parameter can be longer than 80 characters. All parameters are separated
by commas. A right parenthesis is not required, but can be used to end the
command.

Required Parameters

Parameters are on the main path if they are required.
>>-- CONNECT TO ServerName ----------------------------------------------<<

When one parameter is on the main path with others listed below, you must
choose at least one from the list.
>>-- DISPLAY --- QUERY --------------------------------------------------<<

+- FORM ---+
+- PROC ---+
+- REPORT -+

Optional Parameters

When a parameter is shown below the main path, it is optional. When all
parameters are shown in a list below the main path, you can specify any one
of them or none.
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>>-- ERASE ------------- ObjectName -------------------------------------<<
+- QUERY -+
+- FORM --+
+- PROC --+
+- TABLE -+

Sometimes two values are separated by a forward slash (/). This indicates
that one of the two values must be entered:
>------------------------------------------------------------------------<<

+- ( CONFIRM = YES/NO -+

BOTTOM command
BOTTOM scrolls to the last row of a query result set. This command is
equivalent to FORWARD MAX.

Syntax
>>-- BOTTOM -------------------------------------------------------------<<

Example
BOTTOM

CONNECT command
CONNECT will establish a connection to a database server. Subsequent procedure
commands will run at the specified server. The running procedure’s server
will also be changed to the specified server. No immediate action is taken
upon any other current objects within the procedure. However, subsequent
commands which affect those objects may result in additional processing.

Example

Assume query Q1 has been run but not completed at server X. The CONNECT
TO ’SERVER Y’ command is then issued, connecting to server Y. Next, the SAVE
DATA AS T1 command is issued.

Query Q1 is not immediately affected by the CONNECT command to server Y,
but the SAVE DATA command requires completion (or cancellation) of query Q1
at server X. Once the data object is completed, the server for query Q1 is
changed to Y, and the data is saved in table T1 at server Y.

Syntax
>>-- CONNECT TO ServerName ----------------------------------------------<<

Chapter 6. Working with Procedures 69



Table 17. CONNECT command parameter

Parameter Description

ServerName The name of a database server.
Note: Enclose the server name in quotes if the name
includes spaces.

Example
CONNECT TO SERVER1

CONVERT command
CONVERT will convert a prompted query to a new SQL query. The original
query (whether a named object in the database or a temporary object) is
unaffected by this operation.

Syntax

For a target object in the database:
>>-- CONVERT ------------- QueryName ------------------------------------<<

+- QUERY -+

For a temporary target object:
>>-- CONVERT QUERY ------------------------------------------------------<<

Example
CONVERT QUERY

DISPLAY command
DISPLAY will display an object in temporary storage or an existing object that
was saved in the database. DISPLAY for an object in temporary storage will act
only upon the current object; there is no way to DISPLAY an object from
temporary storage that is not the current object.

For example, consider the following procedure:
DISPLAY QUERY Q1

DISPLAY QUERY Q2

DISPLAY FORM F1

DISPLAY QUERY

After this procedure runs, query Q2 is the active window, and is the current
query object. Query Q1 is inaccessible from any command accessing
temporary storage. F1 is the current form object and is accessible from a
command accessing the current form object in temporary storage. For
example, DISPLAY FORM would display F1.
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Syntax

For a target object in the database:
>>-- DISPLAY ------------- ObjectName -----------------------------------<<

+- QUERY -+
+- FORM --+
+- PROC --+
+- TABLE -+

For a temporary target object:
>>-- DISPLAY --- QUERY --------------------------------------------------<<

+- FORM ---+
+- PROC ---+
+- REPORT -+

Example
DISPLAY QUERY USER1.QUERY1

DRAW command
DRAW creates a basic query for a table based on the description of the table in
the database.

Syntax
>>-- DRAW TableName -----------------------------------------------------<<

+- ( --- TYPE = --- SELECT -----+
| +- INSERT -+ |
| +- UPDATE -+ |
+- IDENTIFIER = CorrName -+

Table 18. DRAW command parameters

Parameter Description

TableName The name of the table for which to create a query.

TYPE Specifies the type of SQL query to create. The default is
SELECT.

IDENTIFIER The correlation name to be associated with the table in the
resulting query. It is ignored when TYPE=INSERT. There is no
default.

Example
DRAW Q.STAFF (TYPE=SELECT

ERASE command
ERASE removes a query, form, procedure, or table from the database.

Syntax
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>>-- ERASE ------------- ObjectName -------------------------------------<<
+- QUERY -+ +- ( CONFIRM = YES/NO -+
+- FORM --+
+- PROC --+
+- TABLE -+

Table 19. ERASE command parameters

Parameter Description

ObjectName The name of the object to remove from the database.

CONFIRM Specifies whether or not to display a confirmation dialog
before removing the object. If CONFIRM is not specified or
is NO, the corresponding resource limit is used.

Example
ERASE QUERY USER1.QUERY1

EXPORT command
EXPORT copies objects from the database or temporary storage to a file.

Syntax

For a target object in the database:
>>-- EXPORT --- QUERY --- ObjectName TO FileName ------------------------<<

+- PROC --+ +- ( CONFIRM = YES/NO -+

>>-- EXPORT FORM ObjectName TO FileName ---------------------------------->

>------------------------------------------------------------------------<<
+- ( --- CONFIRM = YES/NO -----------+

+- LANGUAGE = ENGLISH/SESSION -+

>>-- EXPORT TABLE ObjectName TO FileName --------------------------------->
+- ( --- CONFIRM = YES/NO -+

+- DATAFORMAT = IXF -+

For a temporary target object:
>>-- EXPORT --- QUERY --- TO FileName -----------------------------------<<

+- PROC --+ +- ( CONFIRM = YES/NO -+

>>-- EXPORT FORM TO FileName --------------------------------------------<<
+- ( --- CONFIRM = YES/NO -----------+

+- LANGUAGE = ENGLISH/SESSION -+

>>-- EXPORT DATA TO FileName --------------------------------------------<<
+- ( --- CONFIRM = YES/NO -+
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+- DATAFORMAT = QMF/IXF/TEXT/HTML/CSV -+
+- OUTPUTMODE = BINARY/CHARACTER/PC -+
+- LOBSINFILE = YES/NO -+
+- LOBSTO = path1;path2; -+
+- LOBFILE = basefile1;basefile2; -+

>>-- EXPORT REPORT TO FileName ------------------------------------------<<
+- ( --- CONFIRM = YES/NO --+

+- DATAFORMAT = QMF/HTML/TEXT -+

Table 20. EXPORT command parameters

Parameter Description

ObjectName The name of the object to export from the database.

FileName The name of the file to which to export the object.

CONFIRM Specifies whether or not to display a confirmation dialog
before replacing an existing file. If CONFIRM is not
specified or is NO, the corresponding resource limit is used.

LANGUAGE Specifies whether a form is exported in English or in the
current session language. A form that is exported in English
can be run in any NLF session. A form exported in the
session language can only be run in a session of the same
language. The default value is provided by the
DSQEC_FORM_LANG global variable.

DATAFORMAT Specifies the file format of the exported data. If you omit
this parameter, the DSQQW_EXP_DT_FRMT global variable
supplies the format to be used. It can be set to any of ’0’
(text format), ’2’ (HTML format), ’3’ (CSV format), or ’4’ (IXF
format). If you specify IXF, the DSQQW_EXP_OUT_MDE
global variable can be set to either ’0’ for character mode
System/370 IXF or ’1’ for PC/IXF.

For Reports

QMF format is not supported in the Windows environment.
HTML format adds the <PRE> tag. TEXT is for a text-based
file.

OUTPUTMODE Specifies the output format of the data.

LOBSINFILE Specifies whether or not LOBs are included in the exported
data.

LOBSTO The location to save the LOBs.

LOBSFILE The base name of the exported LOBs.

Example
EXPORT QUERY USER1.QUERY TO C:\Queries\query1.qry
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FORWARD command
FORWARD scrolls forward in a query result set. The only acceptable parameter
for this command is MAX, making it equivalent to BOTTOM.

Syntax
>>-- FORWARD MAX --------------------------------------------------------<<

Example
FORWARD MAX

IMPORT command
IMPORT copies data from a file into temporary storage or the database.

Syntax

For a target object in the database:
>>-- IMPORT --- QUERY --- ObjectName FROM FileName ------------------------>

+- PROC --+

>------------------------------------------------------------------------<<
+- ( --- CONFIRM = YES/NO ---+

+- COMMENT = Text ---+
+- SHARE = YES/NO ---+

>>-- IMPORT FORM ObjectName FROM FileName --------------------------------->

>------------------------------------------------------------------------<<
+- ( --- CONFIRM = YES/NO -------------+

+- COMMENT = Text -------------+
+- LANGUAGE = ENGLISH/SESSION -+
+- SHARE = YES/NO -------------+

>>-- IMPORT TABLE ObjectName FROM FileName -------------------------------->
>------------------------------------------------------------------------<<

+- ( --- CONFIRM = YES/NO ----------+
+- COMMENT = Text ----------+
+- ACTION = REPLACE/APPEND -+

For a temporary target object:
>>-- IMPORT --- QUERY --- FROM FileName ---------------------------------<<

+- PROC --+
+- FORM --+
+- DATA --+

+- LOBSFROM = path1;path2; -+

Table 21. IMPORT command parameters

Parameter Description

ObjectName The name of the object to import into the database.

FileName The name of the file from which to import the object.
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Table 21. IMPORT command parameters (continued)

Parameter Description

CONFIRM Specifies whether to display a confirmation dialog before
replacing an existing object. If CONFIRM is not specified or is
NO, the corresponding resource limit is used.

COMMENT Specifies a comment with the imported object. Enclose the
text in quotes.

SHARE Specifies whether other users are allowed to use the
imported object.

LANGUAGE Specifies whether a form is imported in English or in the
current session language. A form that is imported in English
can be run in any NLF session. A form that is imported in
the session language can only be run in a session of the
same language. The default value is provided by the
DSQEC_FORM_LANG global variable.

ACTION Specifies whether to replace the entire database table or
append data to the existing table.

LOBSFROM The LOBs location

Example
IMPORT QUERY FROM C:\Queries\query1.qry

PRINT command
PRINT prints a copy of an object in temporary storage or from the database.

Syntax

For a target object from the database:
>>-- PRINT ------------- ObjectName -------------------------------------<<

+- QUERY -+ +- PRINTER = Printer -+
+- PROC --+
+- TABLE -+

For a temporary target object:
>-- PRINT --- QUERY ------------------------------------------------------<<

+- PROC --+ +- PRINTER = Printer -+
+- TABLE -+

>>-- PRINT REPORT -------------------------------------------------------<<

>------------------------------------------------------------------------<<
+- ( --- DATETIME = YES/NO ----------+

+- PAGENO = YES/NO ------------+
+- PRINTER = Printer ----------+
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+- FORM = --- FORM ------------+
+- FormName --------+

+- COPIES = NumChars ----------+
+- TYPEFACE = fontname --------+
+- SIZE = NumChars ------------+
+- BOLD = YES/NO --------------+
+- ITALIC = YES/NO ------------+
+- CHARSET = ANSI/DEFAULTS/SYMBOL/SHIFTJIIS/GB2312/ -------+

HANGUEL/CHINESEBIG5/OEM/JOHAB/HEBREW/ --------+
ARABIC/GREEK/TURKISH/THAI/EASTEUROPE/ --------+
RUSSIAN/MAC/BALTIC/ --------------------------+

+- ORIENTATION = PORTRAIT/LANDSCAPE -----------------------+
+- USEFORMPS = YES/NO ----------+
+- LENGTH = NumChars/CONT/AUTO -+

+- CONT -----------+
+- WIDTH = NumChars/CONT/AUTO --+

Table 22. PRINT command parameters

Parameter Description

ObjectName The name of the object to print.

DATETIME Whether to include the current date and time in the page
footing. When you print a report, the date and time are
printed in the page footing unless you specify DATETIME=NO
or include the &DATE or &TIME variables in the page text in
the form. If included, the date and time are formatted
according to the current Windows regional settings.

PAGENO Whether to include page numbers in the page footing. When
you print a report, page numbers are printed in the page
footing unless you specify PAGENO=NO or include the &PAGE
variable in the page text in the form.

PRINTER The name of the printer on which to print the object or
report.

FORM The form to use when generating the report. You can specify
the keyword FORM to use the current form object, or
specify the name of a form saved in the database.

COPIES The number of copies to print when printing the object.

TYPEFACE The font type face to use when printing the object.

SIZE The font size to use when printing the object.

BOLD Whether to use bold text when printing the object.

ITALIC Whether to use italic text when printing the object.

CHARSET The character set to use when printing the object.

ORIENTATION The paper orientation of the printed object.

USEFORMPS Whether to use the Windows form associated with the
object.
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Table 22. PRINT command parameters (continued)

Parameter Description

LENGTH LENGTH is one of the following:

v The maximum number of lines to print on each page
(from 1 to 999)

v CONT (to cause continuous printing without page breaks)

v AUTO

If LENGTH is omitted, the values of the DSQQW_RPT_LEN_TYP
and DSQQW_RPT_NUM_LINES global variables are used.

WIDTH WIDTH is one of the following:

v The maximum number of characters to print on each line
(from 1 to 999)

v CONT (to cause continuous printing without page breaks)

v AUTO

When you print a report, lines longer than WIDTH are
formatted on a subsequent page.

Example
PRINT QUERY

PRINT REPORT (LENGTH=60, DATETIME=NO

RESET GLOBAL ALL command
RESET GLOBAL ALL deletes the names and values of global variables that have
been set using the SET GLOBAL command.

Syntax
>>-- RESET GLOBAL (Variable1, Variable2 ... ------------------------<<

or
>>-- RESET GLOBAL ALL ----------------------------------<<
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Table 23. RESET GLOBAL ALL command parameters

Parameter Description

VariableName The names of specific variables to be deleted. You can name
up to 10 variables previously set by the SET GLOBAL
command.

ALL deletes the names and values of all variables previously
set by the SET GLOBAL command. If you do not have several
global variables defined, or you do not remember the names
of your global variables, you can use this parameter to reset
all global variables at one time. Variables whose names
begin with DSQ are restricted, and cannot be deleted.
Note: You can use global variables in queries, procedures,
and forms, but not in the DB2 Table Editor.

When you issue RESET GLOBAL ?, a prompt is displayed.
Here, fill in the names of the variables you want to reset.

On the Global Variable List dialog, you can reset a variable
by positioning your cursor on the line you want to delete
and pressing Delete.

For example, to delete the values for all global variables that
were previously set, type:

RESET GLOBAL ALL

To delete the values only for the variables named DEPT and
LOCATION, type:

RESET GLOBAL (DEPT LOCATION

Example
RESET GLOBAL (Variable1, Variable2

or
RESET GLOBAL ALL

RUN command
RUN executes procedures or queries from temporary storage or the database.

Syntax

For a target object from the database:
>>-- RUN ------------- ObjectName --------------------------------<<

+- QUERY -+ +- ( --- &&Variable = Value ----+
+- CONFIRM = YES/NO ------+
+- FORM = --- FORM -------+
| +- FormName -+ |
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+- ROWLIMIT = NumRows-----+

>>-- RUN ------------ ObjectName ----------------------------------------<<
+- PROC -+ +- ( &&Variable = Value ... -+

For a temporary target object:
>>-- RUN QUERY ----------------------------------------------------------<<

+- ( --- &&Variable = Value ----+
+- CONFIRM = YES/NO ------+
+- FORM = --- FORM -------+
| +- FormName -+ |
+- ROWLIMIT = NumRows/NO -+

>>-- RUN PROC -----------------------------------------------------------<<
+- ( &&Variable = Value ... -+

Table 24. RUN command parameters

Parameter Description

ObjectName The name of the query or procedure to run.

&&Variable Assigns a value to a variable in the query or procedure that
is run. The variable name can be from 1 to 17 characters
long and the value can be from 1 to 55 characters long. You
can specify any number of variables and values on the RUN
command. The user will be prompted for the values of the
variables if there are variables in the query or procedure that
are not given values on the RUN command, and these
variables are not global variables.

Once a global variable it set, the variable can be used for an
entire QMF for Windows session. A global variable can be
used in a query, form, or procedure.

When you include variable assignments in a procedure, you
must use two ampersands (&&) to prevent variable
substitution before the procedure is run.

CONFIRM Specifies whether to display a confirmation dialog before
replacing or changing an object as a result of this command.
If CONFIRM is not specified or is NO, the corresponding
resource limit is used.

A resource limit specifies limits and controls that govern the
use of database and communication resources by QMF for
Windows users.

FORM Specifies a form to use when generating a displayed report
using the data retrieved by the query. You can specify the
keyword FORM to use the current form object, or specify
the name of a form saved in the database.

ROWLIMIT Specifies the maximum number of rows to retrieve for the
query.
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Example
RUNQUERY USER1.QUERY1 (&&Var1=10

SAVE command
SAVE stores the contents of an object in temporary storage into the database.

Syntax
>>-- SAVE --- QUERY --- AS ObjectName -----------------------------------<<

+- PROC --+ +- ( --- COMMENT = Text ---+
+- CONFIRM = YES/NO -+
+- SHARE = YES/NO ---+

>>-- SAVE FORM AS ObjectName --------------------------------------------<<
+- ( --- COMMENT = Text -------------+

+- CONFIRM = YES/NO -----------+
+- SHARE = YES/NO -------------+
+- LANGUAGE = ENGLISH/SESSION -+

>>-- SAVE DATA AS TableName ---------------------------------------------<<
+- ( --- COMMENT = Text ----------+

+- CONFIRM = YES/NO --------+
+- METHOD = REGULAR/FAST --------+
+- SCOPE = NumChars --------+
+- ROWIDADD = YES/NO --------+

+- ROWIDNAME = Text ---------+
+- ROWIDDISP = ALWAYS/BYDEFAULT --------+
+- ROWIDDISPnnn = EXCLUDE/CONVERT/ALWAYS/BYDEFAULT+
+- ACTION = REPLACE/APPEND -+

Table 25. SAVE command parameters

Parameter Description

ObjectName The name to assign to the object (query, form, procedure, or
table) when it is saved.

COMMENT A comment with the saved object. Enclose the text in quotes.

CONFIRM Whether to display a confirmation dialog before replacing or
changing an object as a result of this command. If
CONFIRM is not specified or is NO, the corresponding
resource limit is used.

SHARE Whether other users are allowed to use the saved object.

LANGUAGE Whether a form is saved in English or in the current session
language. A form that is saved in English can be run in any
NLF session. A form that is saved in the session language
can only be run in a session of the same language. The
default value is provided by the DSQEC_FORM_LANG
global variable.
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Table 25. SAVE command parameters (continued)

Parameter Description

METHOD The method of saving the data. A regular save send data
from the client back to the database server to be inserted
into the table. Fast saved data reruns the query at the server
and inserts the results directly into the table.

SCOPE The commit scope of the data.

ROWIDADD Whether to add the Row ID column to the table.

ROWIDNAME The name to assign to the new Row ID column.

ROWIDDISP The disposition of the new Row ID column.

ROWIDDISPnnn The disposition of existing Row ID columns.

ACTION Whether to replace the entire database table or append data
to the existing table.

Example
SAVE QUERY AS USER1.QUERY1 (CONFIRM=NO

SEND TO command
SEND TO exports reports and data from the database or temporary storage and
sends them to the specified target or application in your Send To folder.

Syntax

For a temporary target object:
>>-- SEND DATA TO Target ------------------------------------------------<<

+- DATAFORMAT = IXF -+

>>-- SEND REPORT TO Target ----------------------------------------------<<
+- DATAFORMAT = HTML -+

Table 26. SEND TO command parameters

Parameter Description

Target The name of the file to which to export the object. Targets
containing space characters must be enclosed in single or
double quotes.
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Table 26. SEND TO command parameters (continued)

Parameter Description

DATAFORMAT The file format of the exported data or report. If you omit
this parameter, the DSQQW_EXP_DT_FRMT global variable
supplies the format to be used. It can be set to:

v ’0’ (text format)

v ’2’ (HTML format)

v ’3’ (CSV format)

v ’4’ (IXF format)

If you specify IXF, the DSQQW_EXP_OUT_MDE global
variable can be set to either ’0’ for character mode
System/370 IXF or ’1’ for PC/IXF data.

Example
SEND DATA TO "Excel Shortcut"

SET GLOBAL command
SET GLOBAL sets the values of existing global variables or creates new variables
and values. Any new global variables created exist for the entire QMF for
Windows session (unless deleted manually).

Syntax
>>-- SET GLOBAL ( VariableName = Value, ... ----------------------------<<

Table 27. SET GLOBAL command parameters

Parameter Description

VariableName The name of the global variable to set or create. Global
variable names can be from 1 to 17 characters long.
Variables whose names begin with DSQ are restricted, and
cannot be created or deleted.

Value The value to give the global variable. The value can be from
1 to 55 characters long. The values of variables whose names
begin with DSQ are restricted. See Working with Global
Variables for more information.

Example
SET GLOBAL (Var1=abc, Var2=def

SHOW command
SHOW displays objects from temporary storage and is similar to DISPLAY.
v SHOW QUERY, SHOW FORM, and SHOW PROC activate the current query, form or

procedure window.
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v SHOW REPORT is a synonym for SHOW FORM.
v SHOW GLOBALS opens the Global Variables dialog box.

Syntax
>>-- SHOW --- FORM -------------------------------------------------------<<

+- PROC ----+
+- REPORT --+
+- GLOBALS -+

>>-- SHOW QUERY ----------------------------------------------<<
+- ( --- VIEW = SQL/PROMPTED/NATURAL/RESULTS/STATUS/ ----+

+- RESULTSET = NumChars -----------+

Table 28. SHOW command parameters

Parameter Description

VIEW Specifies the appearance of the target query.

RESULTSETS The maximum number of characters in the result set.

Example
SHOW QUERY

WINDOWS command
The WINDOWS command activates the target Windows application, document, or
URL.

Syntax
>>-- WINDOWS CommandLine ------------------------------------------------<<

Table 29. WINDOWS command parameters

Parameter Description

CommandLine An application command line, document name, or URL to
launch. The command is launched and execution of the
procedure continues without waiting for completion of the
command.

Example
WINDOWS

c:\programs\notepad.exe

Sample procedure

The following sample procedure demonstrates how to display, run, and print
a report using a query and form. It also creates a new query based on a table,
runs that query, exports the data to a file, and saves the data in a table at a
different database server.
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SET GLOBAL (TABLE=SMITH.PAYROLL
DISPLAY QUERY SMITH.PAYROLL_QUERY
RUN QUERY (FORM=SMITH.PAYROLLFORM
PRINT REPORT
DRAW SMITH.PAYROLLTABLE (TYPE=SELECT
RUN QUERY
EXPORT DATA TO C:\TEMP\EXP1.IXF (DATAFORMAT=IXF

CONNECT TO ’OS/2 SERVERC’
SAVE DATA AS SMITH.DATASAVE
SHOW REPORT
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Chapter 7. Working with Lists

Lists provide you with an easy way to view collections of QMF objects.

Objects

QMF for Windows recognizes four types of objects:
v Queries
v Forms
v Procedures
v Tables

You can use the List window to view the objects based on the object name,
owner, and type.

Listing objects
1. Select File: New List.

The List window opens.
2. Specify an owner and a name.

Note: You can use patterns to select objects from a list of matching objects.
v Use the percent character (%) to match a string of any length

containing any characters. For example, to list all tables with a
name beginning with the letter A, enter A%.

v Use the underscore character (_) to match a single character. For
example, to list all tables with an owner that has the letter A in
the second position, enter _A%.

3. Select the type of object for which you are searching.
4. Click Refresh List.

A list of matching objects saved at the database server is displayed.

List window commands

Right-clicking an object in the List window displays a list of commands
identical to those on the List menu.

Display object
Opens the selected object for viewing. This option is available for queries,
forms, procedures, and tables.
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Run object
Runs the selected object. This option is available for queries and procedures.

Draw object
Creates a query based on the selected table. You can draw an SQL SELECT
query, an SQL UPDATE query, an SQL INSERT query or a prompted query.
This option is available for tables.

Edit object
Opens the Table Editor for editing this table. This option is available for
tables.

Properties
Displays the properties of the selected object, including comments, attributes,
and historical usage information. This option is available for queries, forms,
procedures, and tables.

Creating lists

You can create lists to serve as collections of objects. For example, you could
create a list of all inventory-related queries, forms, procedures, and tables to
keep your work in one place. Once created, you can add and remove objects
from the list and save the list for future use.

Adding objects to lists
You can add objects to lists.

From an open list, specify the owner and name information of the objects that
you want to add and click Add to List on the toolbar.

The objects matching the owner and name are added to the list.

Removing objects from lists
You can remove unrelated objects from lists.

From an open list, click Remove on the toolbar.

The object is removed from the list, but is not deleted.

Saving lists to files
1. From an open list, click Save on the toolbar.

If the list has been saved before, the list is saved. If the list has not been
previously saved, the Save As dialog box opens.

2. Enter the name of the file where you want the list stored and click OK.
The list is saved.
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Opening saved list files
1. Click Open on the toolbar.

The Open dialog box opens.
2. Select the file that you want to open and click OK.

The selected list opens in a list document.
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Chapter 8. Working with Static Queries

A static query is an SQL query that has been previously passed to a database
server and bound into a package. When a static query is run, the database
server uses the SQL text bound in the package, rather than the SQL text
currently appearing in the query window. Static queries are more resource
efficient than dynamic queries, but static queries cannot be edited.

Static queries

Static queries are created from previously existing SQL and prompted queries.

Creating static queries
1. From the Query menu, select Bind Static Package.

The Bind Static Package dialog box opens.
2. Select the Package tab, enter a collection ID and package name and change

any other options.
3. If the query contains any substitution variables, select the Variables tab.
4. Replace any substitution variables with host variables.
5. Click OK.

The static query is bound.

Note: After you bind a query, you must also save that query to a file or to
the database server.

Replacing substitution variables with host variables
When you bind a package, you must specify a host variable to use in place of
each substitution variable in the SQL text. However, a substitution variable
cannot always be directly replaced by a host variable. Substitution variables
provide direct text substitution in the query text before the text is sent to the
database server. Host variables are sent as part of the query to the database
server. Refer to the documentation for your database server for rules on where
and how host variables can be used in queries.

After you specify a relationship between a substitution variable and a host
variable, QMF for Windows remembers the relationship, and suggests it in
future queries, making binding packages simpler.

The valid data types for host variables are:
v CHAR(n)
v VARCHAR(n)
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v INTEGER
v SMALLINT
v FLOAT
v DECIMAL(p,s)
v DATE
v TIME
v TIMESTAMP

Procedure
1. From the Bind Static Package dialog box, select the Input Variables tab.
2. Enter the type of variable for each host variable and click OK.

The substitution variables are converted to host variables.

Running a static query
You run static queries as you would any other queries. See “SQL Queries”.
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Chapter 9. Working with the Table Editor

Use the table editor to search for, add, edit, or delete data stored in your
tables without having to write SQL statements.

About the Table Editor

The table editor gives you flexibility in editing and searching your data.

Searching for rows using the table editor
1. From the File menu, select Table Editor.

The Table Editor dialog box opens.
2. Specify a table.

Note: You can use patterns to select table names from a list of matching
tables.

v Use the percent character (%) to match a string of any length containing
any characters. For example, to list all tables with a name beginning
with the letter A, enter A%.

v Use the underscore character (_) to match a single character. For
example, to list all tables with an owner that has the letter A in the
second position, enter _A%.

3. Once you enter a pattern, click List Tables.
4. Select a table from the resulting list.
5. Select a Save Mode.

v Immediate

The table is updated at the database server immediately after each
change.

v End

The table is updated at the database server after you finish entering all
changes. Other users will not be able to make changes to the table while
you are making your changes.

6. Click Edit.
The Edit Table dialog box opens.

7. Enter search conditions:
v Simple search

Enter search values in the Value column.
v Advanced search
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Enter search criteria in the Additional search criteria field to specify
more complex search conditions.

Note: You can enter any valid SQL predicate in the Additional search
criteria field.

8. Click Start Search.
The first matching row is displayed in the Value column.

Adding a row
1. In the Edit Table dialog box, enter information for the new record.
2. Click Insert Row.

The new row is added to the table.
3. Click OK.

Your changes are saved.

Changing a row
1. From the Edit Table dialog box, search for the row you want to change.
2. Click Next Row until the row you want to change is displayed.
3. Edit the data in the Value column.
4. Click Update Row.

The row is updated.
5. Click OK.

Your changes are saved.

Deleting a row
1. From the Edit Table dialog box, search for the row that you want to delete.
2. Click Next Row until the row you want to delete is displayed.
3. Click Delete Row.

The row is deleted.
4. Click OK.

Your changes are saved.

Editing tables from the query results view

You can edit tables directly from the query results view.

Deleting a row from the query results view
You can delete individual rows from tables in the query results view.

From the query results view, select a row and select Delete from the Edit
menu. The row is deleted.
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Updating columns from the query results view
You can update the contents of individual columns in the query results view.

From the query results view, double click on a cell, enter a new value, and
press Enter. The table is updated.
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Chapter 10. Distributing Data

You can export your data to other databases and applications.

Exporting data

You can export data from QMF for Windows into other applications in the
following ways:
v Export the data into a Text, CSV, IXF, or HTML file
v Save the query results to a table
v Add query results directly into a Microsoft Excel or Lotus 1-2-3 spreadsheet

Exporting data to files
1. While viewing query results, click Export Data on the File menu.

The Export Data dialog box appears.
2. Select the desired Output File Type and click Options.

Depending on the type of output file you select, either the Export
Text/DEL Options dialog box, the Export HTML Options dialog box, the
Export IXF Options dialog box, or the Export CSV Options dialog box
appears.
v You can produce a text file, with a .TXT extension. This is a standard

ASCII file with optional string and column delimiters (as specified in
the Export Text/DEL Options dialog box).

v You can produce an HTML file with an .HTM extension file. This is an
HTML file that can be viewed by any web browser. All of the HTML
tags are automatically generated in the file; it is ready to be published
on your Internet or intranet web site. The options you choose on the
Export HTML Options dialog box control the appearance of the
exported data.

v You can produce an IXF file. An IXF export preserves all database
information, including column headings and data types. It is typically
used to transfer information from one database to another.

v You can produce a .CSV file. A .CSV export is similar to a text export,
using a comma as the column delimiter. This format is most commonly
used by spreadsheet applications.

3. Select the options for the desired export file.
4. Click OK.

The Options dialog box closes.
5. Click OK on the Export Data dialog box.
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The data is exported.

Importing data
You can import data that has been saved in an IXF file. Once data is imported
into a query window, it can be saved to a database server, exported to a new
file, or used for reports. PC/IXF and character mode System/370IXF files are
supported.
1. From the File menu, click Import Data.

The Import Data dialog box opens.
2. Select the file you want to import and click OK.

The imported data is displayed in a new query window.

IXF messages
The IXF Messages dialog box displays when you export or import data
successfully into an IXF format file.

Messages

The messages section of this dialog displays detailed data and process
information when exporting to or importing from an IXF file, such as the
number of rows imported and exported, which rows are rejected, and which
data is truncated, for example.

The edit box is read-only; however, you can select and copy these messages.

OK

Closes the dialog box.

Sample messages

Sample messages are presented below:
The H record in the PC/IXF file has product "DB202.00, date "20011025 time "160300",
single CCSID "0" and double CCSID "0".

The C record in the PC/IXF file has column name "ID", data type "INTEGER",
single CCSID "0", and double CCSID "0"
...
The T record in the PC/IXF file has a name "STAFF", qualifier "Q", and source "TEST".
...
The application is beginning to export data to file c:\temp.IXF.
...
The row 5 is rejected.
The data in (1,3) is truncated.
The data in (4,3) is truncated
...
Number of rows rejected = 1.
Number of data truncated = 2.
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Number of rows exported = 10.
...
The application has completed processing. "26" rows were exported from the file c:\temp.IXF.

Saving data to a database server
Imported query results can be saved to a database table.
1. While viewing imported query results, click Save Data on the File menu.

The Save data dialog box appears.
2. Select a database server, enter a table owner and name, or choose any

other options.
3. Click OK.

The data is saved.

Using the Microsoft Excel add-in

The 32-bit version of QMF for Windows includes an add-in for Microsoft
Excel 7.0 or later. These add-ins enable you to run QMF for Windows from
Excel and return query results directly into a spreadsheet. The appropriate
add-in is automatically installed if you choose the ″Typical″ installation
option, or if you choose the ″Custom″ installation option and select the
Microsoft Excel Add-In.
1. Click QMF for Windows on the Excel toolbar.

QMF for Windows activates.
2. From QMF for Windows, select and run a query.

The query results appear.
3. Select the data you want to return to Excel.
4. From the File menu, click Return data to Microsoft Excel.

Excel activates and displays the QMF for Windows Add-In dialog box.
5. Enter the destination range for the data.
6. Click OK.

The data is added to the spreadsheet.

Using the Lotus 1-2-3 add-in

The 32-bit version of QMF for Windows includes an add-in for Lotus 1-2-3
that enables you to run QMF for Windows from 1-2-3 and return query results
directly into a spreadsheet. This add-in is installed if you choose the ″Typical″
installation option, or if you choose the ″Custom″ installation option and
select the Lotus 1-2-3 Add-In option.
1. Click QMF for Windows on the 1-2-3 toolbar.

QMF for Windows activates.
2. From QMF for Windows, select and run a query.
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The query results appear.
3. Select the data you want to return to Lotus 1-2-3.
4. From the File menu, click Return data to Lotus 1-2-3.

The Data Option dialog box appears. Lotus 1-2-3 activates and displays
the QMF for Windows Add-In dialog box.

5. Enter the destination range for the data.
6. Click OK.

The data is added to the spreadsheet.

Using sample applications

Several sample applications and integration solutions are available for QMF
for Windows. Visit the IBM web site at http://www.ibm.com/qmf/ to find
out more.

Building an application using the QMF for Windows API

You can build your own applications using QMF for Windows. Refer to the
online API online help for a complete listing of all the API functions and their
effects. Visit the IBM web site at http://www.ibm.com/qmf/ to see
programming examples.
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Chapter 11. Working with Job Files

You can schedule and run procedures using job files. Job files store procedure
parameters and use the Windows scheduler to run the procedures according
to your preset time and date.

Job files allow you to schedule lengthy or resource intensive queries to run at
more convenient times.

Job files

You can create job files and store them locally or at the database server.

Query menu

Set server
Select the database server that contains the procedure you want to run.

Set user information
Set your database server user ID, password, and accounting string for the
active job.

Run
Run the job in a separate QMF for Windows instance, which leaves the
current session open to perform other tasks.

Test
Run the scheduled task at the same time that QMF for Windows runs the SQL
for that task. Both are done in the same instance, but in separate windows.

Schedule
Schedule the job using the Windows Schedule Job dialog box.

View scheduled tasks
Open the Scheduled Tasks dialog box.

Creating job files
From the File menu, select New Job. A new job document opens. You can
save the job file locally or at the database server.

Saving a job file to a file
You can save job files locally or at a database server.
1. From an open job file, select Save from the File menu

The Save As dialog box opens.
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2. Specify a location and file name.
3. Click OK.

The job file is saved.

Saving a job file to a server
You can save a job file to a database server.

From an open job file, select Save At Server from the File menu.

Running job files
You can run job files that have been saved locally or that have been saved at a
database server.
1. Open a job file.
2. Click Run Job on the toolbar.

The job file runs.

Scheduling job files
You can schedule job files to run unattended using the Windows scheduler.

Note: To schedule a job file that has been saved locally, you must have saved
your user ID and password with the job file. Your password is saved as
encrypted text, but still could be vulnerable to discovery.

1. Open a job file.
2. Click Schedule Job on the toolbar.

The Schedule Job dialog box opens.
3. Specify the scheduling information for the job file.
4. Click OK.

The job is scheduled.
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Chapter 12. Working with QMF Report Center

Use QMF Report Center to produce custom reports by using shared QMF
objects (queries, forms, procedures, and tables). With quick access to these
objects, you can specify data format preferences and produce custom reports
that can be viewed and manipulated in a variety of applications. The Report
Center is a simple user interface that launches centrally-shared queries and
QMF reports and sends the results to spreadsheets, desktop databases, and
browsers.

The QMF for Windows Report Center module is installed with QMF for
Windows and QMF for Windows Administrator.

Features

Queries and reports can be stored and run against multiple DB2 database
servers. Results may be viewed, formatted, and saved. Individual users can
create lists of favorites and send them to Favorites folders on their desktops in
various formats, such as Microsoft Excel, Microsoft Access, Lotus 1-2-3 or .txt
files.

Administrators can set governing limits based on schedules and user groups
that restrict the user from running very large reports to certain times of the
day or various days of the week. Additionally, only the administrator can
make queries and reports available to Report Center users, and retain
distribution and central control over these reports.

Definitions

v A query is a description of a result set of data to retrieve from a database
server.

Note: Queries cannot be created or modified in QMF Report Center.
v A table is a collection of stored data. You interact with tables by running

queries.
v A form contains the formatting instructions for generating report from

query results.
v A procedure is a set of commands for running queries, printing reports,

importing and exporting data, and performing other functions.
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Getting started in QMF Report Center

QMF Report Center window

Navigation
1. Right-click on any object or folder to activate the same options that are

available from the toolbar menus.
2. Click the plus symbol (+) next to any folder to open the first level of

contents.

Note: Hold down SHIFT while clicking the plus symbol (+) to open all
levels beneath the folder.

Directory structure
The QMF Report Center window contains a tree-like structure of available
Favorites, DB2 servers, Public Favorites, objects, and a Recycle Bin.

Objects are represented by an icon, such as a query or database server icon.
This allows you to expand the objects for each server and see all other
available servers.

Favorites
The Favorites folder contains reports based on objects that reside on a server.
Reports are created by copying objects to your Favorites folder. The objects
are not physically located on your hard drive; instead, the reports link to
objects on the server.

DB2 servers
Lists all DB2 servers that are in your server definition file (SDF). You can also
view servers you cannot access.

Reports
Lists, by server name, all available objects to which you have access.

Public favorites
A folder residing on a server. This folder, like personal Favorites, contains
reports, though any user can access Public Favorites.

Recycle bin
Contains all folders and reports you delete from your Favorites folder.

Deleted items remain in the Recycle Bin until you empty the bin. The Recycle
Bin acts as an ″undo″ feature because you can move items out of the bin and
back to your Favorites.
v Deleting

With the item selected, choose Edit: Delete, or
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With the item selected, right-click and choose Delete

v Emptying

Choose Report: Empty recycle bin

Note: You cannot undo this operation because items will be deleted
permanently.

v Restoring

Drag the item from the Recycle Bin to the desired location.

Working with folders and favorites
Folders group reports and QMF objects. Folders are named according to object
owner names. You can perform the same operations on folders that you do on
reports, such as running reports and defining report properties.

Note: Performing operations on a top-level folder applies the operation to
every report contained within the folder.

For example, if you want to run the reports within a folder consecutively,
select the folder, then select Run from the Report menu.

QMF Report Center contains two top-level folders in which you can store
reports. The folders contain reports that point to objects on servers. These
objects are not contained within the Favorites folders.
v Your personal Favorites folder resides locally (on your PC). You are the

only user who can access the folder and its contents.
v The Public Favorites folder resides on the server and can be accessed by all

authorized users.
You may have access to several Public Favorites folders, depending on your
resource limits, although there will never be more than one public Favorites
folder on each server.

When you copy QMF objects to the Favorites folders, the folders are renamed
automatically to include the object type and owner name. When you copy an
entire object type (for example, a folder of same-type objects) from a server
(for example, containing all queries), the server name is also included in the
new folder name.

Adding reports to Favorites
You can add any object or report from a server to your personal Favorites
folder, or to the Public Favorites folder on a server (with permission from
your system administrator).

Personal Favorites: Select the report or object, then choose:
v Add to favorites from the Report menu, or
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v drag the report or object to your personal Favorites folder

A report is added to the top of your personal Favorites folder with the
following naming convention:
Objecttype OWNERNAME.OBJECT NAME

For example:
Query QMFGUEST."SELECT"

Public Favorites: Drag the QMF object or report to the Public Favorites
folder on a server. You can add reports from your personal Favorites folder or
from any server.

Note: When adding to Public Favorites or modifying reports in Public
Favorites, select Save changes to Public Favorites from the Report
menu before your updates are saved to the server.

Menu options

Report menu

Table 30. Report menu options

Field Description

Add to favorites Add a pointer in your Favorites folder to the selected
table, procedure, or query.
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Table 30. Report menu options (continued)

Field Description

Create shortcut Create a shortcut (.QRS file) to the selected personal
favorite at the location you specify.

You can create a shortcut to specific reports in your
Favorites folder. The shortcut lets you access a report
by launching QMF Report Center and locating the
report associated with the shortcut.

Follow these steps to create a shortcut:

1. Select the report.

2. Choose Report: Create a shortcut, or with the
report selected, right-click and choose Create a
shortcut.

3. Specify a filename and location for the shortcut.

4. Click OK.

The extension .qrs is added to the filename.

5. Double-click the shortcut to launch the report.

QMF shuts down automatically after the report
runs.

Note: Shortcuts open when the report name is found.

If you have several reports with the same name
(under separate folders), the report at the highest
level opens.

Save changes to public
favorites

Save modifications made to reports in your Public
Favorites folder.

New report linked to locally
saved query

This option enables you to create a report by selecting
a query (.qry) saved locally on your network/hard
drive. When this option is selected, the Locate the
QMF for Windows query link to dialog box displays.
Select the query (or queries) to add. When you select
a query, then Report Center will read the SQL, go to
the specified server, and create the report
dynamically.
Note: Only the SQL and server information are used;
other options saved with the .QRY file are ignored.

This is the only situation where SQL can be edited by
Report Center. Select the local query report and
choose QMF object text. Edit the SQL and save the
changes. This alters the SQL in the .qry file.

New folder Create a new folder within the current folder.

Empty recycle bin Remove all deleted items from the Recycle Bin.
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Table 30. Report menu options (continued)

Field Description

Exit Exit QMF Report Center.
Note: Right-clicking on any element displays options
also available through the Report, Edit, View, and
Tools menu.

Report properties - general
This dialog box opens when you select Properties from the Report menu.

Table 31. General options

Field Description

Report name One of the following identifiers for the report:

v QMF object type followed by
OBJECTOWNER.OBJECTNAME

v the report description if the selected report is in a
Favorites folder

Server The name of the server on which the report resides.
Optionally, use the drop-down list to select another server.

[Object] [Query/Table/Procedure]: The name of the object. You
cannot edit this field directly. To select another object, click
Select to open the Filter Options dialog box.
Note: The Formatting, Output, and Procedures tabs are
disabled for queries that do not use the SQL SELECT
statement because they do not return data (non-SELECT
SQL verbs).

View QMF Object text When checked, displays the text of the QMF object.
Note: Right-click on the dialog box to display report
comments.

Report properties - formatting
This dialog box opens when you select Properties from the Report menu, then
select the Formatting tab.

Table 32. Formatting options

Field Description

No formatting (data
only)

Returns raw data to the file

Include column headers Adds labels to report columns. This option is available
only when you select the ″No formatting″ option.
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Table 32. Formatting options (continued)

Field Description

Default QMF formatting Returns data in the default QMF format, which includes
column headers and a vertical separating line between the
headers and data.

QMF formatting from
form

Formats report results with the specified QMF form. Click
Select Form to open the Filter Options dialog box where
you select the QMF form from which to copy formatting.

Run Runs the SQL

Select form Opens the form filter dialog box to specify the object
owner and object name. The Select Form dialog box
displays for you to select a form to use for QMF data
formatting.

Report properties - output
This dialog box opens when you select Properties from the Report menu, then
select the Output tab.

Table 33. Output options

Field Description

Select output application The application for which you want to format
the report.

For Microsoft Excel, Lotus 1-2-3, and Microsoft
Access, click Options to open the Report
Output Option dialog box to define options
specific to each application.
Note: For Microsoft Excel, Lotus 1-2-3, and
Access, No formatting (data only) has to be
selected from the Report Properties: Formatting
tab.

Publish to a temporary file Saves the report to a temporary file in the
directory indicated. Click Select Directory to
change the directory.

Use the temporary directory of the
machine running this report

Defaults to the temporary directory of the
machine from which the report is being run.
Check this option to use the machine’s
temporary directory; otherwise, provide a
directory in the Publish to a temporary file, in
the following directory field.

Start file name with The prefix used with the filename, if applicable.
This option is available on when you select
Publish to a temporary file option.
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Table 33. Output options (continued)

Field Description

End file name with Select a date format to be used as a suffix to the
filename, if applicable. Select ″Random″ if you
have no preference for a filename but you do
no want any previous reports overwritten. QMF
Report Center randomly assigns a unique
filename. This option is available only when
you select the Publish to a temporary file
option.

Publish to a specific file Saves the report to the filename you specify.
click Select File to specify the filename.

Overwrite file if it already exists Replaces files of the same name with updated
files. If this option is not selected, you are
warned if an existing file is about to be
overwritten.
Note: Files other than Lotus 1-2-3, Microsoft
Access, and Microsoft Excel are always
overwritten.

View report after publishing Automatically displays finished reports after
they are created. If you do not select this
option, you can view the report later through
Report History.

Run Runs the SQL

Output range Click the text box to launch Microsoft Excel or
Lotus 1-2-3. The Output range dialog box
displays.
Note: Click the cell in the spreadsheet where
the results should be written. The output range
will be updated to this cell position.

108 Query Management Facility™ for Windows: Getting Started with QMF for Windows



Table 33. Output options (continued)

Field Description

Data options

Microsoft Excel or Lotus 1-2-3

v Data import options

– Import data

– Group by one column

– Group by two columns

– Create a pivot table

For Microsoft Excel or Lotus 1-2-3

– Create a cross-tab report

v Charting

– Create a chart

– Select chart type

v Column grouping

– ID

– Name

– Dept

v Calculated fields options

– Sum

– Count

– Max value

– Min value

– Average value

Printer options Specify the printer and corresponding attributes
for printing your output.

Microsoft Access and Lotus 1-2-3

This dialog box opens when you click Options from the Report Properties:
Output dialog box, and select Microsoft Access as the output application.

Table 34. Microsoft access options

Field Description

Select or enter a table name Select a name from the drop-down list or type a new
name in the text box for the Microsoft Access table
Note: This option is not available if the Use QMF
Object Name option is selected.

Use the QMF object name Uses the object name as the Access table name. An
object is a table, form, procedure or query.
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Table 34. Microsoft access options (continued)

Field Description

Append the above name with Adds the current date to the object name to create the
table name. Use the drop-down list to select a date
format.

Overwrite existing data in
table

Replaces existing data in the named table with data
from the most recent report

Select or enter a report name To view a predefined Microsoft Access report when
the database is opened, select a report name from the
drop-down list or type a new name in the text box.
This option is useful when you want to view the
report after it runs.

Follow these steps to specify output options for a report:
1. Click Properties at the QMF Report Center dialog box (main window),

then right-click on a report.
2. Click on the Output tab.
3. Select Microsoft Excel (.xls) or Lotus 1-2-3 (*.123) as the output application.
4. Click Options.
5. Select Lotus 1-2-3 or Microsoft Excel as the output application.
6. Specify the sheet name or QMF object name, whether to append the

specified name with a date (in the specified date format), whether to
include column names, and output range (the cell on the spreadsheet to
which the output data will be positioned).

7. Click Data Options to specify additional formatting options for graphing
and grouping data.

Note: Data Options is disabled if you selected Default QMF formatting or
QMF formatting from the Properties: Formatting tab.

8. The [Lotus 1-2-3 or Microsoft Excel] Data Grouping and Charting Options
dialog box displays. Use this dialog to specify:
v Group by one column [you need to specify the column name]
v Group by two columns [you need to specify the column names]
v Create a pivot table [for importing the report to Microsoft Excel] or a

cross-tab report [for importing the report to Lotus 1-2-3].
v Charting options:

– A checkbox to create a chart
– Chart types

v Column grouping options:
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– ID or Cross tab row (if creating a cross-tab report for importing to
Lotus 1-2-3)

– Name or Cross tab column (if creating a cross-tab report for
importing to Lotus 1-2-3)

v Column with calculated field (this group box is activated only if
grouping by one- or two columns).

v Calculated field options:
– Sum
– Count
– Max value
– Min value
– Average value
– Product*
– Count nums*
– StdDev*
– StdDevp*
– Var*
– Varp*

Note: These options are activated only if you set the data import
options to:
- Group by one column
- Group by two columns
- Create a pivot table (for importing the report to Microsoft

Excel), or
- Create a cross-tab report (for importing the report to Lotus

1-2-3)
– Excel only*

Report properties - procedures
This dialog box opens when you select a procedure, then select Properties
from the Report menu, then you select the Procedures tab.
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Table 35. Procedure options

Field Description

This procedure produces no output When checked, indicates that there is no output
resulting from this procedure; instead, the
procedure runs and a subsequent action takes
place. The procedure itself does not produce
output such as report results.
Note: Output options are not available when
this option is selected.

The procedure will place output
data in the following file

Specify the filename to which the procedure
will send output.

View output after running Display the report after it is produced.
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Table 36. Procedure options

Field Description

The procedure uses the
DSQQW_PROC_OUTPUT
substitution variable

Indicates the substitution variable in the current
procedure. This variable is used to export data
to the location you specify. The syntax EXPORT
REPORT TO &DSQQW_PROC_OUTPUT must
be included in the procedure to use this
variable. The substitution variable will be
displayed in the Report Properties: Variables
dialog box.

The output location specified below is passed to
the procedure using this substitution variable:

v Publish to a temporary file

Saves the report to a temporary file in the
directory indicated. Click Select to change
the directory.

v Start file name with

Type a prefix to be used with the filename, if
desired. This option is available only when
you select the Publish to a temporary file
option.

v End file name with

Select a date format to be used as a suffix to
the filename, if desired. Select ″Random″ if
you have no fielname preference but do not
want any previous reports overwritten.

QMF Report Center randomly assigns a
unique filename. This option is available only
when you select the Publish to a temporary
file option.

v Extension

Select the extension that represents the file
format to use for your temporary file.

v Publish to a specific file

Saves the report to the filename you specify.
Click Select to specify the filename

The procedure will place output
data in the following file

Specify the filename to which the procedure
will send output.

View output after running Display the report after it is produced.
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Report properties - variables
The Report Properties: Procedure dialog box opens when a procedure is
selected and you select Properties from the Report menu, then the Procedures
tab.

Specify formatting, output, procedures, variables, miscellaneous, scheduling,
security, and email preferences. Follow these steps to set report properties:
1. At the QMF Report Center dialog box (main window), right-click on a

report.
2. Click the Variables tab.

The Variables dialog box displays with a list of variable names. Values for
these variables can be preset and optionally, individually hidden when the
report is run.

3. Selecting the variable value box for a given variable lets the user create a
″calculated″ date value.
Calculate date is now enabled.

4. Press Calculated Date.
The Calculated date dialog box displays.

Table 37. Variable options

Field Description

Name The name of the query or procedure.

Value Click Value to type a variable value to be
used each time the current report runs.
Note: Calculated Date becomes enabled
when you click the Value field. This button
displays the Set Date Substitution Values
dialog box.

Hide this value When checked, the preset values are hidden.
For queries and procedures containing preset
variables, you are not prompted for values
when the report is run.

Clear values Removes the variable values displayed above.

Calculated date When a value is entered, Calculate date
becomes enabled.

When clicked, the Set Date Substitution
Values dialog box displays. See ″Set Date
Substitution Values.″
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Report properties - Set Date Substitution Values
The Set Date Substitution Values dialog box displays when you click
Calculated date on the Report Properties: Variables tab. Calculate date is
enabled when you click on the Values column on the Report Properties:
Variables tab.

Table 38. Set Date substitution values

Field Description

Calculated
date

By days Select the number of
days prior to the
current date

By days of the
week

Last occurrence in
current month

Choose the day to
display in its last
occurrence in the
current month.

For example, the last
Wednesday of the
current month.

First occurrence of
current month

Choose the day to
display in the first
occurrence in the
current month.

For example, the first
Wednesday of the
current month.

Last occurrence of
previous month

Choose the day to
display in its last
occurrence from the
previous month.

First occurrence in
previous month

Choose the day to
display in its first
occurrence from the
previous month.

By month Choose occurrence by
the first day or the last
day of the month and
by how many months
prior from the current
month.

By quarter From the beginning of Choose the quarter of
the year to start the
calculated date.

Fiscal year starts Choose the month that
starts the fiscal year.
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Table 38. Set Date substitution values (continued)

Field Description

Date format
options

Date format Choose the format in
which to display the
date

Date separator Choose the symbol to
separate the month,
day, and year.

Use PC date as
current date

Uses the current date
set on your PC

Use DB2 date as
current date

Uses the current date
set on the DB2 system
(to account for time
zones)

Sample date Click New Sample
to see an example
of how the date
will display.

Current PC
date

Displays the
current date you
have set on your
PC

Report properties - miscellaneous

Table 39. Miscellaneous options

Field Description

Run as a separate process Runs reports in a separate instance of QMF
Report Center, allowing you to continue
working within QMF Report Center.

The second window only displays Cancel, and
the window is not otherwise interactive.

Suppress informational messages Hides informational messages

Suppress error messages Hides error messages

Limit the number of rows returned Restricts the number of rows returned to the
report. Type a number in the text box, or use
the arrows to scroll in increments of 100. This
option applies when you have an individual
report selected.
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Table 39. Miscellaneous options (continued)

Field Description

Prompt for variable values prior to
running reports

Prompts for variable input for all reports
contained in the folder before the first report
runs. This option applies when you have a
folder selected.

Do not display any of the reports
being run

The reports are not displayed after they are
produced. If an error occurs, the report stops
running. This option applies when you have a
folder selected.

Continue running subsequent
reports if an error occurs

By default, if an error occurs when running a
folder the execution is halted. If this field is
checked, then Report Center will attempt to run
every report in turn irrespective of any errors
that arise.

Report properties - schedule
This dialog box opens when you select Properties from the Report menu, then
click the Schedule tab.

Table 40. Schedule options

Field Description

Job ID The number used to identify each scheduled
job. The number is assigned automatically and
cannot be edited.

Interval The frequency at which the job is run, such as
once, weekly or monthly.

Days of week The day on which the job is scheduled to run.
This field may be blank or contain
″Customized″ if the job has been edited using
Microsoft’s Task Scheduler (R), indicating that
QMF Report Center is not able to display the
job details.

Days of month The number of the day of the month on which
the job is scheduled to run.

For example, a 2 indicates that the run will run
on the second day of the specified month.

This field is blank if the job is scheduled for
specific days of the week.

Time (display) The time at which the job is scheduled to run
on the specified days.
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Table 40. Schedule options (continued)

Field Description

Time Type the time in the text boxes or use the
arrows to scroll up and down. The time is in a
24-hour format.

Days of week to run The days on which the job is scheduled to run.
Choose Select all to select all days of the week
automatically.

Days of month to run The number of the days in the month on which
the job is scheduled to run.

For example, a 2 indicates that the job is run on
the second day of each specified month.

Choose Select all to select all days of the month
automatically.

Today only Run the job on the current day only

Once for the days marked Run the job only once on the days indicated

Every time for the days marked Run the job each time the selected days occur.

For example, if Tuesday is selected, the job runs
every Tuesday until you change the schedule.

Set variable values Opens the Variable Input dialog box where you
specify variables to be used with the report.
Variable values must be defined prior to
running reports. Queries and procedures can
contain variables.

Edit variable values Opens the Variable Input dialog box where you
can modify values set for variables in the
current report. The report name must be
selected to activate this button.

Report properties - security
This dialog box opens when the selected object is contained in the Public
Favorites folder and you select Properties from the Report menu, then click
the Security tab.
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Table 41. Security options

Field Description

User ID The names of the users or user groups to which
you can assign permission to the current object.
Authorized users and their permissions are
displayed in the text box below.

To add new users, type a user ID in the text
box, then click Add.

Add Add the selected user (in the User ID field) to
the group of authorized users for the current
object

Add all Add all users to the group of authorized users

Remove Remove the selected user from the group of
authorized users

Read Allows the selected user to view the current
Public Favorite and run it

Write Allows the selected user to modify any
properties of the current object and add new
reports and folders if the selected item is a
folder

Administer Allow the selected user to grant or revoke
access to the current object

Take ownership Grant ownership of the current object to the
selected user. This option may not be available,
depending on your resource limits.

Use these settings for all reports
under this folder

Apply the same security settings to all reports
and subfolders contained in the current folder

Report properties - email
This dialog box opens when you select Properties from the Report menu, then
click the Email tab.

Table 42. Email options

Field Description

Send an email message whenever I
run the report

Sends an email notification each time the report
is run directly (use the next option for
scheduled reports). You determine the email
address and messages to be sent.

Send an email message whenever
the scheduler runs a report

Sends an email notification each time the report
is run through the scheduler
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Table 42. Email options (continued)

Field Description

Attach report output to
email/Attach all underlying report
output to email message

Includes the report output in the email
notification. For folders, this option attaches
report output for all reports contained under
the folder.
Note: Select one of the above options when
selecting this option.

[Email] properties Opens the Internet Mail Wizard where you may
specify the recipients for the message, the
message text, and the attachments.

Edit menu

Cut
Remove the selected item from the active document. You do not see action
here until you Paste the item.

Copy
Copy the selected item. To complete this action, you must Paste the item at
the desired location.

Paste
Add the copied item at the insertion point.

Delete
Remove the selected item and adds it to the Recycle Bin. QMF objects that
reside on a server are not added to the Recycle Bin.

Note: Items deleted from the Recycle Bin are permanently removed.

Rename
Change the name of the selected item.

Note: Right-clicking on any element displays options that are also available
through the Report, Edit, View, and Tools menu.

Select server
The Select Server dialog box opens if the report you are editing is linked to an
object that resides on a server that is not defined in your SDF (server
definition file).
v Available servers

The servers to which you can connect.
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View/Edit Server
The View/Edit Server dialog box displays when you:
v choose View: Edit Server from the Edit menu, or
v right-click on a report and choose View, then Edit Server

You choose this option to view or edit the server against which the report is
run without initializing the underlying QMF object located at the server.

The list of servers is disabled when:
v the report is a Public Favorites and the user has permission to read the

report only, and
v the report is a locally-bound static query, which is server-dependent

Note: Because the query is not initialized to determine if it is static, users
can change the server on static queries. However, this query will fail
to run.

Table 43. View/Edit server

Field Description

Current server The name of the server where the report is currently
located

Available servers Displays a lit of available servers to relocate the
report

View menu

Names
Display the name view of tables, forms, procedures, and queries. This option
is a toggle with Comments.

Comments
Display the comment view of tables, forms, procedures, and queries. This
option toggles with Names. For objects that do not have comments, the name
view is displayed.

Objects on the server may contain comments that include descriptive
information about the object. These comments are assigned to the object when
the object is created. You cannot modify comments; they are for viewing
purposes only. Where comments do not exist, the object name remains
displayed.

Display object comments

v Select the object type, owner, or name, and right-click Choose View, then
choose Comments
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v Or, with the object type, object, or name selected, choose View: Comments

Comments are displayed for the current level and all levels below. For
example, if you selected the type QMF Queries, all owners and objects
contained within QMF Queries are displayed with comments.

To return the display of object names, repeat the above process and select
Names.

Note: Because retrieving comments may be a time-consuming process, you
may want to view comments for a particular object, rather than
viewing comments for all objects of the same type.

QMF object text
This option displays the text for the QMF object. Specify the relative display
size of text in QMF Report Center.

When you select an object (query, table, or procedure) a pop-up window will
display the SQL for the object used to produce the report. The pop-up
window identifies the object name, and then displays the text for the object in
the main part of the window. For example:
Table: DB2ADMIN.MAX_T
Select * from DB2ADMIN.MAX_T

Note: You cannot edit the QMF object text using this function unless it is a
local query (.QRY) that has not been statically bound to a server.

Filter options
Specify display options for the current object. You can filter by any of the
following for the object owner and object name:
v Tables
v QMF queries
v QMF procedures
v QMF forms
v Public favorites
v DB2 forms

Server filter options
Use this option to specify which servers you want to hide. The Select Servers
to Hide dialog box displays when you click on Server Filter Options from the
View menu.

The Select Servers to Hide dialog box lists the servers included in the SDF
(Server Definition File). Check the servers you want to hide, or click Select
All or Clear All. You can still run reports against the hidden server.
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Options include:
v Select all: lists available servers to be hidden
v Clear all: Clears all servers selected to be hidden

Report comments
Displays the name of the report on which you are commenting.

Text size
Specify the relative display size of text in QMF Report Center.

Scheduled jobs
View, edit, and delete scheduled reports.

Report history
View details for reports run, in chronological order.

Activity log
View all activities in chronological order.

The activity log contains detailed information on reports run and errors
encountered during QMF Report Center operations.

Refresh
Display an updated view, reflecting any recent changes made to objects on the
server. If the ″Prompt me with this filter every time″ option is selected on the
Filter Options dialog box, the Filter Options dialog box is opened each time
you select Refresh.

Note: When you right-click an element, options will display which are also
available through the Report, Edit, View, and Tools menus.

Tools menu

Set user information
Log in as another user, or specify account information. The Set User
Information pop-up window displays when you select this option. Enter the
user ID and password, and [optionally] check Remember this password if you
want to retain the password. Optionally, enter an account number to track this
user’s activity.

You can change the name of the current QMF Report Center user by
specifying another valid User ID. This option is only available when the active
item is on a server (for example, server name, object type, object owner, object
name, or Public Favorites is selected).
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Run QMF for Windows
Launch the QMF for Windows application (QMF Report Center remains
active).

Note: You are not able to use the application if you do not have permission in
your resource limits.

Export favorites
Export your personal Favorites folder to a .qrs file.

Import favorites
Import a .qrs file to your personal Favorites folder.

Options
Set QMF Report Center options for the Activity Log, Creating Favorites,
Creating Folders, and Miscellaneous options.

Note: Right-clicking on any element displays options that are also available
through the Report, Edit, View, and Tools menu.

Print Options

The Print Options dialog box displays when you click Options from the
Global Options: Creating Favorites dialog box and you select Printer as the
application for which you are creating the report.

Table 44. Print options

Field Description

Select a printer Select an installed printer from the drop-down list or
click More Options to select from additional printer.
Note: Select ″Default Printer″ to send the report to
the default printer defined for the PC.

Use form page setup Uses the specified form settings when a form is
associated with the current report

Number of copies Use the arrows to increase or decrease the number of
copies you want to print, or type the number directly
in the text box

Font options The font type and size to be used in the printed
report. Click More Options to specify a new font.

Orientation Select Portrait to print the page with the short edge
on top or Landscape to print the page with the long
edge at the top.

Fit to printer page Automatically sizes the page width or length to fit
the size of the printed page
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Table 44. Print options (continued)

Field Description

Characters/Lines Identifies page size according to a specific number of
character lines. Type a number in the text box or use
the arrows to scroll.

Continuous Prints continuous pages, without page breaks, or
wraps text (for page width)

Other options Includes a date and time stamp and/or page number
or the report

Margins Use the arrows to increase or decrease the number of
inches for each margin, or type the number directly
in the box.

Help menu

Contents
Display the table of contents for the online help system.

About
Display QMF Report Center copyright information.

Connecting to the server

1. If no server names are displayed beneath DB2 Servers, click the plus
symbol (+).

2. Click the plus symbol (+) next to a server.
The Filter Options dialog box opens.

3. At the Filter Options dialog, select the object types that you want to see,
then click OK.
The available objects on the server are displayed, grouped by object type
(tables, QMF queries, QMF procedures, QMF forms, public favorites, and
DB2 forms).

4. You can check the Select all option to select all object types stored at the
server.
You will be prompted for your User ID and Password to access these
objects.

5. Select or de-select the option, Prompt me every time with this filter, if you
want to display the Filter Options dialog box each time you select an
object at a server.
The default is checked (″yes″).
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Working with reports and objects

Reports are based on QMF objects (queries and forms). They contain the
formatting and output specifications that you identify. Reports that are
contained in the Favorites folder point to objects that reside on the server.

All items in your personal and Public Favorites folders are considered reports;
you can manipulate formatting and display options for these items. The items
contained in these Favorites folders link to the QMF objects that reside on the
server.

You do not actually modify a QMF object. Instead, you modify the link to the
object that is referred to as a report. Because reports are based on objects,
properties of objects also apply to reports.

You can create reports from objects that reside on a server, but these reports
are not saved to the server. This allows you to create one-time reports. After
creating a report from objects on a server, you can save the report to your
Favorites folder.

Creating reports
You can create reports from reports in your Favorites folders and QMF objects
that reside on a server.

Create reports locally
Select one of these options to create a report locally:

Option 1

1. Connect to the server that contains the object on which you want to base
your report.

2. Select an object, then drag the object to one of your Favorites folders.

Option 2

Select the object, then choose Report: Add to Favorites.

You can now run the report or define report properties.

Create reports from the server
Select one of these options to create reports from the server:
v Right-click on the object then select Run, or
v Modify report properties, then use the first option

Note: Reports created from objects that reside on the server are not saved to
the server.
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If you choose this method to create a report, you are prompted to save
the report in you Favorites folder. If you do not save the report to your
Favorites folder, your report is not saved.

Running reports
You can run reports from your Favorites folders or from objects located on the
server.
1. [Optional] Select the report or object, then choose Report: Properties.

The Report Properties dialog box opens.
2. Optionally, define properties. See ″Report Properties.″

You can set properties for formatting, output, procedures, variables,
miscellaneous, schedule, security, and email for objects that reside in your
Favorites folders and objects on the server.

3. Click Run.
You are prompted for your user ID and password. Enter this information.

4. Click OK.
The report is processed.

If you selected View report after publishing at the Report Properties: Output
tab, the report is displayed in the application you specified in the Select
output application field.

You can also run a report by any of the following methods:
v Selecting the report, then choosing Report: Run, or
v Right-clicking on the report, then choosing Run, or
v Double-clicking on the report name.

The query result displays in the way specified in the Report: Properties. By
default, it will point to the Notepad application. Within these properties, you
can select the form for formatting the query result. Other applications
predefined by QMF Report Center include:
v Web browser (.html)
v Microsoft Excel (.xls)
v Microsoft® Word® (.doc)
v Microsoft® Access® (.mdb)

Running multiple reports
Repeat the procedure for running reports while a folder in your personal
Favorites is selected.

You can also run a report by:
v Selecting the report, then choosing Run from the Report menu
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v Right-clicking on the report, then choosing Run
v Double-clicking on the report name

You can run reports in separate memory so you can continue to work in the
QMF Report Center while reports are running. Run as a separate process
option on the Report Properties: Miscellaneous dialog box to run reports in
separate memory.

If you selected the View report after publishing option in the Report
Properties: Output dialog box, the report is displayed in the application you
specified.

Printing reports
You print Report Center reports from the output application or directly from
QMF Report Center.

Procedure
1. Select one of these options:

v Select the report, right-click, and choose Properties, or
v Select the report, then choose Report: Properties.

2. Select the Output tab to open the Report Properties: Output dialog box.
3. Select a Printer from the output application list, then click Options.
4. Specify the desired options.
5. Click OK.

The report is sent to the printer when you run the report.

Scheduling reports
You can schedule reports and entire folders within your personal Favorites to
be run at a specific date and time, and at regular intervals.

The QMF Report Center scheduler is based on the Windows scheduler;
therefore, if you do not have the Windows scheduler running or if you are not
authorized to use the scheduler, you are not able to schedule reports. QMF
Report Center notifies you if the Windows scheduler is not running when you
attempt to schedule jobs.

Note: If you are using an NT machine that does not have the Task Scheduler,
only the user whose name was identified as the logon account for
running the ″AT″ scheduler can schedule jobs.

Check with your system administrator to determine which account is
set up on your computer.
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Procedure
Select one of the following options to schedule reports:

Option 1

1. Select Tools: Set User Information, then check the option, Remember this
password.

Note: This option must be selected for scheduled reports to run.
2. Choose one of the following options:

v Select the report and choose Report: Properties, or
v Select the report, then right-click, and choose Properties.

3. Choose the Schedule tab to open the Report Properties: Schedule dialog
box.

4. Select schedule options.
5. Click OK.

The scheduled jobs are run as a separate process, so you can continue to
work within QMF Report Center while jobs are run.

Note: If you set up a daily and monthly schedule in which reports will run
once a day, two separate jobs are entered (one for the weekly schedule
and one for the monthly schedule).

Viewing scheduled reports
You can view the schedule for the reports that have been scheduled to run.

Procedure
Choose View: Scheduled jobs to open the QMF Scheduled Jobs dialog box.

Viewing report history
You can display a chronological list of all reports run. Report History contains
date and time, report name, output application, and file location.

Procedure
Choose View: Report history to open the Report History dialog box.

Renaming reports and folders
You can rename the reports and folders contained in your Favorites folders.

Note: You cannot rename QMF objects.

Procedure
Option 1

1. Select the report or folder.
2. Right-click, then choose Rename.
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Option 2

1. Select the report or folder.
2. Choose Edit: Rename.

Type the new name for the report or folder, then press Enter.

Moving reports, objects, and folders
You can move reports, objects, and folders on a server and within your
Favorites folders.

Procedure
1. Select one of the following options:

v Select the item, right-click, and choose Cut, or
v Select the item, then choose Edit: Cut.

2. Select one of the following options:
v Right-click on the location, then choose Paste, or
v Right-click on the location, then choose Edit: Paste.

Note: Dragging an item does not move the item from one location to another.
Instead, dragging makes a copy of the item, except when working in
the Favorites folders.

Copying reports, objects, and folders
You can copy reports, objects, and folders from a server or within your
Favorites folders.

Copy from a server
1. Choose one of the following options:

v Drag the item from its current location to the desired location, or

Note: This is the easiest method.
v Select the item, right-click, then choose Copy, or
v Select the item, then choose Edit: Copy

2. Choose one of the following options:
v Right-click on the folder to which you want to copy the item and choose

Paste, or
v Right-click on the location, then choose Edit: Paste

A message displays that indicates that the item has been successfully pasted.
The item is added to the bottom of the current folder.
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Copy within Favorites folders
Use the copy and paste method above to copy reports within your Favorites
folders.

Note: Dragging reports within the Favorites folders only moves the reports
from one folder to another.

Deleting reports, objects, and folders
Objects and reports that you delete from your personal Favorites folder are
sent to the Recycle Bin. However, objects and reports that you delete from the
server cannot be retrieved and this action cannot be undone.

Note: You may not have permissions to delete items from the server.

Procedure
1. Select one of the following options:

v Select the item, right-click, then choose Delete, or
v Select the item, then choose Edit: Delete, or

2. For objects and reports that are on a server, you are prompted with a
warning message before you confirm the deletion.

Note: The task scheduler must be running for you to delete a report with
scheduled jobs and remove it from the Recycle Bin.

Report properties

You can define report properties for objects that reside in your Favorites
folders and objects on the server. To set properties, select the report and
choose Report: Properties. Or, select the report, right-click, then choose
Properties.

General
The General tab of the Report Properties specifies the report name, server,
query, and optionally, the query text.

Report name
The identifier for the report, which is the QMF object type (table, form,
procedure or query), followed by OBJECTOWNER.OBJECT NAME or the
report description of the selected report is in a Favorites folder. A Favorites
folder is a folder containing reports that you can modify.
v The Personal Favorites folder resides on your PC and you are the only user

with access to these reports
v The Public Favorites folder resides on a server and can be accessed by any

authorized user.
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Server
The name of the server where the report resides. Optionally, use the
drop-down list to select another server.

[Object]
The name of the object (query, procedure, or table). You cannot edit this field
directly. Instead, to select another query, table or procedure, click Select to
open the Filter Options dialog box.

Note: The Formatting, Output, and Procedures tabs are disabled for queries
that do not use the SQL SELECT statement because they do not return
data (non-SELECT SQL verbs).

View QMF object text
When checked, displays the text of the QMF object (query, procedure).

Table 45. View QMF object text options

Control Description

Run Runs the SQL

OK Accept your entries

Cancel Cancel your entries and return to the previous dialog
box

Help Obtain online help for the dialog box

Select Open the Object Filter dialog box to select another object
by providing its object owner, object name, and whether
you want to show QMF queries, tables or procedures

Object filter
This dialog box opens when you:
v Click Select from the Report Properties: General dialog box, or
v Select an object on a server, then choose View: Refresh

Object owner
The name of the current object owner. Wildcards can be used to search for a
specific owner.

Object name
The name of the current object. Wildcards can be used to search for a specific
name.

Show objects
Displays the specified objects available on the server. You cannot select a
different type of object and OK will be disabled.
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Prompt me every time with this filter
Indicates whether this dialog will be opened each time you refresh or connect
to a database.

Table 46. Object filter prompts

Control Description

OK Accept your entries

Cancel Cancel your entries and return to the previous dialog
box

Help Obtain online help for the dialog box

Formatting
This dialog box opens when you select Properties from the Report menu, then
the Formatting tab.

No formatting (data only)
Returns raw data to the file.

Include column headers

When selected, adds labels to report columns. This option is available only
when you select the ″No formatting″ option.

Default QMF formatting
Returns data in the default QMF format, which includes column headers and
a vertical line that separates the headers and data.

QMF formatting from form
Specifies the QMF form to use to format the report results. Click Select Form
to open the Filter Options dialog box where you select the QMF form from
which to copy formatting. See Select Form for more information.

Table 47. Formatting options

Control Description

Run Runs the SQL

OK Accept your entries

Cancel Cancel your entries and return to the previous dialog
box

Help Obtain online help for the dialog box

Select Form Open the Form Filter dialog box to specify the object
owner and object name. The Select a Form dialog box
displays for you to select a form to use for QMF data
formatting.
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Output
This dialog box is opened when you select Properties from the Report menu,
then you select the Output tab.

Select output application
The application for which you want to format the report. For Microsoft Excel,
Lotus 1-2-3, and Microsoft Access, you can click Options to define options
specific to each application.

You may output the file to a text browser, text viewer, Microsoft Word, Lotus
WordPro, Microsoft Excel, Lotus 1-2-3, Microsoft Access, or to a printer.

Publish to a temporary file, in the following directory
Saves the report to a temporary file in the directory indicated. To change the
directory, click Select Directory.

Use the temporary directory of the machine running this report
Defaults to the temporary directory of the machine from which the report is
being run. Check this option to use the machine’s temporary directory;
otherwise, provide a directory in the Publish to a temporary file, in the
following directory field.

Note: This is especially useful for Public Favorites where you may not know
the directory structure of the user’s machine.

Start file name with
Type a prefix to be used with the filename, if desired. This option is available
only when you select the Publish to a temporary file option.

End file name with
Select a date format to be used as a suffix to the filename, if desired. Select
″Random″ if you have no preference of filename but do not want any
previous reports overwritten; QMF Report Center randomly assigns a unique
filename. This option is only available when you select the Publish to a
temporary file option.

Publish to a specific file
Saves the report to the filename you specify. Click Select File to specify the
filename.

Overwrite file
The Overwrite file if it already exists option replaces files of the same name
with updated files. If this option is not selected, you are warned if an existing
file is about to be overwritten.

Note: Files other than Lotus 1-2-3, Microsoft Access, and Microsoft Excel are
always overwritten.
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View report after publishing
Automatically displays finished reports after they are created. If you do not
select this option, you can view the report later through the Report History.

Table 48. Output options

Control Description

Run Runs the SQL

OK Accept your entries

Cancel Cancel your entries and return to the previous dialog
box

Help Obtain online help for the dialog box

Options Various dialog boxes open when you click the Options
button from the Report Properties: Output dialog box
and you have specified Lotus 1-2-3, Microsoft Excel,
Microsoft Access, or a printer as your output application.

Which dialog box opens depends on the output options.

v REPORT OUTPUT OPTIONS for Microsoft or Lotus
1-2-3:

– Select or enter a sheet name: select a name from the
drop-down list or type a new name in the text box
for the Excel or Lotus 1-2-3 sheet.
Note: This option is not available if the Use the
QMF object name option is selected.

– Use the QMF object name: uses the object name as
the Excel or Lotus 1-2-3 sheet name.

– Append the above name with: adds the current date
to the object name to create the sheet name. Use the
drop-down list to select a date format.

– Include column names: when checked, displays
column headers in the formatted report.
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Table 48. Output options (continued)

Control Description

v Output range: click the text box to launch Excel or
Lotus 1-2-3. The Output Range dialog box opens to
specify the range for your query results. You cannot
type a range in this field manually

v DATA OPTIONS for Microsoft or Lotus 1-2-3: Displays
the Microsoft Excel and Lotus 1-2-3 Data Grouping
and Charting Options dialog. If your query has
substitution variables in it, then you will be prompted
for sample values on these so that the column names
can be retrieved.
Note: This prepares, but does not run the query.

Data options are disabled unless No formatting (data
only) is selected from the Formatting tab of the
Properties dialog.

– Data import options

- Import Data

- Group by one column

- Group by two columns

- Create a cross tab report

– Charting

- Create a chart

- Select chart type

– Column Grouping

- ID

- Name

- Dept

– Calculated Field Options

- Sum

- Count

- Max value

- Min value

- Average value

v PRINTER OPTIONS

– Specify the printer and corresponding attributes for
printing your output.
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Table 48. Output options (continued)

Control Description

FOR MICROSOFT ACCESS

This dialog box opens when you click Options from the
Report Properties: Output dialog box, and select
Microsoft Access as the output application.

v Select or enter a table name: Select a name from the
drop-down list or type a new name in the text box for
the Access table.
Note: This option is not available if the Use the QMF
object name option is selected.

v Use the QMF object name: uses the object name as the
Access table name. An object is a table, form,
procedure or query.

v Append the above name with: adds the current date to
the object name to create the table name. Use the
drop-down list to select a date format.

v Overwrite existing data in table: replaces existing data
in the named table with data from the most recent
report.

v Select or enter a report name: To view a predefined
Access report when the database is opened, select a
report name from the drop-down list or type a new
name in the text box. This option is useful when you
want to view the report after it runs.

Procedures
The Procedures dialog box opens when a procedure is selected and you select
Report: Properties, then you select the Procedures tab.

This procedure produces no output
When checked, this indicates that there is no output resulting from this
procedure.

Note: Output options are not available when this option is selected.

This procedure uses the DSQQW_PROC_OUTPUT substitution variable
Indicates the substitution variable in the current procedure. This variable is
used to export data to the location you specify. The syntax EXPORT REPORT TO
&DSQQW_PROC_OUTPUT must be included in the procedure to use this variable.
The substitution variable will not be displayed in the Report Properties:
Variables dialog box.The output location specified below is passed to the
procedure using this substitution variable:
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v Publish to a temporary file: Saves the report to a temporary file in the
directory indicated. To change the directory, click Select.

v Start file name with: Type a prefix to be used with the filename, if desired.
This option is only available when you select the Publish to a temporary
file option.

v End file name with: Select a date format to be used as a suffix to the
filename, if desired.

Note: Select Random if you have no preference of filename but do not
want any previous reports overwritten; QMF Report Center
randomly assigns a unique filename.

This option is available only when you select the Publish to a temporary
file option.

v Extension: Select the extension that represents the file format to use for
your temporary file.

v Publish to a specific file: Saves the report to the filename you specify.
Click Select to specify the filename.

The procedure will place output data in the following file
Specify the filename to which the procedure will send output.

View output after running
Displays the report after it is produced.

Variables
This dialog box opens when you select Properties from the Report menu, then
click on the Variables tab.

Preset the following variables
Click the Value field to type a variable value to be used each time the current
report is run.

Clear values
Removes the variable values displayed above.

Hide preset values when report is run
For queries and procedures containing present variables, you are not
prompted for values when the report is run.

Miscellaneous
This dialog box opens when you select Properties from the Report menu, then
click on the Miscellaneous tab.
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Run as a separate process
Runs reports in a separate instance of QMF Report Center, allowing you to
continue working within QMF Report Center. The second window only
displays Cancel, and the window is otherwise not interactive.

Suppress informational messages
Hides informational messages.

Suppress error messages
Hides error messages.

Limit the number of rows returned
Restricts the number of rows returned to the report. Type a number in the text
box, or use the arrows to scroll in increments of 100.

Note: This option applies only when you have an individual report selected.

Prompt for variable values prior to running reports
Prompts for variable input for all reports contained in the folder, before the
first report is run.

Note: This option applies only when you have a folder selected.

Do not display any of the reports being run
The reports are not displayed after they are produced.

Note: This option applies only when you have a folder selected.

Table 49. Output options

Control Description

Run Runs the procedure

OK Accept your entries

Cancel Cancel your entries and return to the previous dialog
box

Help Obtain online help for the dialog box

Schedule
This dialog box opens when you select Properties from the Report menu, then
click on the Schedule tab.

Job ID
The number used to identify each scheduled job. This number is assigned
automatically and cannot be edited.
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Interval
The frequency with which the job is run (such as once, weekly, monthly).

Days of the week
The day on which the job is scheduled to run. This field may be blank or
contain the term ″Customized″ if the job has been edited using Microsoft’s
Task Scheduler. This indicates that QMF Report Center is not able to display
details about the job.

Days of the month
The number of the day of the month on which the job is scheduled to run.
For example, 2 indicates that the job will run on the second day of each
specified month.

This field is blank if the job is scheduled for specific days of the week.

Time (display)
The time at which the job is scheduled to run on the specified days.

Time
Type the time in the text boxes or use the arrows to scroll up and down. The
time is in a 24-hour format.

Days of week to run
The days on which the job is scheduled to run. Choose Select all to select all
days of the week automatically.

Days of month to run
The number of the days in the month on which the job is scheduled to run.
For example, 2 indicates the job is run on the second day of each specified
month.

Choose ″Select all″ to automatically select all days of the month.

Today only
Run the job on the current day only.

Once for the days marked
Run the job only once on the days indicated.

Every time for the days marked
Run the job each time the selected days occur. For example, if Tuesday is
selected, the job is run every Tuesday until you change the schedule.

Set variable values
Opens the Variable Input dialog box where you specify variables to be used
with the report. Variable values must be defined prior to running reports.
Queries and procedures can contain variables.
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Edit variable values
Opens the Variable Input dialog box where you can modify values set for
variables in the current report. The report name must be selected to activate
this button.

Table 50. Output options

Control Description

Add Schedule a new job

Delete Delete the selected job from the Scheduler

Edit Edit the schedule setting for the selected job

Run Run the SQL

OK Accept your entries

Cancel Cancel your entries and return to the previous dialog
box

Help Obtain online help for the dialog box

Note: Click the heading of the column by which you want to sort.

Security
This dialog box opens when the selected object is contained in the Public
Favorites folder and you select Properties from Report menu, then the
Security tab.

User ID
The names of the users or user groups to which you can assign permission to
the current object. Authorized users and their permissions are displayed in the
text box below. To add new users here, type a user ID in the text box, then
click Add.

Add
Add the selected user (in the User ID field) to the group of authorized users
for the current object.

Add all
Add all users to the group of authorized users.

Remove
Remove the selected user from the group of authorized users.

Read
Allows the selected user to view the current Public Favorite and to add new
reports and folders if the selected item is a folder.
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Write
Allows the selected user to modify any properties of the current object.

Administer
Allows the selected user to grant or revoke access to the current object.

Take ownership
Grants ownership of the current object to the selected user. This option may
not be available, depending on your resource limits.

Use these settings for all reports under this folder
Applies the same security settings to all reports and subfolders contained in
the current folder.

Email
This dialog box is opened when you choose Report: Properties, then select the
Email tab.

Send an email message whenever I run the report
Sends an email notification each time the report is run directly. You determine
the email addresses and message to be sent.

Note: Use the next option for scheduled reports.

Send an email message whenever the scheduler runs a report
Sends an email notification each time the report is run through the scheduler.

Attach report output to email
Includes the report output in the email notification. For folders, this option
attaches report output for all reports contained under the folder. You must
select one of the above options when selecting this option.

Table 51. Email options

Control Description

Run Runs the SQL

OK Accepts your entries

Cancel Cancels your entries and return to the previous dialog
box

Help Obtains online help for the dialog box

[Email] Properties Opens the Internet Mail Wizard to specify the message
recipients, the message text, and attachments.
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Associating forms with objects

Forms contain formatting for QMF query results. Therefore, you need to
associate the form with a corresponding query or table.

Procedure

Option 1
Drag a form from the server on top of a query or table in your personal
Favorites folder. The form is associated with the object automatically.

Option 2
1. Select an object in your personal Favorites folder.
2. Right-click and choose Properties.
3. Select the Formatting tab to open the Report Properties: Formatting dialog

box.
4. Select the QMF formatting from form option to open the Select a Form

dialog box.
5. Select a form.
6. Click OK.

Copying reports, objects, and folders

You can copy reports, objects, and folders from a server or within your
Favorites folders.

Copy from a server

Option 1
The quickest way to copy items is to drag the item from its current location to
the desired location.

Option 2
Select the item, right-click, then choose Copy.

Option 3
1. Select the item, the choose Edit: Copy.
2. Right-click on the location (a folder) where you want to copy the item.
3. Choose Paste.

Option 4
1. Right-click on the location.
2. Choose Edit: Paste.
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A message displays that indicates that the item has been successfully pasted.
The item is added to the bottom of the current folder.

Copy within the Favorites folders
Use the copy and paste method described in the ″Copy from a server,″ to
copy reports within your Favorites folders.

Note: Dragging reports within the Favorites folders only moves the reports.

Moving reports, objects, and folders

You can move reports, objects, and folders on a server and within your
Favorites folders.

Procedure

Option 1
1. Select the item.
2. Right-click.
3. Choose Edit: Cut.
4. Right-click on the location to which you are copying the object.
5. Choose Paste.

Option 2
1. Select the item.
2. Choose Edit: Cut.
3. Right-click on the location to which you are copying the object.
4. Choose Edit: Paste.

Note: Dragging an item does not move the item from one location to
another. Dragging makes a copy of the item, except when working
in the Favorites folders.

Deleting reports, objects, and folders

When you delete reports and folders from your personal Favorites folder, they
are sent to the Recycle Bin. Deleting objects and reports from the server,
however, is a permanent function and cannot be undone.

Note: You may not have permissions to delete items from the server.

Procedure
Select one of these options to delete reports, objects, or folders:
v Select the item, right-click, then choose Delete, or
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v Select the item, the choose Edit: Delete

For objects and reports that are on a server, a warning message displays
before you confirm the deletion.

Note: The task scheduler must be running to delete a report with scheduled
jobs and remove it from the Recycle Bin.

Copying tables on a server

You can copy tables from one location on a server to another location on the
same server, and you can copy tables between servers. When you copy a
table, you only copy the data, not the table itself.

Procedure

Option 1
Select one of these options to copy tables on a server:
v Drag the table (folder or tables) to another location within the Tables object

section of the server
v Select the table, right click, and choose Copy

v Select the table and choose Edit: Copy

The Save Data dialog box opens.

Option 2
Specify desired options, then click Save.

Refreshing objects

You can refresh objects periodically because they reside on a server and can
be changed while you are using them.

Procedure
Select one of these options to refresh objects:
v Select an object on a server, then choose View: Refresh
v Select the object, right-click, and choose View, then Refresh

The Object Filter dialog box is opened. Choose OK.

Note: All options are inactive when you refresh an object because you are
refreshing the view only for the object and all objects below the current
level.

All options are active when you refresh a server.

Chapter 12. Working with QMF Report Center 145



Tips for working efficiently

Here are some ways in which you can work with QMF Report Center more
efficiently.

Running reports simultaneously
Group all reports that can be run simultaneously into folders. Instead of
running each report individually, choose Report: Run while the folder is
selected. All reports contained in the folder are run consecutively.

Running reports as a separate process
Use the Run reports as a separate process option on the Report Properties:
Miscellaneous dialog box to run reports in the background while you continue
to work in QMF Report Center.

Limit rows returned
You can limit the number of rows of data that are returned to your report to
reduce processing time. For example, this is useful when you are only
interested in the first 20 results of a query that returns hundreds of results.
Use the Report Properties: Miscellaneous dialog box to specify the number of
rows to which you want to limit output.
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Chapter 13. Using the QMF for Windows API

This chapter describes how an application can access the queries stored in the
QMF query repository and manipulate them. QMF for Windows has a set of
application programming interfaces (APIs) that enable the application to
execute the functions.

What is an API?

APIs are functions with a pre-defined functionality that allows the application
to execute that function without any knowledge on how it performed. APIs
have well-defined inputs and outputs but the process is transparent. APIs are
useful when dealing with device drivers for hardware or software packages.

Most programming languages designed for Windows can access the APIs. The
method by which this is done varies between programming languages, but all
languages have a way of calling the APIs. Once the APIs are included in the
programming language environment, using them is like a regular function in
the program.

Any programming language that accesses the Windows API can access the
QMF for Windows API, including IBM Visual Age® for Java.

In order to develop an application using QMF APIs, no extra middleware is
needed in addition to the one required for the end user. This means that there
ar no special prerequisites for developers. The basic middleware is the
middleware necessary for the network environment, the installation of QMF
for Windows on the computer, and the programming language used. The
same happens with the final application that you distribute to your users. The
only middleware necessary for the application to run is the middleware for
the network and QMF installed within the environment.

Blocking calls
All of QMF for Windows API functions are synchronous. This means that,
when an API is called in your application, it blocks, or does not return, until
the requested action completes. This means that the code just below the line
calling the API will not be executed until the API completes its function. This
implementation is desirable because it simplifies programming in the client
application. However, if your application is single-threaded, it will not be able
to respond to user input or perform screen refreshes while it is waiting for a
QMF for Windows API function to return.
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The QMF for Windows API responds to one function call at a time from a
client. If you client application is multi-threaded, you must:
v wait for one function call to complete before making another, or
v create multiple instances of the QMF for Windows API (one for each thread

using the API)

If it is necessary for the application to be synchronous, the programmer has to
create a new thread within the application and call the API from the new
thread. The new thread will then be blocked, but all other threads will
continue to execute normally. The programmer has to manage the timing and
execution of the threads. When developing multi-threaded applications, keep
in mind that QMF for Windows API responds to one function call to complete
before making another, or create multiple instances of the QMF for Windows
API (one for each thread using the API).

Unit of work
Each instance of the QMF for Windows API object represents a single ″unit of
work,″ and can only connect to a single database server at a time. To connect
to multiple database servers simultaneously, you create multiple instances of
the QMF for Windows API object: one for each database server. To connect to
multiple database servers serially (one after the other) using the same QMF
for Windows API object, call Commit() or Rollback() and then
InitializeServer(). Calling these functions ends the current unit of work, and
subsequent calls start a new unit of work.

Governing
One of the key features of QMF for Windows is its ability to govern, or
oversee, your use of database resources based on the resource limits
established by your system administrator. The QMF for Windows API
enforces all resource limits except warning level limits. When you reach a
cancel limit, QMF for Windows generates an error indicating that the current
action has been disallowed by your system administrator.

Database connections
Each instance of the QMF for Windows API object creates and uses a single
connection to the database for all database activity that is subject to a
subsequent rollback or commit, including opening a query, fetching data, and
executing SQL statements.

If you create more than one query in a given instance of the QMF for
Windows API object by calling InitializeQuery() two or more times, all the
queries share the same single connection. However, when you call:
v nDeleteQMFObject()
v nGetQMFObjectInfo()
v nGetQMFObjectInfoEx()
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v nGetQMFObjectList()
v nGetQMFObjectListEx()
v nGetQMFQueryText()
v nSaveQMFQuery()

QMF for Windows creates and use a second connection to the database in
order to handle administrative database activity (for example, retrieving QMF
information). This second connection is necessary to support a consistent
rollback and commit mechanism for client applications.

The QMF for Windows API object handles these connections automatically to
the database. However, if your system administrator has established a limit
for the number of connections allowed, remember that each instance of the
QMF for Windows API object may use two connections.

Controlling QMF for Windows with APIs

The following steps provide an overview of how you work with the API to
control QMF for Windows:
1. Create an instance of the QMF for Windows API object.

If you are using Microsoft Visual Basic, add a reference to the QMF for
Windows type library, qmfwin.tlb. Then use the Dim statement:
Dim QMFWin As New QMFWin

or the CreateObject statement:
Dim QMFWin As Object
Set QMFWin = CreateObject("QMFWin.Interface")

If you are using Microsoft® Visual C++® and MFC, create a wrapper class
for the QMF for Windows API object from the QMF for Windows type
library, qmfwin.tlb. Then use the CreateDispatch() function:
COleException e;
IQMFWin QMFWin;
QMFWin.CreateDispatch("QMFWin.Interface", &e);

Note: If you are using a different development environment, refer to your
product documentation on how to complete this step.

2. Select the DB2 server you want to use and call InitializeServer() to
initialize a connection to the database.

Note: You cannot initialize a server until a user ID and password are
validated by DB2. You can have QMF for Windows prompt for the
user and password, or you can prompt for them in your application
and pass them as parameters in the InitializeServer() function call.
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3. Select the query you want to run using InitializeQuery(). If the query
contains variables, use the SetVariable() function to set the variable values.

4. Open or execute the query. Use the Open() function to open the query’s
cursor for SELECT statements, and use the Execute() function to execute the
SQL for non-SELECT statements.

5. If the query is a SELECT statement, fetch rows of data by repeatedly calling
FetchNextRow(). To fetch more than one row at a time, use
FetchNextRows(), or use CompleteQuery() to direct QMF for Windows to
fetch all of the rows.

6. If the query is a SELECT statement, close the query using the Close()
function.

7. Terminate the unit-of-work using the Commit() or Rollback() functions.

QMF for Windows APIs

API example

AddDecimalHostVariable()
short AddDecimalHostVariable(long QueryID, short Type, short Precision,
short Scale, const VARIANT& Value)

Description

This function applies the data in Value to a variable in the static SQL
statement initialized with QueryID. You call this function for each variable in
the statement. QMF for Windows makes no attempt to match values to
variables, so you must call this function in the same order as the variables in
the SQL statement.

Parameters

Table 52. AddDecimalHostVariable() parameters

Name Description

QueryID The ID of the query as returned from InitializeStaticQuery().

Type The SQL data type of the value to be passed to the database
server. This value influences the conversion of Value from a
VARIANT data type to the value actually passed. The only valid
value for AddDecimalHostVariable() is 484 (RSDT_DECIMAL).

Precision The precision of the decimal value.

Scale The scale of the decimal value.

Value The data value to substitute in the statement. To specify a null
value, the type of the variant should be set to VT_EMPTY.
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Return Value

Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

Additional information

For additional information about the APIs for QMF for Windows, see the
online help for QMF for Windows. The online help discusses APIs in detail,
and lists the APIs by name, description, parameters, and return values. There
are approximately 100 APIs to date.
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Chapter 14. Working with Global Variables

Global and substitution variables

Global variables
Global variables are variables that stay active while the QMF instance is
active. It is possible to configure QMF to save your global variables from one
instance to the other.

There are two types of global variables:
v user-defined global variables
v pre-loaded (system) global variables provided with QMF for Windows

A global variable can be used in a query, form, or procedure. Global variables
may be viewed or updated by selecting the View\Global Variables option in
QMF for Windows.

The QMF for Windows set of global variables is stored in the Windows
registry. The system administrator can view and edit the system global
variables before installation or export the file to all users (copying from one
system to another after installation to keep the variables in sync). The global
variables are located in:
HKEY_CURRENT_USER\SOFTWARE\IBM\RDBI\GlobalVariables

Substitution variables
Substitution variables stay active only during execution of the object; whereas,
the global variables stay active while the QMF instance (session) is active and,
by updating the Windows registry, may be permanent in the Windows
registry.

Substitution variables are associated with QMF objects. Global variables are
associated with QMF for Windows and the operating system’s registry (if you
update the registry to make global variables permanent).

Updating the registry

When using QMF for Windows, you may add user-defined global variables
for the current work session. When QMF for Windows closes, these variables
will be lost.

Follow these steps to retain user-defined global variables:
1. Open the Registry Editor.
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2. Go to the following location in the registry:
HKEY_CURRENT_USER\SOFTWARE\IBM\RDBI\Options

3. Select New-->DWORD Value.
4. Label the DWORD, SaveGlobals.
5. Give SaveGlobals a value of 1.

The user-defined variables will be retained from session to session.

After you update the registry, all the global variables that you create will be
stored in the Windows registry and will be kept from one instance to another.

You can add your own global variables:
v manually
v during a procedure

Note: You cannot add a global variable with a DSQ prefix.

Also, you cannot change the value of a global variable with a DSQAO
prefix.

User-defined global variables

The user-defined global variables are global variables used for executing
queries, procedures or forms. In a query or procedure, no dialog box displays
for the user to enter a value if a user-defined global variable has been created.
The value specified for that global variable will be used instead.

Adding variables manually
Follow these steps to create global variables manually:
1. Go to the View: Global Variables menu.
2. Click the Add icon.

The Add Global Variable pop-up window displays.
3. Type the global variable name and its value.

Global variable names must be between 1-17 characters. Global variable
values must be between 1-55 characters long.

Note: Variable names prefixed with DSQ are not allowed because they are
system variables.

4. Click Add.
The variable will be created and can be viewed at the Global Variables
dialog box.
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Adding in procedure
Follow these steps to add a global variable during a procedure:
1. Create or open the procedure.
2. Add global information to the procedure such as:

SET GLOBAL(MY_GLOBAL=20

3. You can add multiple variables, such as in the following two examples.
a. String of variables:

SET GLOBAL(MY_GLOBAL=2,START_DATE=&DATE,DEPARTMENT=&DEPT

b. Lists each variable and uses the SET GLOBAL command only for the
first line:
SET GLOBAL(MY_GLOBAL=2,

+START_DATE=&DATE,
+DEPARTMENT=&DEPT

4. Add the following command as the last line in the procedure:
RESET GLOBAL ALL

Note: This command resets the user variables previously set.

Editing a global variable
Click Edit to change the name or value of a user-defined global variable.

Deleting a global variable
Click Delete to remove a user-defined global variable.

System global variables

QMF for Windows has a set of global variables that are pre-loaded with the
product. You can view the system global variables from the View: Global
Variable option at the main QMF for Windows dialog box.

Note: Tooltips are available for each option. This allows you to see the entire
short description of the variable.

You cannot change or delete status information for system global variables.
But, in some instances, you can change the value of the system global
variable. System global variables are hard-coded into the procedure. The name
of a system global variable cannot be changed.

QMF for Windows provides many variables to use in your queries, forms, and
procedures. All of the global variables defined for host QMF are recognized
by QMF for Windows; however, many host QMF variables do not apply to
QMF for Windows. Only the variables listed below are used and are
accessible by QMF for Windows. Any references to queries, forms or
procedures to QMF host global variables that are not supported by QMF for
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Windows are ignored. QMF for Windows may not recognize a global variable
and will use it as a substitution variable at runtime.

Global variables prefixed with DSQQW are QMF for Windows global
variables. All other global variables prefixed with DSQ are supported by
QMF for Windows and host QMF.

Viewing variable values
Follow these steps to view the possible values for a system global variables:
1. Double-click the name of the global variable.

The Change Global Variable Value pop-up window displays.
2. Select the variable from the drop-down list.
3. Click OK.

For example, for the DSQEC_FORM_LANG global variable, you can select one of
the following options:
0 - Use NLF language when saving forms
1 - Use English language when saving forms

Note: The following message displays if you try to change the value of
″protected″ global variables:
You cannot set the value of [global variable name].

Naming convention
The naming convention for global variables is:
DSQcc_xxxxxxxxx

where DSQcc can be one of the following category identifiers:

Table 53. Global variable naming convention

Identifier Description

DSQAO State information (controls administrative objects)

DSQCP Information about the Table Editor

DSQDC Controls how QMF for Windows displays information

DSQEC Controls how QMF for Windows executes commands
and procedures

DSQQW Controls specific to the QMF for Windows
environment

State information variables
Global variables prefixed with DSQAO provide state information about QMF
for Windows.
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Note: None of these variables can be modified by the SET GLOBAL command.

Table 54. State information global variables

Global variable Length Description

DSQAO_BATCH 1 Batch or interactive mode. Value can be
1 (interactive session) or 2 (batch
session).

See /Batch command parameter.

DSQAO_CONNECT_ID The ID used to connect to the current
database.

DSQAO_CURSOR_OPEN 1 Status of current query’s database
cursor. Value can be:

v 1 (cursor is open)

v 2 (cursor is closed)

DSQAO_DBCS 1 DBCS support status. Value can be:

v 1 (DBCS support)

v 2 (DBCS support is not present)

DSQAO_NLF_LANG 1 National language ID.

DSQAO_NUM_FETCHED 10 Rows fetched by current query object.

DSQAO_OBJ_NAME 18 Name of current QMF object (query,
form or procedure).
Note: This value is blank if there is no
current object.

DSQAO_OBJ_OWNER 8 Owner of current QMF object (query,
form or procedure).
Note: This value is blank if there is no
current object.

DSQAO_QMF_RELEASE 2 Release number of application.

DSQAO_QMF_VER_RLS 10 Version and release of application. For
example, for QMF for Windows version
7.2, this value is ’QMF V7R2’.

DSQAO_QRY_SUBTYPE 1 Subtype of current query. Value can be:

v 1 (SQL query)

v 3 (prompted query)

DSQAO_QUERY_MODEL 1 Model of current query. Value can be 1
(relational).
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Table 54. State information global variables (continued)

Global variable Length Description

DSQAO_SYSTEM_ID 1 Operating system (OS). Values can be:

v ’6’ for Windows 3.x

v ’7 for Windows 95 or Windows 98

v ’8’ for Windows 2000 and Windows
NT

Table Editor variables
Global variables prefixed with DSQCP control the operation of the Table
Editor. All of these variables can be modified by the SET GLOBAL command.

Table 55. Table editor global variables

Global variable Length Description

DSQCP_TEDFLT 1 Default character for a column in
QMF Table Editor. The default value
is ’+’. This variable can also be set on
the Options dialog box.

DSQCP_TENULL 1 Default character for a NULL
character for a column in QMF Table
Editor. The default value is ’-’. This
value can also be set on the Options
dialog box.

Display information variables
Global variables prefixed by DSQDC control how QMF for Windows displays
information. All of these variables can be modified by the SET GLOBAL
command.

Table 56. Display information global variables

Global Variable Length Description

DSQDC_CURRENCY 18 Custom currency symbol for DC
edit code.

DSQDC_DISPLAY_RPT 1 Display a report after RUN QUERY.
The value can be:

v 0 (the default, do not display a
report)

v 1 (automatically display the
report with the form)
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Table 56. Display information global variables (continued)

Global Variable Length Description

DSQDC_LIST_ORDER 2 Default sort order for objects in
List window.

The value for the first character can
be:

v 1 (default order)

v 2 (sort by object owner)

v 3 (sort by object name)

v 4 (sort by object type)

The value for the second character
can be:

v A (sort in ascending order)

v D (sort in descending order)

Note: The default value is 1A.

Command and procedure variables
Global variables whose names are prefixed with DSQEC control how QMF
for Windows executes commands and procedures. These variables can be
modified by the SET GLOBAL command.

Table 57. Command and procedures global variables

Global Variable Length Description

DSQEC_FORM_LANG 1 Default NLF language for saving or
exporting a form. Value can be:

v 0 (presiding NLF language)

v 1 (English)
Note: The default is 1 (English).

DSQEC_NLFCMD_LANG 1 Expected NLF language for
commands in procedures. Value
can be:

v 0 (presiding NLF language)

v 1 (English)
Note: The default value is 0.
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Table 57. Command and procedures global variables (continued)

Global Variable Length Description

DSQEC_RESET_RPT 1 Prompt when handling an
incomplete data object. Value can
be:

v 0 (complete the data object
without prompting)

v 1 (prompt the user to complete
the data object)

v 2 (reset the data object without
prompting)

DSQEC_SHARE 1 Default value for sharing saved
objects. Value can be:

v 0 (do not share the object)

v 1 (share the object)

Windows environment variables
Global variables prefixed with DSQQW are specific to the QMF for Windows
connections. These variables can be modified by the SET GLOBAL command.

Table 58. Windows environment global variables

Global Variable Length Description

DSQQW_AUTOMATION 1 Indicates whether the current instance
of QMF for Windows was started to
service OLE automation requests
(value is 1) or to service the user
interface (value is 0).
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Table 58. Windows environment global variables (continued)

Global Variable Length Description

DSQQW_CONNECTIONS 1 Use server connections while running
a procedure. This setting controls the
number of server connections for
procedures.

v 0 = minimize the number of
connections

Specifying a value of 0 can force
QMF for Windows to reset or
complete a data object before
continuing the execution of a
procedure.

If set to 0, you specify a linear
connection, which means that the
first query must complete before
the next is run. These queries are
run in a series.
Note: The default is 0.

v 1 = all: a new connection for each
RUN QUERY command

If set to 1, subsequent connections
are opened so the queries are run
in parallel (at the same time).

Note: This global variable is designed
to be used with
DSQQW_FST_SV_DATA (by which
the query will be PREPARED only on
RUN QUERY.

DSQQW_DQ ″ Double-quote character

DSQQW_EXP_DT_FRMT 1 Format for EXPORT DATA. Value can be:

v 0 (text)
Note: The default is 0.

v 2 (html)

v 3 (csv - comma-separated value)

v 4 (ixf)

For the EXPORT command, you can
export the report to a file name with
a file type of .qmf, .html or .txt.
Note: In a procedure (with a .txt file
type), if no options are specified as
delimiters, the default is spaces.
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Table 58. Windows environment global variables (continued)

Global Variable Length Description

DSQQW_EXP_OUT_MDE 1 IXF mode for procedures. Value can
be:

v 0 (System/370 character mode IXF)

v 1 (PC/IXF)
Note: The default is 1.

DSQQW_FST_SV_DATA 1 Use ’Fast Save’ mode for SAVE DATA.
Value can be:

v 0 (do not use fast mode)
Note: The default is 0.

v 1 (use fast mode)

DSQQW_HTML_REFTXT 55 Text for &REF form variable. The
default is ’Back To’.

DSQQW_PROC_OUTPUT Report Center will pass the path
name and file name to a procedure
that uses &DSQQW_PROC_OUTPUT.

EXPORT REPORT TO
&DSQQW_PROC_OUTPUT

Alternatively:

EXPORT DATA TO &DSQQW_PROC_OUTPUT

DSQQW_QUERY_LANG 1 Subtype of query created by DISPLAY
QUERY when no query object exists.
Value can be:

v 0 (SQL)
Note: The default value is 0.

v 1 (prompted)

DSQQW_QUERY_PREP Prepare the query on a RUN command
instead of running. This option
invokes the PREPARE SQL command.

DB2 will check the query syntax,
existence of every object concerned
with the query, but internal
calculations will be performed and no
data will be sent to the client. This
option can be used to validate queries
with complicated calculations or ones
that will return significant data. Value
can be:

v 0 (No)

v 1 (Yes)
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Table 58. Windows environment global variables (continued)

Global Variable Length Description

DSQQW_RPT_COPIES 10 Number of copies for PRINT REPORT.
The default is 1.
Note: If DSQQW_RPT_USE_PS is set to 1,
the Page Setup options are used; if it
is set to 2, the global variable settings
are used.

DSQQW_RPT_FONT 55 Font for PRINT REPORT. The default
is’Courier New’.
Note: If DSQQW_RPT_USE_PS is set to 1,
the Page Setup options are used; if it
is set to 2, the global variable settings
are used.

DSQQW_RPT_FONT_BD 1 Bold attribute for PRINT REPORT. The
default is 0.
Note: If DSQQW_RPT_USE_PS is set to 1,
the Page Setup options are used; if it
is set to 2, the global variable settings
are used.

DSQQW_RPT_FONT_IT 1 Italic attribute for PRINT REPORT. The
default is 0.
Note: If DSQQW_RPT_USE_PS is set to 1,
the Page Setup options are used; if it
is set to 2, the global variable settings
are used.

DSQQW_RPT_FONT_SZ 2 Font size for PRINT REPORT. The
default is 10.
Note: If DSQQW_RPT_USE_PS is set to 1,
the Page Setup options are used; if it
is set to 2, the global variable settings
are used.

DSQQW_RPT_LEN_TYP 1 Type of page length for PRINT REPORT.
The value can be:

v 0 to fit the length of the printed
page
Note: The default value is 0.

v 1 to specify an explicit number of
lines

v 2 to specify a continuous report
with no page breaks

Note: If DSQQW_RPT_USE_PS is set to 1,
the Page Setup options are used; if it
is set to 2, the global variable settings
are used.
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Table 58. Windows environment global variables (continued)

Global Variable Length Description

DSQQW_RPT_NUM_CHR 10 Number of characters across a printed
page for PRINT REPORT. This has an
effect only when
DSQQW_RPT_WID_TYP is 1. The
default value is 80.
Note: If DSQQW_RPT_USE_PS is set to 1,
the Page Setup options are used; if it
is set to 2, the global variable settings
are used.

DSQQW_RPT_NUM_LNS 10 Number of lines down a page for
PRINT REPORT. This has an effect only
when DSQQW_RPT_LEN_TYP is 1.
The default value is 60.
Note: If DSQQW_RPT_USE_PS is set to 1,
the Page Setup options are used; if it
is set to 2, the global variable settings
are used.

DSQQW_RPT_ORIENT 1 Page orientation for PRINT REPORT.
The value can be:

v 0 = portrait
Note: The default is 0.

v 1 = landscape

Note: If DSQQW_RPT_USE_PS is set to 1,
the Page Setup options are used; if it
is set to 2, the global variable settings
are used.

DSQQW_RPT_USE_PS 1 Set of page formatting options (page
length, page length) for PRINT REPORT.
The value can be:

v 0 (use the values specified on the
PRINT REPORT command or in
global variables)

v 1 (use the values specified in the
form document’s page setup. This
is the default.

Note: If this value is set to 1, the
Page Setup options are used; if it is
set to 2, the global variable settings
are used.
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Table 58. Windows environment global variables (continued)

Global Variable Length Description

DSQQW_RPT_WID_TYP 1 Type of page width for PRINT REPORT.
Value can be 0 (fit the width in the
printed page) or 1 (specify an explicit
number of characters). The default is
0.
Note: If this value is set to 1, the
Page Setup options are used; if it is
set to 2, the global variable settings
are used.

DSQQW_SHOW_QUERY 1 View of a query for SHOW QUERY. Value
can be:

v 0 = SQL or prompted view
Note: The default value is 0.

v 1 = results view

DSQQW_STRIP_SPACE 1 Remove trailing spaces from objects
retrieved from server. Value can be:

v 0 = retain trailing spaces

v 1 = remove trailing spaces
Note: The default is 1.

DSQQW_SV_DATA_C_S 10 Rows to insert before commit for SAVE
DATA. Value can be:

v 0 = all rows
Note: The default is 0.

v n, where n is an explicit number of
rows

DSQQW_UEDIT_DLL 55 DLL implementing user edit routines.
The default value is rsuedit.dll

DSQQW_PROC_WNDWS Procedure results options. Values are:

v 0 = leave the most recent objects
open at the end of the procedure

For example, leave the most recent
query and form open at the end of
the procedure, but not the most
recent procedure.

v 1 = leave all objects open at the
end of the procedure
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Chapter 15. Working from the Command Bar

A command bar is available at the top of the QMF for Windows user
interface. From this command line you can enter commands and specify the
server at which to run the command. A drop-down list box lists the recent
commands.

If it is not visible, select View: Command bar to display the command bar.

Executing commands automatically

Settings and actions can be defined to take effect when QMF for Windows is
started. These parameters are defined on the QMF for Windows command
line. They can be used to preset settings or to run unattended sessions.

For help on adding command line parameters to an icon or start menu, refer
to your operating system’s help facility.

Command bar parameters

The command line parameters are listed and described below.

Table 59. Command bar parameters

Parameter Description

ObjectName The QMF for Windows file (query, procedure, job, or
form) that is opened when you start QMF for
Windows.

/IProcName:procedurename The name of a procedure stored at a database server
to run after starting QMF for Windows. To use the
/IProcName parameter, you must also specify the
/IServer parameter if the server is different from the
server on which the procedure was created.

/IProcFile:procedurefile Defines the location and name of a locally-stored
procedure file to run after starting QMF for Windows.

/IServer:servername The server where the startup procedure specified on
the /IProcName parameter is stored.

/IObject:″ObjectOwner″.″ObjectName″The name of an object stored at a database server that
will be retrieved after starting QMF for Windows. To
use the /IObject parameter, you must also specify the
/IServer parameter.
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Table 59. Command bar parameters (continued)

Parameter Description

/IRun Starts an opened or retrieved object. It is used in
conjunction with /IUserID and /IPassword parameters.
Note: This parameter ignores forms and jobs.

/IDisplay An opened or retrieved object. If /IRun or /IDisplay
parameters are not specified, then the /IDisplay
parameter is used.

/IUserID:userID The user ID to use when running an object specified
with the /IProcName or /IProcFile parameters or with
the Object Name or /IObject parameters. It is used in
conjunction with the /IPassword parameter.

/IPassword:password The user’s password specified with the /IUserID
parameter.
Note: The /IPassword parameter includes the user’s
password in plain text.

/Batch End the current session of QMF for Windows and
close the application after running the object specified
on the command line. This parameter suppresses all
warning and error messages.

&variablename-variablevalue Define or update global variable values for a
procedure or query. Multiple variables can be
defined.
Note: The value sent to the procedure must be
enclosed in double quotes (″ ″).

/ICatalogUserID The user ID to use when connecting to an ODBC data
source. It is used in conjunction with the
/ICatalogPassword parameter.

/ICatalogPassword The user’s password, as specified with the
/ICatalogUserID. This parameter is used when
accessing ODBC data sources.

ICatalogUserID The catalog server’s user ID to use when working
with a server specified with the /IServer parameters.
It is used in conjunction with the /ICatalogPassword
parameter.

ICatalogPassword The password of the user specified with the
/ICatalogUserID parameter.
Note: The /IPassword parameter includes the user’s
password in plain text.
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How to use the command bar

Follow these steps to use the command line functionality in QMF for
Windows:
1. Create a procedure.

For example,
run query ObjectTracking (form=ObjectTrackingForm
export report to c:\qmftrack.rep
windows notepad c:\qmftrack.rep

This example executes a query called ObjectTracking using the form called
ObjectTrackingForm for report generation. It will export the report to a file
called qmftrack.rep at the local system in c:\directory. The last statement,
Windows Notepad c:\qmftrack.rep, will open the saved report file using
the Windows Notepad application.

2. Save the procedure at the server or as a local file on your system.
For example,
c:\procedure1.prc

3. Execute the procedure saved at the server or saved as a local file.
4. Issue the following statement at the command line prompt to execute the

procedure if saved at the server:
"C:\Program Files\IBM\QMF for Windows\qmfwin.exe" /IServer:DB2AIX
/IProcname:DB2INST1.Procedure1 /IUserID:db2inst1 /IPassword:db2inst1

Note: Make sure to include the double quotes around the path
specification within the statement if the path contains spaces.

5. Issue the following statement from the system command prompt to
execute the procedure saved in a local file:
"C:\Program Files\IBM\QMF for Windows\qmfwin.exe" /IServer:DB2AIX
/IProcfile:"c:\Procedure1.prc" /IUserID:db2inst1 /IPassword:db2inst1

Note: Make sure to include the double quotes around the path
specification within the statement if the path contains spaces.
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Appendix A. Working with IBM DB2 Spatial Extender

The IBM DB2 Spatial Extender stores, accesses, manages, and analyzes spatial
data that you can query. The Spatial Extender works with ESRI spatial
visualization tools. This enables you to gather spatial data and attach
non-spatial business data attributes to it.

IBM DB2 Spatial Extender is a feature incorporated into IBM DB2 Universal
Database that enables spatial data access and analysis. Spatial data consists of
values that denote the location of objects and areas with respect to one
another. The technology for DB2 Spatial Extender was jointly developed by
IBM and ESRI.

An estimated 80% of all data has embedded spatial characteristics. This data
can be exploited to formulate queries containing relevant parameters.

Features

v Make spatial data relevant to your business, such as customers, staff,
departments, inventory

v Combine spatial data with business data in the same RDBMS to better
manage your data within DB2

v Use SQL extensions to handle complex data types and allow applications to
store and manipulate objects directly inside the DB2 database

v Make this data more SQL accessible
v Ability to do SQL querying of spatial data or joining this data with

conventional business data stored any DB2 database
v Work with visualization tools, such as ArcView, to provide visual map

renderings of spatial data

Note: ArcView is required to use the IBM DB2 Spatial Extender feature.
v Spatial data modeling
v Multiple data types (13)
v Support for popular industry formats, such as ESRI shape files (.shp)

Prerequisites

v DB2 Spatial Extender
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v Licensed copy of DB2 Universal Database Enterprise Edition, or licensed
copy of DB2 Universal Database Enterprise-Extended Edition for Windows
NT or AIX®

v Microsoft Windows NT, Microsoft Windows 2000, or IBM AIX

Integration with QMF for Windows

IBM Spatial Extender is integrated in many areas of QMF for Windows.

Export Data dialog box
Two options have been added to the Save as Type menu option:
v dBase III file (*.dbf)

If you press Options when you select this file type, the ExportdBase
Options dialog box displays. Here, you can select whether to export all data
or selected data.

v Shape file

Shape file (*.shp) is an option available under the Save As Type menu
option if the result set being exported contains exactly one column with a
spatial data type. If you press Options when you select this file type, an
Export Shape File Options dialog box displays. Here, you can specify
whether to export all data or selected data.

Import Data dialog box
Two options have been added to the Files of Type menu option.
v dBase III files (*.dbf)

You can select a dBase file to import. The data is imported into the result
set of a new query document, similar to importing IXF data.

v Shape files (*.shp)

You can select a shape file to import. The data is imported into the result
set of a new query document, similar to importing IXF data.

Invoking the ESRI Visualization Component

You can invoke the ESRI Visualization Component, which is used to present
shape files (*.shp) visually.

Results menu
The Visualize option on the Results menu does the following:
1. Exports the current result set to a temporary shape file.
2. Displays the Visualize Spatial dialog box.

This command is available only if the current result set contains exactly one
column with a spatial data type.
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Note: Only one layer will be created from each temporary shape file.

List menu
The Visualize command on the List menu (or from the right-click menu in an
object list) does the following:
1. Retrieves and runs the selected queries and tables.
2. Exports the result sets to temporary shape files.
3. Displays the Visualize Spatial Data dialog box.

Note: Only one layer will be created from each temporary shape file.

The Visualize command is available only if queries and tables are selected in
the list.

Note: An error occurs if any of the result sets do not contain exactly one
column with a spatial data type.

File menu
From the Select File menu option, choose Visualize Shape File to browse for
an open a shape file. When you choose this option, the Open dialog box
displays. Enter search information at this dialog box to search for the shape
file. After you select the shape file, the Display Map dialog box displays, with
one layer created from the selected shape file.

Note: In the Open dialog box, the Files of Type lists only shape files (*.shp).
The Visualize Shape command is always enabled on the File menu.

Display Map

The Display Map dialog box displays spatial data and the corresponding
layers used to build the data. This dialog box has two panes: the Layers List
and the Result Map.

Layers list
The left side of the Display Map dialog box contains a tree control that
displays the layers being visualized. Each layer corresponds to a shape file in
the file system, including temporary files.
v For each layer created from a temporary shape file or exported from a

query or table, the label for that layer is the name of the query or table,
followed by the name of the shape file in parentheses.

v For each layer created from an existing shape file, the label for each layer
will be the label of the shape file.
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Table 60. Layers list controls

Control Description

Add Displays the Add Layer dialog box, where you can add
a layer by selecting a result set that contains spatial
data, a query or table, or a shape file.

Remove Removes the selected layer from the right pane display.

Add Layer dialog box
Use the Add Layer dialog box to add a layer from a file, database, or open
document. Some options may not be active. For example, you can select an
option only if there is at least one result set open that contains spatial data.
The selected file is created as a new layer in the visualization.

Click List Objects to locate the desired object via the List Objects dialog box.

List Objects dialog box
Use the List Objects dialog box to specify the server, owner, or name of the
object that you want to add as a layer. Specify the criteria for locating the
object, then select the object from the list.

Result Map
The right side of the Display Map dialog box visually presents the spatial data
assembled from the selected queries, tables, or shape files.

Table 61. Result map controls

Control Description

Zoom In Changes focus on an area of the result map. The result
map will be magnified in the selected area.

Zoom Out Changes the focus on an area of the result map. The
result map will be reduced in the selected area.

Pan Pull down or pull up the result map to change the
vertical view.

Pan Diagonally Shift the content of the result map diagonally.

Help Obtain online help.

Save Save the content of the result map, including its layers.
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Procedure Commands

Table 62. Procedure commands

Procedure Description

SPATIAL Perform spatial operations from a procedure.
Below are the forms of the SPATIAL command.

SPATIAL RESET Reset the current visualization specification to
contain no layers.

SPATIAL ADD Export the current data object to a temporary
shape file and add it, as a new layer, to the
current visualization specification.
Note: An error occurs if the current data
object does not contain exactly one column
with a spatial data type.

SPATIAL EXPORT TO file-name
(DATAFORMAT-
JPG|BMP|GIF|...,CONFIRM=YES|NO

Invokes the ESRI component to visualize the
layers in the current visualization specification
and export the image to a file with the
specified name, in the specified data format.
The CONFIRM option controls whether an
overwrite confirm message should display if
the specified file exists.
Note: An error occurs if the current
visualization specification is empty.

SPATIAL DISPLAY Displays the Visualize Spatial Data dialog box
to visualize the layers in the current
visualization specification. The procedure is
suspended until the user closes the dialog
box. Then, it continues running.
Note: An error occurs if the current
visualization specification is empty.

EXPORT DATA This procedure command accepts the
following values for the DATAFORMAT option:

v DBF

v SHP

This function is similar to the EXPORT FORMAT
command and the Export Data dialog box.
Note: An error occurs if SHP is specified and
the current data object does not contain
exactly one column with a spatial data type.
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Table 62. Procedure commands (continued)

Procedure Description

IMPORT DATA This procedure works with dBase files and
shape files. This function is similar to the
IMPORT DATA command and the Import Data
dialog box. The type of data that is being
imported is determined by the file extension,
where .dbf means a dBase file, .shp means a
shape file, and anything else means an .ixf file
(which maintains backward compatibility).
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Appendix B. Working with QMF Query for Java

Overview

QMF Query for Java opens data stored in any member of the DB2 family of
databases to any web browser client. It uses 100% pure Java technology to
provide server platform independence.

This chapter describes the setup and configuration of an HTTP server, a Web
application server, and the JDBC drivers on a Windows NT/2000 platform.

Features

QMF Query for Java enables you to create and run SQL queries against DB2
databases and format the results for viewing or use in other applications.

After logging into the database (by specifying the database name, user ID,
and password), you can select QMF for Windows SQL queries, prompted
queries, or database tables. You can also create a new SQL query manually or
by using a prompted query tool. Queries can be parameterized, and you can
specify different input values each time you run an SQL query.

Once a query is run and a result set is obtained, there are several ways to
view or export the results data. You can:
v apply a QMF form from the server or from your computer to create a

report
v generate a QMF form from the query
v export the data in text format for import into other applications
v export the data in comma-separated value (*.CSV) format for import into

spreadsheet applications
v save the data to a new or existing database table

The resulting output report or export file (and the database connection) is
maintained for the lifetime of the web server session.

Object tracking
Object tracking, similar to that in QMF for Windows, is performed
automatically. The tracking data for executed queries is stored in the
Q.OBJ_ACTIVITY_SUMM and Q.OBJ_ACTIVITY_DTL tables.
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Getting started with QMF Query for Java

Connect
To launch QMF Query for Java, open a web browser and enter the following
URL:
http://serverHost/servlet/QMFJava

ServerHost is the server name where QMF Query for Java has been installed.
The name of the servlet is assumed to be QMFJava. If it is not, change the URL.

The QMF Query for Java logon page displays.

Log on

Procedure
Once you install and configure QMF Query for Java, as described in the
appendix, ″Using QMF Query for Java,″ in the Getting Started with QMF for
Windows manual, you can connect using any Web browser.

Follow these steps to log in to QMF Query for Java before interacting with a
database.
1. Enter the name of the database you want to query.
2. Enter your user ID and password.

Note: Your User ID is the user ID at the selected database. Your database
server user ID is not necessarily the same as your local or network
ID.

3. Click Next.
The List Objects page displays.

Table 63. Controls on login page

Control Description

Continue Open the List Objects page

Back [This control is disabled.]

Home [This control is disabled.]

Save [This control is disabled.]

Exit Closes QMF Query for Java and logs off the current
user

Help Display the online help facility

Options [This control is disabled.]
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You are now logged on to QMF Query for Java. After logging on to the
database, you can work with queries or database tables or create a query. You
can add parameters to queries and specify different input values each time
you run the query.

Select objects

Use the List Objects page to view a list of objects (queries or tables) belonging
to the specified owner and name. From this page, you can select the objects
you want to view and provide information on how these objects will be
sorted on the page. Additionally, you can run, edit, or delete the object. There
are also options to create an SQL or prompted query if the desired object does
not exist for this owner and name.

Fields

Owner
The owner of the object, such as Q.

The owner is taken from the Login page. If you leave the default name, (%),
all objects will be listed for this owner and ID.

Name
The name of the object, such as APPLICANT.

The name is taken from the Login page. If you leave the default name, (%), all
objects will be listed for this owner and ID.

You can specify ″like″ information to work with particular queries or tables,
such as:
Objects with an owner like: MA%

and a name like: REPORT%

Object type
Specify the objects with which you want to work. You can choose from queries
and tables.

Sort list by
Specify the sort condition for the List Objects. You can choose from owner and
name or comment.

Note: A comment describes the query. A comment can be up to 80 characters
in length. Comments are optional.

List Objects
This table lists the objects that meet your criteria (owner, name, or object type
- table or query).
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The owner and name of the object are listed, along with comments, if any. The
objects listed are listed alphabetically, in descending order, by owner and
name or comment.

The icon to the left of the object identifies whether the object is an SQL query
or a prompted query. This determines the page to which you advance when
editing the query.

Procedure

Working with an existing object
1. Type the owner or name of the object with which you want to work.

Optionally, you can type the owner and (object) name.
2. Check the object type. Choices are query and table.

Optionally, you can select query and table objects.
3. Specify how you want to sort the List Objects. Choices are by owner and

name or by comment.

Note: Comments are optional and may not exist for queries and tables.
4. Click Refresh to update the List Objects based on your entries.
5. Locate the object in the List Objects.
6. Click on the object, then click Continue or double-click on the object.

Note: You cannot double-click on an object if you are not using a grid.

The Format Query Results page displays. See ″Format Query Results″ for
more information about this option.

Other options are described below.

Controls

Table 64. Controls on List Objects page

Control Description

Continue Open the next page

Back Return to the prior page. Your entries are cancelled.

Home [This control is disabled.]

Save [This control is disabled.]

Exit Closes QMF Query for Java and logs off the current
user

Help Display the online help facility
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Table 64. Controls on List Objects page (continued)

Control Description

Options Display the Options page, where you can customize:

v User interface (look and feel)

v Query results

v HTML reports

v Page format

v LOB

v Exported text data

v Exported csv data

See ″options″ for information on these options.

Run Run the selected object (query or table). The object
runs and the Format Query Results page displays.
Here, you specify how you want to handle the results
(to a form or report). See ″Format Query Results″ for
information on this option.

Edit Display the Edit Query page to edit the selected object
(query or table). See ″Edit Query″ for information on
this option.

Delete Delete the selected object (query or table).
Note: Delete- and delete-confirmation prompts display
when you select this option.

Create SQL query Display the SQL query page to enter an SQL
statement. See ″Create SQL Query″ for information on
this option.

Create prompted query Display the Prompted Query page to select the tables,
columns, join, sort, and row conditions used to create
a query. See ″Create Prompted Query″ for information
on this option.

Edit SQL Query

You can edit an SQL query from the List Objects page. A query is a
description of a result set of data that you want to retrieve from a database.

Fields

Text of Owner.Name
Use the Text of Owner.Name field to edit the text of the query.

Note: The dialog is captioned Text of [ ] where [ ] is replaced by the
query name, such as:
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Text of DB2ADMIN.GRID

Procedure
1. Select the query you want to edit.
2. Click Edit.

The Edit SQL Query page displays, and contains the SQL associated with
the query.

3. Update the SQL text.
4. Click Continue.

The Format Query Results page displays.

Controls

Table 65. Controls on Edit SQL query page

Control Description

Continue Open the next page

Back Return to the prior page. Your entries are cancelled.

Home Return to the List Objects page to work with or create
a query

Save Save the current query to the database. This function
is not available from all pages.

Exit Close QMF Query for Java and logs off the current
user

Help Display the online help facility

Options Display the Options page, where you can customize:

v user interface (look and feel)

v Query results

v HTML reports

v Page format

v LOB

v Exported text data

v Exported csv data

See ″Options″ for information on these options.

Create SQL query

You can create an SQL query from the List Objects page. This option creates
an ad hoc SQL query. A query is a description of a result set of data that you
want to retrieve from a database.
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Fields

Enter an SQL statement
Use the input field to enter the text of the new query.

Procedure
1. Click Create SQL query at the Objects List page.

The SQL Query page displays.
2. Type the text of the query.
3. Click
4. Continue to run the query.

The Format Query Results page displays.

Controls

Table 66. Controls on Create SQL query page

Control Description

Continue Run the query

Back Return to the prior page. Your entries are cancelled.

Home Return to the List Objects page to work with or create
a query

Save Save the current query to the database. This function
is not available from all pages.

Exit Close QMF Query for Java and logs off the current
user

Help Display the online help facility

Options Display the Options page, where you can customize:

v user interface (look and feel)

v Query results

v HTML reports

v Page format

v LOB

v Exported text data

v Exported csv data

See ″Options″ for information on these options.

Save object

The Save Object page displays when you click Save from any page where
Save is enabled.
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Fields

Query owner
The owner of the object being saved.

Query name
The name of the object being saved.

Comment
A comment, up to 80 characters, that describes the object. You can leave this
field blank.

Share the query with other users
When checked, makes the query available to other users.

Replace the query if it already exists
When checked, replaces any query that shares the same owner and name.

Procedure
1. Define the Query Owner and Query Name.
2. Optionally, at the Comment field, add a comment to describe the query.
3. Specify whether the query can be shared.
4. Define whether to replace an existing query if it has the same name.

A message displays that the object was saved.

Controls

Table 67. Controls on Save Object page

Control Description

Continue Save the query or prompted query

Back Return to the prior page. Your entries are cancelled.

Home Return to the List Objects page to work with or create
a query

Save [This control is disabled.]

Exit Close QMF Query for Java and logs off the current
user

Help Display the online help facility
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Table 67. Controls on Save Object page (continued)

Control Description

Options Display the Options page, where you can customize:

v user interface (look and feel)

v Query results

v HTML reports

v Page format

v LOB

v Exported text data

v Exported csv data

See ″Options″ for information on these options.

Create prompted query

You can create a prompted query from the List Objects page. A prompted
query is a graphical representation of the components that make up a query. If
you are not familiar with SQL syntax, use the Prompted Query page to create
and edit your queries.

At least two components are required to create a prompted query: tables and
columns. You need to specify join conditions if you select more than one table
for the prompted query. Row conditions and sort conditions are optional.

The Create Prompted Query page is a form that is laid out in logical order.
The sections below describe how to complete the form by identifying the
required input fields for each element included in the prompted query.

Add Tables
Displays the names of the tables in the prompted query. The tables from
which you are retrieving data are the first elements you specify in a prompted
query. You must include at least one table in this list to run a prompted query.

Note: No tables will be associated with the prompted query when you select
the create function. You must add at least one table to the prompted
query before you can add columns, join conditions, sort conditions, and
row conditions. These fields are disabled until you add a table to the
prompted query.

The Add Table page displays when you click Add Table from the Create
Prompted Query page. Use this page to identify which tables will be added to
a new prompted query.
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Fields
Select a table to add

Specify the criteria for adding a table to the prompted query. Choices are:

Table 68. Table selection criteria

Table criterion Description

Tables with owner like The owner of the table you want to include in the
query. Use % as a wildcard, if applicable.

And a name like The name of the table you want to include in the
query. Use % as a wildcard, if applicable.

How do you want to sort the list of objects?

Specify the criteria for sorting the tables added to the prompted query.
Choices are:

Table 69. Table sort criteria

Sort criterion Description

By owner and name Sorts the List Objects alphabetically by owner and
name

By comment Sorts the List Objects alphabetically by the comment
associated with the object.
Note: Not all objects have comments.

Procedure
1. Type the owner and name of the table you want to add to the prompted

query.
2. Click on the sort option to sort the tables in the prompted query by owner

and name or comment.
3. Click Continue.

The Select Table page displays. This page presents the same information as
the List Objects page, including listing tables by owner, name, and
comments.

4. Double-click on a table or select a table and click Continue.
You return to the Create Prompted Query page. The table will be listed.
Next, you can specify the columns from the selected table to include in the
prompted query. See ″Add Columns″ for more information.

Add Column
The Add Column page displays when you click Add Column from the Create
Prompted Query page.
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Use this page to identify which columns will be added to the new prompted
query from the selected tables.

Fields
Select a column

Choose the columns to add to the prompted query. The columns that display
are the columns from the selected table. If you select two or more tables, the
columns from each table are prefixed. For example,
A.TEMPID
A.NAME
A.ADDRESS
B.TEMPID
B.NAME
B.INTDATE
B.STARTDATE

Use Ctrl to select multiple columns, if applicable.

Enter an expression

(Or enter an expression here): Enter an SQL expression to take some kind of
action against the selected column. For example:
Q.ID+10

This expression will add 10 to each ID.

New column name

This field enables you to rename a column. The new column name will be
included in the result set. For example, you can change A.OBJECTLEVEL to
AUTHORIZATION. This allows you to rename the column for the result set but
not the table.

Summary function

The summary function enables you to obtain different types of summary
information for a column. For example, select a column (Q.SALARY) then
choose the summary type (AVERAGE) to determine the average salary of a
department. The following summaries are available:
v Average
v Count
v Maximum
v Minimum
v Sum
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Procedure
1. From the column list, select the column or columns you want to add to

the prompted query. The columns are taken from the selected table or
tables.
You can use Ctrl to select multiple columns.

2. Alternatively, you can enter an expression,
3. Click Continue.

You return to the Create Prompted Query page. The columns will be
listed.
[Optional] You can specify the join conditions to link tables in the
prompted query. This is required if more than one table is selected and the
tables have matching columns. See ″Add Join Conditions″ for more
information about this option.
[Optional] You can specify sort conditions to organize the query results
based on the columns included in the table or tables. See ″Add Sort
Conditions″ for more information about this option.
[Optional] You can specify row conditions to determine which rows are
returned in the query results. See ″Add Row Conditions″ for more
information about this option.

Add join conditions
Displays the join conditions used to connect the tables in the query. When you
add more than one table, you must specify at least one join condition for each
table. Any table that is not part of at least one join condition is deleted from
the query automatically.

The Join Condition page displays when you click Add Join Condition from
the Create Prompted Query page. The join condition will be used to connect
the tables in the query. The join condition specifies how the tables are related.

Note: This control is disabled if a single table is selected for the prompted
query.

Fields

Table [ ]: The left- and right columns list the columns in each table from
which you can make a join condition.

Note: Rows that have equal values in those columns will be joined.

Procedure
1. Click a column from the left- and right lists of columns in each table.

Select columns with equal values from each table, such as joining the
following tables by NAME:
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Table 70. Sample Join Conditions

Table [ A ] Table [ B ]

OWNER (CHARACTER)
NAME (CHARACTER)
TYPE (CHARACTER)
SEQ (NUMERIC)

TEMPID (NUMERIC)
NAME (CHARACTER)
ADDRESS (CHARACTER)
EDLEVEL (NUMERIC)

2. Click Continue.
The Create Prompted Query page displays. The join conditions will be
listed.
[Optional] You can specify sort conditions to organize the query results
based on the columns included in the table or tables. See ″Add Sort
Conditions″ for more information about this option.
[Optional] You can specify row conditions to determine which rows are
returned in the query results. See ″Add Row Conditions″ for more
information about this option.

Sort conditions
The Sort Condition page displays when you click Add Sort Condition from
the Create Prompted Query page. The sort condition will be used to organize
the query results, based on the columns included in the tables. For example, if
you selected the following columns from two joined tables (prefixed by A and
B), select a single column by which to sort the query results.

Note: Sort conditions are optional in a prompted query.

Table 71. Sample sort conditions

Column to sort by

A.OWNER (CHARACTER)
A.NAME (CHARACTER)
A.TYPE (CHARACTER)
A.SEQ (NUMERIC)
A.APPLDATA (LONG VARCHAR FOR BIT DATA)
B.TEMPID (NUMERIC)
B.NAME (CHARACTER)
B.ADDRESS (CHARACTER)
B.EDLEVEL (NUMERIC)
B.COMMENTS (CHARACTER)

If sorting by multiple columns, the results will be sorted by the first sort
condition, then the second sort condition within the first, and so on. In the
example below, the primary sort is on Manager (in descending order), Salary
(in ascending order), then Name (in descending order).
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Table 72. Sample sort conditions

Manager Salary Name

Salloum $50,000 $57,500 $60,000 Sweeney Parker Demoura
Zidonis Blair Albright
Albrizio LeVine Coughlin

Graham $48,000 Sullivan Romano

Entwistle $40,000 $45,000 Orr Gretzky Buckner

Fields
Select a column to sort by

Lists the columns you selected from the table (or joined tables) for which you
can define a sort condition for organizing the query results.

Ascending/Descending

Click one of the following options:
v Ascending to sort the query results by the specified column and table in

ascending order (1, 2, 3, 4...; A, B, C, D...)
v Descending to sort the query results by the specified column and table in

descending order (10, 9, 8, 7...; Z, Y, X, W...)

Procedure
1. Click a column for which you are defining sort conditions.

The column list displays each column from the selected table or tables.

Note: You can select multiple columns for the sort condition.
2. Click Ascending to sort the query results from lowest-to-highest (such as

1, 2, 3, 4...; A, B, C, D...).
3. Otherwise, click Descending to sort the query results from

highest-to-lowest (such as 10, 9, 8, 7...; Z, Y, X, W...).
4. Click Continue.

The Create Prompted Query page displays. The sort condition will be
listed.

[Optional] You can specify row conditions to determine which rows are
returned in the query results. See ″Add Row Conditions″ for more
information about this option.

Row conditions
The Row Condition page displays when you click Add Row Condition from
the Create Prompted Query page. Use this option to specify which rows to
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include in the query results. For SQL users adding a row condition is the
same as adding a predicate to the query WHERE clause.

Note: Row conditions are optional in a prompted query.

Fields
Select a column

Lists the columns included in the query.

You can select a column from the list of available columns or enter an
expression valid for your database server.

Is/Is Not

Click Is or Is Not to specify the operator for the expression. For example, to
specify ″Not Equal To″, click Is Not and select the Equal To operator.

If the Column expression is numeric, you cannot use the Starting With, Ending
With or Containing operators.

If all conditions are connected with Is, the database server returns only those
rows that meet all of the row conditions. If all conditions are connected with
Is Not, the database server will exclude all rows that meet the row conditions.

Note: This switch (″is″ or ″is not″ and the accompanying condition, described
below) works in conjunction with the fields to the right of the page
(fields labeled p1 - p6).

Conditions

Conditions include:
v Equal to (p1) or (p2) or (p3)...or (p6)

Enter up to six expressions. If you specify more than one expression here, a
compound row condition is created using the Or connector. For example, ID
= 10 Or 20 Or 30 Or 40.

v Less than (p1)

Specify one expression.
v Less than or equal to (p1)

Specify one expression.
v Greater than (p1)

Specify one expression.
v Greater than or equal to (p1)

Specify one expression.
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v Between (p1) and (p2)

Specify two expressions. For example, ID Between 10 And 20.
v Starting with (p1) or (p2)

Enter up to six expressions. If you specify more than one expression here, a
compound row condition is created using the Or connector. For example, ID
= 10 Or 20 Or 30 Or 40.

v Ending with (p1) or (p2)

Specify one expression.
v Containing (p1) or (p2)

Enter up to six expressions. If you specify more than one expression here, a
compound row condition is created using the Or connector. For example, ID
= 10 Or 20 Or 30 Or 40.

v NULL

You cannot enter an expression if the operator is NULL.

p1 - p6

Enter column or expression valid for your database server in each of these
input fields based on the selected condition.

Note: Use the appropriate identifier (table owner, table name, or column
name) in the expression. Enclose the character values in the appropriate
quote character.

Object owners and object names, including column names. The
maximum length of table owners and table names depends on the
version and platform of DB2.

Normal characters include uppercase letters, digits or the following
characters: _ @ # # $. Enclose any special characters in quotes. If the
identifier contains a quote character, double each occurrence of the
quote character and then enclose the entire identifier in quote
characters. For example, enter the identifier pro″ject as ″pro″″ject″.

If you use lowercase letters and do not enclose the identifier in quotes,
any lowercase letters are not changed to uppercase.

Enter expression here

Enter an expression valid for your database server in each of the input fields.
Use the appropriate identifier (table owner, table name, or column name) in
the expression, and enclose character values in the appropriate quote
character.
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Procedure
1. Click a column for which you will set conditions to limit the query results

returned by the database.
The column window lists the columns included in the query.

2. Click Is or Is Not as the operator for the expression (described in step #3).
3. Click on the appropriate condition, which works in conjunction with the

fields on the right of the page (p1 - p6). Each condition identifies the field
with which it is associated.
Conditions include:
v Equal to (p1) or (p2) or (p3)...or (p6)
v Less than (p1)
v Less than or equal to (p1)
v Greater than (p1)
v Greater than or equal to (p1)
v Between (p1) and (p2)
v Starting with (p1) or (p2)
v Ending with (p1) or (p2)
v Containing (p1) or (p2)
v NULL

Note: See ″Conditions″ above for a description of the conditions and
related input fields.

4. Enter values in the fields on the right of the Row Conditions page (p1 -
p6) based on the selected condition.

Note: Use the appropriate identifier (table owner, table name, or column
name) in the expression. Enclose the character values in the
appropriate quote character.

5. At the Enter expression here field, enter an SQL expression to limit the
query results returned by the database.

6. Click Continue.
The Create Prompted Query page displays.

7. Click Continue.
The Format Query page displays and has been updated with Row
Condition information.
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Controls

Table 73. Controls for Create Prompted Query

Control Description

Add v Table

Display the Add Table page so you can add a table to the
prompted query. For SQL users, this is the same as adding
a table to the query using the FROM clause. When you
add a table, QMF Query for Java assigns to it a correlation
ID. See ″Add Table″ for more information on this option.

v Column

Display the Add Column page so you can add columns to
the query results. See ″Add Column″ for more information
on this option.

v Join Condition

Display the Add Join Conditions page. For SQL users, this
is the same as adding a join predicate to the WHERE
clause in the query. See ″Add Join Conditions″ for more
information on this option.

v Sort Conditions

Display the Add Sort Conditions page. See ″Add Sort
Conditions″ for more information on this option.

v Row Conditions

Display the Add Row Conditions page. See ″Add Row
Conditions″ for more information on this option.

Edit Update the column description, join condition, sort condition
or row condition in the prompted query.
Note: This control is not available for tables.

Delete v For tables

Delete the selected table from the prompted query. QMF
Query for Java removes all other related elements
automatically (including join conditions, columns, sort
conditions, and row conditions) that refer to the table you
are deleting from the prompted query.

v Remove the column, join condition, sort condition or row
condition from the prompted

Note: Delete- and delete-confirmation prompts display when
you select this option.
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Table 73. Controls for Create Prompted Query (continued)

Control Description

Move up Move the selected table, column, join condition, sort
condition or row condition up in the list

v Moving a table affects the order in which two or more
tables are joined

v The initial column order is taken from the tables

v The join condition is based on the table order

v The sort condition controls the primary and subsequent
sorts

Move down Move the selected table, column, join condition, sort
condition or row condition down in the list

v Moving a table affects the order in which two or more
tables are joined

v The initial column order is taken from the tables

v The join condition is based on the table order

v The sort condition controls the primary and subsequent
sorts

Continue Run the query

Back Return to the prior page. Your entries are cancelled.

Home Return to the List Objects page to work with or create a
query

Save [This option is disabled.]

Exit Closes QMF Query for Java and logs off the current user

Help Display the online help facility

Options Display the Options page, where you can customize:

v user interface (look and feel)

v Query results

v HTML reports

v Page format

v LOB

v Exported text data

v Exported csv data

See ″Options″ for information on these options.
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Format query results

Use the Format Query Results page to define how to output the query results.
Choices are to generate some kind of report, to use some kind of form, or to
export the results. Additionally, use this page to define how to format the
contents of the report.

Forms are reusable templates for creating your reports. For example, you can
present tabular information with specific headings and text to clarify your
data. In addition, you can use forms to control the type of data you present,
enabling you to generate reports for different audiences from the same query.
You can also create HTML reports.

This page displays when you:
v double-click on an object at the List Objects page
v click on an object at the List Objects page and click Continue or Run

v click Continue from the Create SQL Query page or the Create Prompted
Query page

Fields

Format option
Select the form or method to use to format the report. You can generate a
report, apply a form, or export the results to a spreadsheet.
v Generate a default report

Generates a new report for the query using generic form options. See ″List
Reports″ for more information on this option.

v Generate a query report

Generates a new report for the query using the formatting that has been
applied to the query results. See ″List Reports″ for more information on this
option.

v Apply a QMF form from database

Generates a report using a form selected from forms stored at the database
server. See ″Apply Form″ for more information on this option.

v Apply a QMF form from file

Generates a report using a form saved as a file at your local computer. See
″Apply Form″ for more information on this option.

v Export data to text file (*.txt)

Saves the data as a plain text file. A text export produces an ASCII text file.
This format is typically used to export information to spreadsheet and word
processing applications. See ″Export Data″ for more information on this
option.

v Export data to spreadsheet file (*.csv)

196 Query Management Facility™ for Windows: Getting Started with QMF for Windows



A CSV export is similar to a text export, but it uses a comma as the column
delimiter. This format is used most commonly by spreadsheet applications.
See ″Export Data″ for more information on this option.

v Export data to database file

Export the data to a database. You need to define the target for the export,
including specifying the table owner, table name, tablespace and other
specifics. See ″Export to Database″ for more information on this option.

Report formatting
Select an option for formatting the selected report. Choices are:
v Plain text

Format the selected report or form in plain text format (*.txt). The
subsequent page presents a list of reports or forms that can be generated in
this format, if applicable.

v HTML text

Format the selected report or form in HTML format (*.htm), which is
suitable for a browser, but is largely unformatted in terms of specialized
headings, tables, and other formatting features. The subsequent page
presents a list of reports or forms that can be generated in this format, if
applicable.

v HTML table

Format the selected report or form in a structured HTML table, complete
with headers and other formatting features. The subsequent page presents a
list of reports or forms that can be generated in this format, if applicable.

v Chart

Procedure
1. Select the method by which you want to format query results, either as a

report, form or exported file.
2. Select the type of formatting for the report, either as text or HTML.
3. Click Continue.

Controls

Table 74. Controls on Format Query page

Control Description

Continue Open the next page

Back Return to the prior page. Your entries are cancelled.

Home Return to the List Objects page to work with or create
a query

Save [This control is disabled.]
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Table 74. Controls on Format Query page (continued)

Control Description

Exit Close QMF Query for Java and logs off the current
user

Help Display the online help facility

Options Display the Options page, where you can customize:

v user interface (look and feel)

v Query results

v HTML reports

v Page format

v LOB

v Exported text data

v Exported csv data

See ″Options″ for information on these options.

List reports

The List Reports page displays when you click Continue after generating a
default report or generating a query report at the Format Query Results page.
This page lists the reports that you have generated during the current session.

Fields

Available reports
This page displays a list of reports based on the selected formatting type and
formatting option. You can use one of these reports as a template for
formatting the generated report.

Procedure
Click on the link for the report you want to use. This report is a template that
you can customize.

The formatted report displays in a separate browser window for viewing,
saving, printing, exporting, or sending (via E-mail).

Controls

Table 75. Controls on List Reports page

Control Description

Continue [This option is disabled.]

Back Return to the prior page. Your entries are cancelled.
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Table 75. Controls on List Reports page (continued)

Control Description

Home Return to the List Objects page to work with or create
a query

Save [This control is disabled.]

Exit Close QMF Query for Java and logs off the current
user

Help Display the online help facility

Options Display the Options page, where you can customize:

v user interface (look and feel)

v Query results

v HTML reports

v Page format

v LOB

v Exported text data

v Exported csv data

See ″Options″ for information on these options.

Apply form

The Apply Form page displays when you click Continue after you select the
option to Apply a QMF Form from the Database at the Format Query Results
page.

Fields - Apply form from database
A page similar to the List Objects page displays when you select the option to
Apply a QMF Form from Database. Use the fields to search for the database
form to use as a template for the query results.

Forms are reusable templates for creating your reports. For example, you can
present tabular information with specific headings and text to clarify your
data. In addition, you can use forms to control the type of data you present,
enabling you to generate reports for different audiences from the same query.
You can also create HTML forms.

Once generated, you can display your reports, print them, export them to
files, or publish them on the World Wide Web.

Owner
The owner of the form.
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Name
The name of the form, as it exists in the database.

You can specify ″like″ information to locate the form, such as:
Forms with an owner like: DB2ADMIN

and a name like: EOY_REPORT_FORM

Sort forms in the list by
Specify the sort condition for the list of forms to be extracted from the
database. You can choose from owner and name or comment.

Note: A comment describes the form. A comment can be up to 80 characters
in length. Comments are optional.

Forms list
This table lists the forms that meet your criteria (owner and name or
comment). The forms are sorted by owner and name or by comment.

The owner and name of the object are listed, along with comments, if any. The
objects listed are listed alphabetically, in descending order, by owner and
name or comment.

Procedure
1. Enter the owner and name of the form. You can use % as a wildcard in

either field to select all forms.
2. Specify how you want to sort the search results:

v by owner and name
v by comment

3. Click Refresh to update the list of forms to match the criteria you entered.
4. Double-click the form or select the form and click Continue.

The form will be used as a template for the generated report output.

The formatted report displays in a separate browser window for viewing,
saving, printing, exporting, or sending (via E-mail).

Fields - Apply form from file
A browse page displays when you select Apply a QMF Form from File. Use the
input fields to browse for the file in which the form is stored. This enables
you to search for a form to use as a template for the query results.

Forms are reusable templates for creating your reports. For example, you can
present tabular information with specific headings and text to clarify your
data. In addition, you can use forms to control the type of data you present,
enabling you to generate reports for different audiences from the same query.
You can also create HTML forms.
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Once generated, you can display your reports, print them or export them to
files.

Browse
Enter a path to the form file name. This enables you to search for the form file
and use it as a template for the generated query.

Procedure
1. Click Browse and locate the form file in a directory. Continue with step #3.
2. If you know the location of the form file, enter the path in the input field.

Continue with step #3.
3. Double-click the form or select the form and click Continue.

The form will be used as a template for the generated report output.

The formatted report displays in a separate browser window for editing,
viewing, saving, printing, exporting, or sending (via mail).

Controls

Table 76. Controls on Apply Forms page

Control Description

Continue Open the next page

Back Return to the prior page. Your entries are cancelled.

Home Return to the List Objects page to work with or create
a query

Save [This control is disabled.]

Exit Close QMF Query for Java and logs off the current
user

Help Display the online help facility

Options Display the Options page, where you can customize:

v user interface (look and feel)

v Query results

v HTML reports

v Page format

v LOB

v Exported text data

v Exported csv data

See ″Options″ for information on these options.
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Export data

The List Reports page displays when you click Continue after generating
query results and selecting the option to Export data to the text file (*.txt) or
Export data to spreadsheet file (*.csv). This page lists the reports that you have
generated during the current session.

Fields

Available reports
This page displays a list of reports based on the selected file type. You can use
one of these forms as a template for formatting the spreadsheet.

Procedure
Select a form and click Continue or double-click on a form to use for the
spreadsheet.
v If you export the data to a spreadsheet in *.txt format, the spreadsheet

displays in a browser window. The data in the form is comma-delimited
and the content is displayed in a fixed-pitch, unformatted font.

v If you selected a form with a *.csv file format (comma-separated values),
you are prompted to download the file. Specify whether to open the file or
to save the file to disk, for example, in Excel format.

Controls

Table 77. Controls on Export Data page

Control Description

Continue [This control is disabled.]

Back Return to the prior page. Your entries are cancelled.

Home Return to the List Objects page to work with or create
a query

Save [This control is disabled.]

Exit Close QMF Query for Java and logs off the current
user

Help Display the online help facility
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Table 77. Controls on Export Data page (continued)

Control Description

Options Display the Options page, where you can customize:

v user interface (look and feel)

v Query results

v HTML reports

v Page format

v LOB

v Exported text data

v Exported csv data

See ″Options″ for information on these options.

Export data to database table

The Export to Database Table page displays when you click Continue after
generating query results and selecting the option to Export data to the database
table. Use this form to specify options for the export, including the table’s
owner and name, the tablespace to create the table, and various data handling
and exporting options.

Fields

Table owner
The owner of the table to which you want to export data.

Table name
The name of the table to which you want to export data.

Table space
The name of the table space in which you want to create the specified table, if
it does not exist.

Comment
A comment, up to 80 characters, that describes the data in the table. You can
leave this field blank.

What should happen to existing data
[What should happen to any existing data in the table?] This field specifies
how the exported data is added to the table. Choose one of the following
options:
v Replace any existing data

This option replaces the data in the table with the data you just generated.
v Add to any existing data
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This option appends the newly-generated data to existing data in the table.

Method to save data
This option specifies how the exported data is added to the table. Options are:
v Regular

Regular, run an ″INSERT ... VALUES ...″ statement for each row of data: With
this method, a separate INSERT statement is run for each row of data.

v Fast

Fast, run a single ″INSERT ... SELECT ...″ statement): With this method, one
INSERT statement is used for all of the exported rows of data.

Rows to insert before committing
The number of rows to insert into the table before committing changes to the
database.

Procedure
1. Specify the table owner and table name of the form on the database to

which you want to export data. Use % as a wildcard, if applicable.
2. Enter the name of the table space in which you want to create the

specified table, if it does not exist.
3. [Optional] Enter comments about this report.
4. Specify how you want to handle exporting data to an existing table,

whether to replace existing data or append it.
5. Specify how to save the data, by using the regular method or the fast

method.
6. Specify the number of rows to insert to the database before committing

your changes.
A message displays after the export operation to indicate the data was
saved, if applicable.

Controls

Table 78. Controls on Export to Database Table page

Control Description

Continue Open the next page

Back Return to the prior page. Your entries are cancelled.

Home Return to the List Objects page to work with or create
a query

Save [This control is disabled.]

Exit Close QMF Query for Java and logs off the current
user

Help Display the online help facility
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Table 78. Controls on Export to Database Table page (continued)

Control Description

Options Display the Options page, where you can customize:

v user interface (look and feel)

v Query results

v HTML reports

v Page format

v LOB

v Exported text data

v Exported csv data

See ″Options″ for information on these options.

Define form variables

The Form Variables page displays when you select a form that calls for
variables. At this page, specify values for unparsed variables that occur in a
QMF form or from QMF options.

Form variables prompt you to enter values to produce specific or timely
information on the report. For example, a form may contain a variable for
ADDRESSEE or START_ID and END_ID. You will be prompted to enter a value for
the form variable at runtime.

Fields

[Variable]
This input field is labeled with the name of the variable. Enter a value for the
variable in order to continue. Variables help narrow the range of data written
to the form or exported to the spreadsheet or database.

Procedure
1. Specify a value for the variable.
2. Click Continue.

Controls

Table 79. Controls on Variables page

Control Description

Continue Open the next page

Back Return to the prior page. Your entries are cancelled.

Home Return to the List Objects page to work with or create
a query
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Table 79. Controls on Variables page (continued)

Control Description

Save [This control is disabled.]

Exit Close QMF Query for Java and logs off the current
user

Help Display the online help facility

Options Display the Options page, where you can customize:

v User interface (look and feel)

v Formatting

v HTML reports

v Page format

v LOB

v Text data export

v CSV data export

See ″Options″ for information on these options.

Options

Once you log on to DB2 you can click Options to customize the QMF Query
for Java user interface.

Note: All settings are optional.

Accept
After making updates to any option, click Accept (') to preview the changes
prior to continuing. This enables you to view the results without leaving the
Options page.

User interface
These options control the appearance of the QMF Query for Java application.
You can set options for:
v Background color
v Foreground color
v Use grids
v Use message dialogs
v Row limit for List Objects

Background
Select a background color for the pages in QMF Query for Java. The changes
are permanent for this user. Unless you cancel, the changes will be applied
when you move to another page.
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Note: The default is light yellow.

Foreground color
Select a foreground color for the field labels and titles in QMF Query for Java.
The changes are permanent for this user. Unless you cancel, the changes will
be applied when you move to another page.

Note: The default is black.

Use grids
Check this box to use applets to display the List Objects as a table. If
unchecked, objects are listed in an HTML list in Owner.Name format.

This option is useful if the browser does not support applets or applets are
not configured to display non-English characters.

Note: The default is checked, which means that grids will be used.

Use message dialogs
This option controls how messages are displayed. If checked, system messages
display in a separate dialog box. If unchecked, messages display at the top
right of the page.

Note: The default is checked, which means that messages will display in a
separate dialog box.

You can view error messages in a separate window only if your
browser is enabled to run Java applets.

Row limit for List Objects
This option controls the number of rows that display in the List Objects on
the List Objects page (home page), whether the objects are listed in a grid
(table configuration) or an HTML list (in Owner.Name format).

For example, if you set this value to 7, only seven objects will be listed in the
grid or selection list. You need to scroll to see additional objects, if any.

The List Objects will be resized automatically to accommodate the row limit.

Row limit for query preview
This value controls the number of rows that display when a query is
previewed. This field works in conjunction with the Query preview mode field.
The default is ″Do not show preview,″ so the value in this field will be
ignored if the default is selected.
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Query preview mode
This field determines whether you can view a query prior to running the
query and generating query results. This field works in conjunction with the
Row limit for query preview field, if you specified to show query results.
Choices are:
v Do not show preview (this is the default)
v Show preview for queries running no more than 10 seconds
v Show preview for all queries

User interface language
This field controls the language used by QMF Query for Java. You can set this
field to Autodetect to enable the software to determine the active language,
based on the Windows setting.

Character set in use
This field identifies the character set to use, such as the character set used by
Windows, ISO, and DOS. When QMF for Windows retrieves data from a
database server, it must convert any character data from the coded character
set in use at the server to the coded character set in use in Windows. You can
instruct QMF Query for Java to autodetect the character set, or choose one
from the drop-down list.

User interface direction
Identify the direction in which text is presented on the screen. Choices are:
v Autodetect (the default, which checks the Windows settings)
v Left-to-Right
v Right-to-Left

Report options
These options control how query results are formatted. You can set options
for:
v Title of report
v Null values will be displayed as
v Date/time, numeric, and currency values
v Format of the report
v Split report to pages

Title of report
This value specifies what to use as the title for the default report, a report
from a query, and for reports.

Display null values as
Specify the string to use for null values in the query results (such as a dash).
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Display date, time, numeric and currency values as
Select the language/country upon which the date and time, numerals, and
currency values will be based.

Report formatting
Specify how the report output will be formatted. Choices are:
v Plain text, which is unformatted and uses a fixed-pitch font
v HTML text, which can be read in any browser and has minimal formatting

in terms of the title of the report and column headings
v HTML table, which applies a high level of formatting to the report, such as

presenting information in a grid (table)
v Chart, which represents the output in chart format. The type of chart is

based on the report that you are applying to the results (such as a form that
presents data in bar graph, pie chart, line, or scatter format)

Split report to pages
This field controls whether the report will have page breaks. The default is
checked.

HTML reports
These options control how information is presented in HTML format. You can
set options for:
v Parameters into HTML tag
v Parameters into Body tag
v Width of table border
v Parameters into Table tag
v Keep spaces in the text for HTML table reports
v Draw borders around empty tabular data cells
v HTML report tags

Parameters into HTML tag
The string inserted into the heading of the HTML file when creating a report,
for example, dir="RTL"

Parameters into body tag
The string inserted into the entire document tag of the HTML file when
creating a report. This does not include the report heading.

Parameters into table tag
The string inserted into the table tag of the HTML file when creating a report.
This does not include the HTML tag or body tag.

Width of table border
This value controls whether borders are visible around the table, and if so, the
width of the border. For example:
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v 0 = no border
v 1 = single border
v 2 = double border

HTML report tags
Enter the HTML tags (the prefix and suffix) for each element on the report,
such as the report heading and footing, or the report title: <h2> and </h2>.
The report tags change elements of the report, which in turn change the look
and feel of the report.

Page format
The Page Format page controls how the report is structured. You can set
values for:
v how pages will be placed
v vertical and horizontal size of pages
v page separator for text reports
v page separator for HTML reports
v include date and time
v include page number

Pages will be
Describes how files will be saved in QMF Query for Java. Choices are:
v placed to the separate files
v placed to one file in ″across then down″ order
v placed to one file in ″down then across″ order

Vertical size of pages
The number of rows (text lines) on the page.

Horizontal size of pages
The number of characters in each text line.

Page separator for text reports
The tag used for page breaks in text reports. The default is <PgBreak>;
however, you can define a value here, such as a row of asterisks (*) or equal
signs (=) to indicate a break.

Page separator for HTML reports
The tag used for page breaks in HTML reports. The default is <hr>, which
inserts a horizontal line to signal a page break. Alternatively, you can define a
value here, such as <hr size=5> to indicate a break.

Include date and time
This checkbox indicates whether the date and time print on the report. If
selected, the date and time format is controlled by the Select the format for
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date/time values field on the Data export options - text format or Data export
options - CSV format page of the user options.

Include page number
This checkbox indicates whether the page number prints on the report.

LOBs
Use this form to specify options for handling LOBs (large objects).

QMF for Java allows the retrieval of LOBs from a database as well as
exporting LOB data to your PC. By association, you can work with LOB data
in QMF Query for Java. With this feature, you can insert data types such as
text, graphics, audio, video, mixed media, and photo images.

LOBs can be retrieved from a database and edited in an appropriate
application that supports the type of file you retrieved. For example, a bitmap
can be edited in Microsoft Paint (R) as long as the application is installed on
your computer.

LOBs are retrieved to the table only for queries where LOB extensions are set
with QMF for Windows. For example:
1. Create SQL query in QMF Query for Java.

LOBs do not display.
2. Retrieve LOBs.

The LOB values display.
3. Click Browse <...>.

The LOB value is retrieved to a separate browser window.

Note: LOB objects can be placed inside another object or displayed in a
separate browser. You can also embed pictures into HTML files.

Default extension for large objects
The default extension for large objects is .LOB.

Place large objects inline
This checkbox specifies whether large objects can be placed inline in a report.
This field is valid for text in large objects.

Draw images in HTML table for graphical LOBs
This checkbox specifies whether to draw images in an HTML table for
graphical LOBs. This applies only to .gif and .jpg files.

Text data export
The options on this form control the format of exported text data. A text
export produces a text file. This format is typically used to export information
to word processing applications.
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Include column headings
Check this box to include column headings as the first row of the exported
query results.

String used to separate columns
[Enter the string to use to separate columns]: Enter the string used to separate
columns in an exported text file, such as a comma (,).

String used to delimit values
[Enter the string to use to delimit values]: Enter the string used to delimit
values in an exported HTML file, such as quotes (″).

When should values be delimited
This value determines when to delimit values (as described in Enter the string
to delimit values). Choices are:
v Always
v Never
v Only when necessary

Which type of values should be delimited
Specify which type of values should be delimited for the following elements:
v Column headings
v Character values
v Numeric values
v Date/time values

Format for date/time values
[Select the format for date/time values]: Specify how to format date and time
information on the report. Choices are:
v Local (determined by Java VM)
v ISO (YYYY-MM-DD, HH.MM.SS) - date and time information is exported in

the format specified in ISO
v USA (MM/DD/YYYY, HH:MM AM/PM) - date and time information is

export in the format most commonly used in the United States
v EUR (DD.MM.YYYY, HH.MM.SS) - date and time information is export in

the format most commonly used in Europe
v JIS (YYYY-MM-DD, HH:MM:SS) - date and time information is export in

the format most commonly used in Japan

CSV data export
Use this form to define how you want to format data exported in .csv format.
Choices are:
v Include column headings
v Format for date/time values
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A .csv export is similar to a text export. The file uses a comma as the column
delimiter. This format is most commonly used by spreadsheet applications
such as Microsoft Excel or Lotus 1-2-3.

Include column headings
Check this box to include column headings as the first row of the exported
query results.

Format for date/time values
[Select the format for date/time values]: Specifies the format used to export
date and time information. Choices are:
v Local (determined by Java VM)
v ISO (YYYY-MM-DD, HH.MM.SS) - date and time information is exported in

the format specified in ISO
v USA (MM/DD/YYYY, HH:MM AM/PM) - date and time information is

export in the format most commonly used in the United States
v EUR (DD.MM.YYYY, HH.MM.SS) - date and time information is export in

the format most commonly used in Europe
v JIS (YYYY-MM-DD, HH:MM:SS) - date and time information is export in

the format most commonly used in Japan

Chart options
This option defines graphical attributes for charts created from query results.

Note: A form’s chart specifications will be used instead of those defined here,
if available.

Default X size for a chart
The size, in pixels, for the x axis of the chart, which is the horizontal axis.

Default Y size for a chart
The size, in pixels, for the y axis of the chart, which is the vertical axis.

Value axis label
The default label for the y axis, such as Salary.

Category axis label
The default label for the x axis, such as Year.

Appendix B. Working with QMF Query for Java 213



214 Query Management Facility™ for Windows: Getting Started with QMF for Windows



Appendix C. Notices

This information was developed for products and services offered in the
U.S.A. IBM may not offer the products, services, or features discussed in this
document in other countries. Consult your local IBM representative for
information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or
imply that only that IBM product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe
any IBM intellectual property right may be used instead. However, it is the
user’s responsibility to evaluate and verify the operation of any non-IBM
product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give
you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10594-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the
IBM Intellectual Property Department in your country or send inquiries, in
writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any
other country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow
disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will
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be incorporated in new editions of the publication. IBM may make
improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.

Any references in this publication to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for
this IBM product and use of those Web sites is as your own risk.

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact:

IBM Corporation
J74/G4
555 Bailey Avenue
P.O. Box 49023
San Jose, CA 95161-9023
U.S.A.

Such information may be available, subject to appropriate terms and
conditions, including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer
Agreement, IBM International Program License Agreement, or any equivalent
agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments
may vary significantly. Some measurements may have been made on
development-level systems and there is no guarantee that these measurements
will be the same on generally available systems. Furthermore, some
measurement may have been estimated through extrapolation. Actual results
may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available
sources. IBM has not tested those products and cannot confirm the accuracy
of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be
addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change
or withdrawal without notice, and represent goals and objectives only.
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All IBM prices shown are IBM’s suggested retail prices, are current and are
subject to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is
subject to change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include
the names of individuals, companies, brands, and products. All of these
names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language,
which illustrates programming techniques on various operating platforms.
You may copy, modify, and distribute these sample programs in any form
without payment to IBM, for the purposes of developing, using, marketing or
distributing application programs conforming to the application programming
interface for the operating platform for which the sample programs are
written. These examples have not been thoroughly tested under all conditions.
IBM, therefore, cannot guarantee or imply reliability, serviceability, or function
of these programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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Trademarks

The following terms are trademarks of the IBM Corporation in the United
States or other countries or both:

ACF/VTAM
Advanced Peer-to-Peer

Networking
AIX
AIX/6000
C/370
CICS
CICS/ESA
CICS/MVS
CICS/VSE
COBOL/370
DATABASE 2
DataJoiner
DB2
DB2 Universal Database
Distributed Relational

Database Architecture
DRDA
DXT
GDDM
IBM
IBMLink
iSeries

IMS
Language Environment
MVS
MVS/ESA
MVS/XA
OfficeVision/VM
OS/2
OS/390
PL/I
PROFS
QMF
RACF
S/390
SQL/DS
Virtual Machine/Enterprise

Systems Architecture
Visual Basic
VM/XA
VM/ESA
VSE/ESA
VTAM
z/OS

Java or all Java-based trademarks and logos, and Solaris are trademarks of
Sun Microsystems, Inc. in the United States, other counrtries, or both.

Lotus and 1-2-3 are trademarks of Lotus Development Corporation in the
Unites States, other countries, or both.

Microsoft, Windows, and Windows NT are trademarks or registered
trademarks of Microsoft Corporation.

Other company, product, and service names, which may be denoted by a
double asterisk (**), may be trademarks or service marks of others.
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table 85
text

view 122
tracking

QMF Query for Java 177
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tooltips xi
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QMF Query for Java 179
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work with 126
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cancel
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options 12
warning
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document
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list files 87
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at server 24
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prerequisites 1
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menu

Report Center 124
Microsoft Access 109
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report menu 104
resize 42
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go-to 40
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pivot tables
Report Center x

prepare
command xi, 17, 25
function xi
query menu 17, 25
SQL 25
syntax xi

prerequisites
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print

command 75
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Report Center 124
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add

column 29
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procedure (continued)
command 67
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spatial extender 175
copy

from server 130
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create
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delete 131
export

LOB 49
export data

to files 95
import data 96
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open 7

at server 64
from server 7

options 111
preview 66
print 66, 128
properties

Report Center 111
reference 67
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rename folders 129
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report properties 111
resize
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row 43

run 61
at server 63
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sample 83
save 63

prompted queries 33
to files 63

save data 97
schedule reports 129
toolbar 10
with logic 63
work with 61
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all result windows 61
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windows 62
comment 62
run 61
set font 62
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procedure menu (continued)
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report

form 54
prompted queries

about 25
add
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table 27
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right ix
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preview 34
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save 33
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Report Center 104

Q
QMF for Windows

about 4
integration 172
launch

Report Center 124

QMF for Windows (continued)
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preview
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save
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print 46
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save 45

as table 45
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query results (continued)
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view 20
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zoom edit 50
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delete row 92
edit

tables 92
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draw query 8
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update 8
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file menu 9
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file menu 9
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Report Center 102

reference
procedure 67
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refresh
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Report Center 145
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remember password

log on 5
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list 86
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rename (continued)
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reorder
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replace
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data 203
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report
activity log

errors 123
reports run 123
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format
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HTML table 209
HTML text 209
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QMF Query for Java 209
query results 197
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QMF Query for Java 208
output options 107
page heading 46
variables

options 114
Report Center

about 101
charts x
comments ix
connect

to server 125
copy

folders 143
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display
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procedures 61
prompted queries 28
query menu 17, 25, 99
reports

Report Center 127
SQL queries

at server 19
substitution variables 23
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save
command 80
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to file 57

form files
open 58

format 45
job files 99, 100
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to files 86
mode
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share query 184
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open 63

procedures 63
to files 63
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to database 41
to file 42
to files 45
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at server 23
to files 23
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view 123
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Report Center 117
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procedure 129
Report Center 128
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options 118
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display font 44
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display report 40
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QMF Query for Java 179
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send to
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connect 125
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Report Center ix
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static queries 121
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Report Center 115
default
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set (continued)
font (continued)
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output options

report 110
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query menu 18, 25
security
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form menu 53
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procedure menu 62
query menu 18, 25, 99
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form menu 54
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tools menu 123
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command 82

show
command 82
details 10
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add 26, 30
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ESRI visualization 172
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file menu 173
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prerequisites 171
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print 24
run
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save 23
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search 91
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cancel

timeout 12
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options 12
trace options 13
warning

timeout 12
temporary directory

Report Center x
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file menu 9
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query menu 99
text

direction 208
size 123

tips
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report
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query 208
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